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Style conventions used in this document:

Ul Text: Text that represents elemets of the Ul such as button names, menu
options etcis presented with a grey background and border, in Tahoma
font which is traditionally used in Windows Uls. For example:

Ok

Standard Terms (Jargon): Text that is not English Language but instead refers to
industry standard concepts such s Strategy, BACnet, or Analog Input is
represents in slightly condensed font. For example:

BACnet

Code:  Textthat represents File paths, Code snippets or text file configuration
settings is presented in fixed-width font, with a grey background and
border. For example:

$config file = c:\CYLON\settings\config.txt

Parameter values: Text that represents values to be entered into Ul fields, or
displayed in dialogs is represented in fixed-width font with a shaded
background. For example:

10°C

Product Names: Text that represents a product name is represented in bold
coloured text. For example:

CBX-8R8-H

Process or Feature: Text that represents a particular task that the product
performs (Download, LiveLog), or a specific attribute of the product
that appears as a separate entity (log) is displayed bold and condensed.
For example:

LiveLog

PC Keyboard keys: Text representing an instruction to press a particular key on
the keyboard is enclosed in square brackets and in bold folt. For
example:

[Ctr]+[1]

MANO133 rev 15
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The Cylon BACnet Building Management System is made up of several components, which fall into two main
categories:

e Hardware - the products that monitor and control a building's environment.

e Software - the interface which allows users to configure and monitor Cylon Hardware.

HARDWARE COMPONENTS

Cylon BACnet uses the following main hardware components:
e Routers.
e |/O Field Controllers.
e Keypad
e PC

There may also be other supplementary hardware components such as printers, modems, pagers, etc., but these
are not essential to the basic system.

Routers

CBR devices route communications between BACnet IP and BACnet MS/TP networks.

Aspect® MATRIX Series and NEXUS Series devices are programmable communications controllers, which provide
supervision of Cylon BACnet networks and route communications between BACnet IP and BACnet MS/TP
networks.

3rd-party BACnet Routers can also be used with the Cylon BACnet system.

1/0 Field Controllers

PC

CBM and CBT Field Controllers take inputs from sensors and Building Control plant and send output to Building
Control plant in response. They are available as programmable or unitary controllers, with various input/output
configurations.

These I/O controllers can be programmed with Strategies, which configure them to send specific outputs to
connected devices in response to events occurring on their inputs. For example, you can create a Strategy in CXpro*®
and download it to a Field Controller specifying that a valve is opened if the temperature being input to the controller
rises above a predetermined level.

Cylon Field controllers are networked together using RS485 by BACnet Routers, which in turn are networked by
Ethernet. A Field Controller can also be linked directly to a PC, as well as to a modem or a printer.

The PCis connected to a Cylon network by Ethernet, RS232, or modem connection. The PC can also be connected
directly to a Field Controller for small installations with stand-alone controllers.

CXpro"'® software - which is used to configure the controllers, schedule events, and extract reports - is run on the
PC., which must have Windows 10 Professional 64-bit and Windows 7 Professional / Enterprise / Ultimate 64-bit
installed and running.

The minimum configuration to run this application is: Core 2 Duo E6300, 1Gb RAM, 80Gb hard drive.
The recommended configuration is: Core 2 Duo E6600, 2Gb RAM, 160Gb hard drive.

Connections between hardware components

The following types of connections exist between the hardware components:
e  Fast Ethernet bus connecting CBR routers and Aspect® devices with the CXpro"® PC.
e An RS485 fieldbus, using shielded twisted pair cables, connecting the BACnet Router to the I/O controllers.

10

© Cylon Controls Ltd. MANO133 rev 15



SOFTWARE COMPONENTS

The Cylon suite of software applications is used to set up, maintain, and control the Cylon system in operation.

CXpro*"® modules

The following applications are available from CXpro"® group in the Windows Start menu :

Database Interface

The Database Interface program allows you access to the database that contains details of all the point
values on each Field Controller in the network. You can set point values graphically in CXpro*®, or you can
enter or delete them in the Database Interface program.

Datalog Manager

A datalog in CXpro"® logs the value of a specified point in a Field Controller at a specified interval so that it
contains a record of the changes in that point value over a period of time. The Datalog Manager program
allows you to display the contents of a datalog in either graphic or tabular form. (see also MAN-0043
Datalog Manager User's Guide)

Engineering Tool

CXpro"® is a graphical interface created for programming the Cylon the product range. In CXpro*®,
strategies (which tell a controller how its outputs should respond to conditions on its inputs) can be
designed, edited and downloaded to, or uploaded from, Field Controllers. CXpro"® could be described as
the most important of all the Cylon applications, as it is the application that programs the Cylon
controllers. This manual describes how to carry out a variety of tasks in CXpro*®.

Manage Software Licence
Site Organiser

The Site Organiser is an easy way to configure and examine a complete site or part of a site. Instead of
downloading strategies individually to all the controllers on a site, this can be done in one simple task.
Any combination of strategies can be downloaded to any combination of controllers or to one type of
controller in a .ins batch file. (See also MAN-0020 Site Organiser manual.)

Start CXpro*i®

MANO133 rev 15
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CXPRO"P — OVERVIEW

CXpro*"® provides all of the tools required to design, configure, test, commission, and maintain Cylon BACnet
systems automatically.

You can use CXpro"® to:

Graphically create strategies that implement solutions to conditions on site.

Save those strategies for future editing, testing, or reference.

Test the operation of strategies.

Debug and edit strategies.

Download strategies to the appropriate controllers.

Define and assign 3rd party blocks to carry data across a Fieldbus.

Define and assign wide 3rd party blocks to carry data between Fieldbusses and across the network of a site.
Upload existing strategies from controllers.

Upload analog and digital point values from controllers.

Upload statistical and reference information from controllers.

Record changes that occur on a site as they happen and save the record to a file.

12
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STARTING CXPROMP

Open the CXpro"® section on the Windows Start menu or start screen , or search for “CXpro"®” in the Application

search box .

Click on the Start CXprotd icon. The CXpro®® interface will open:

Quick-Access Toolbar =1z n KX 5] = B
@

o G Cw Ol CdCq

Alows access to - = Configuration Database Datalog S'rle_ Backup ME-Pro
program options Loi Interface Manager Organiser
Utilities

Zo BACnetIP
To BACnet Serial
E_E Sample Apps BACnet
- 52 001 - Wet Systems
..... - CT Single P
----- E,, 1113 - CT Single P
..... - CT Dual Pu
..... - CT Dual Pu
..... - CT Dual Pui
----- &, 1121- VT Single Py
----- &, 1122- VT Single Py
----- &, 1123 - VT Single Py
----- @‘, 1124 - VT Dual Pur
----- @‘, 1125 - VT Dual Pur
----- &, 1126 - VT Dual Put
----- &, 1131 - Four Boilers
----- @’, 1132 - Four Boilers
@’, 1133 - Two Boilers
..... @’, 1134 - Four Boilers
----- &, 1135 - Four Boilers
----- &, 1136 - Two Boilers v

Rl 4444 inasm s o

T 3

Right-Hand Pane
For Modules, Module Properties,
Page Navigation etc.

Site List

Page Mam... Modules Properties
Connected to: Sample Apps BACnet (3], R R .'l \ i

Note: If other Cylon Engineering Software, e.g. CEC7 is installed on the same PC, then instead of the
CXpro*P? interface opening directly, a “Chooser” dialog opens first allowing the user to select the
software to be opened.

14 © Cylon Controls Ltd. MANO0133 rev 15



THE CXPRO"P INTERFACE

The CXprot® User Interface consists of the following sections:

Site List o H |-
. . o) Sites &
The Site List 25 BACKetIP
- 52 001 - Network
- 001 - 001 - UCU32
- 001 - 002 - CBM24
ACnet Serial
Io Sample Apps BACnet
-5 001 - Wet Systems
----- @’, 1111 - CT Single P
----- @’, 1112 - CT Single P
----- E‘, 1113 - CT Single P
----- &, 1114 - CT Dual Pui
----- &, 1115 - CT Dual Pui
----- @,, 1116 - CT Dual Pu
----- &, 1121 - VT Single P
----- &, 1122 - VT Single P
----- E,, 1123 - VT Single Py
----- &, 1124 - VT Dual Pur
----- &, 1125 - VT Dual Put
----- &, 1126 - VT Dual Pur
----- &, 1131 - Four Boilers
----- &, 1132 - Four Boilers
----- &, 1133 - Two Boilers
v

This gives an overview of the BMS Sites that
are accessible from this PC

o
L0
o

v om

ol aama noa

< >

o = K Strategy1 b x| [Me
The Strategy Drawing Area = _ =
122 m R::?:z:‘\r:c Co
This part of the Ul shows the modules and 24 &
. . une= ) Fi
points in the current Strategy, and the p s
. & Sempint Output s
connections between them, e ] e :
eP AI Room Temperature Gain a
ep I o Qg Enzbe
Pu [ oeme@| Tr=graton. 8
Desivative |
Eu‘ Imegraton tme: 900 Damvaiwe | | O
eP y
Rl : -‘.'}
o - °
pu T vz
pu [oe=g >
lers -
o =
lers wl |l
> N < > [ =]
:u:I:::IES * 8
The Right-Hand Pane (Inspector) ap
Constants »
. . . Controls
On the right-hand side of the Ul there is an Functons -
area that displays the Modules library, a ST analag e
Module Property editor, a BACnet properties compermmr - #
) . . Digital Encode
inspector and Page navigation panels. o oira e
By defaul h [ displ d b 7 Limit 3t Min and Max
y defau t,t ese panels are displayed one-by- E—
one in a tabbed interface, I~ wake Lnear
:/: Rescale Custom
:”/: Rescale from 0 to 100

v
Page Nam... Properties Modules
—_

wCmat

syse} oiseq
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but the |ay0ut can be Page Names o E Properties 2 E@ Modules i x |
Conﬂgu red by + X |« ShowPageMNumbersOn < > 2 |Tuneable Forward PID j #
d . h b Page Number | Page Name | a Favorites
ragging the 1abs S0 | e — Ty Tuneable Forward PID  Constants =
that the panels can Service Order ! < ‘
. Synchronised 5tat.. Disconnected i) Digita| Constant
be displayed all = Int
5 _+ Integer Constant
together as shOWn Setpoint Analog 1 Room Setpe...
Process Variable Analog (1) Room Te.. ,5, Real Constant
here: Gain Analog
— Controls »
Enable Digital |
Integration time = Analog .Functluns 4
Derivative time | Analog Math »
8 Schedules, Timers, andL... »
Integration time 900 .Set AT and O
Derivative time 0 [ P - U
Service time 1 |Skbetics »
= VAV »
Qutput Analog (9) Heating Ve yi421 ~
Integration time
Period of integration of difference between the
Setpoint and the Process Variable. Set to zero to
te - BACnet ; = 1 T 100% NUM
The Ribbon

At the top of the CXpro"® User Interface, there is a palette similar to many Windows applications called the Ribbon.
The Ribbon allows access to the majority of CXpro"® features.

File - Home Contrgller Strategy @
’ Connect JﬁCcummunications Iil Download r’i‘:lc-:umpare E:I; "_J‘ I 1 EI |§| Fx‘; @ l_EI
4@’ Disconnect % Contraller )‘B Wipe Controller Show Compare % E.j Q ® f F‘E f 0
" ) oo Scan  Override Livelog Interface Configure
% BACnet 1 Auto Online B Point T Builder
Site Configuration Operations Testing Keypad

The feature options are grouped into tabs each of which contains a different set of options.

The Quick Access toolbar

If there are specific Ribbon feature options that you use often, you can add them to the Quick Access Toolbar where
they will be accessible at all times:

S BEG Q-

Fila = HrAma Camtrallar

To do this, right-click on the feature in the Ribbon and select Add to Quick Access Toobar :

[l r — — = — —
I;; | Adf}to Quick Access Toolbar
Tl
ra| = Customize Quick Access Toolbar...
Show Quick Access Toolbar Below the Ribbon
Minimize the Ribbon

L]
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CONNECTING TO A FIELD CONTROLLER

Work in CXpro"® can be done on-line or off-line. When on-line, the PC can communicate directly to the controller.
When off-line, there is no direct link between the PCand the controller. For tasks that involve direct communication
between the PCand the controller, e.g. uploading or downloading information, it is necessary to work on-line.

To work online, you must connect to the controller by clicking on the Connect button in the Home tab of

the Ribbon :

File -~ Home Controller Strategy
’ Copnect mCDpy Properties Mudu\es Ezlstrategy
ﬁDis%nned LﬁPaste Py Navigatian Macros |:| Reopen
_' Select All List E Page Mames @ Search

Site. Clipboard View
Site List o x [ Strategy1

= @ Sites
@3 BACRtP [
BBt -Netwok |
; = oot -opr-ucuziiav L

To work off-line, click the Disconnect button.

syse} oiseq
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OPENING STRATEGY FILES

To open a strategy file in CXpro"®, you can
e (Create a new strategy

or
e  Open an existing strategy file.

It is possible to open multiple files: multiple new strategies in different controllers, multiple existing files, or a
mixture of both (see page 19)

To create a new Strategy, either double-click on a Field Controller in the Site List that does not already have a Strategy

associated with it or select New from the File menu

8

¥

File -

[ new
=7 Open
B Save
@ Save As
Save All
Q Footers

QI Page Size

Home Controller

Recent Documents

QI Printer Scaling
P, Print Setun

Site List + B
=) Sites
o-£g BACnet IP
-2 001 - Network
1= 001 - 001 - UCU3213V
&= 001 - 002 - CBM24
B-Fa BACnet Serial
B 001 - Network
E-2a Sample Apps BACnet

Strategy

Properties

Engineering Centre

@) Thereis no Associated Strategy with this controller. Create 3 new
Y Strategy?

You will be asked if you want to create a new strategy — click Yes .

2 B Modules

Favorites

Constants
| Controls

Functions

Math
.S(hedu\es, Timers, and L.
Setpoints, Inputs, and 0.
Statistics

VAV

Virtuals

AR AR AR BE AR SR AR AR AR AFY |

To open an existing Strategy file, double-click on a Field Controller that has an associated Strategy, or select Open from

the File menu:

Qo s Engineering Centre
File - Home Cantroller Strategy

[ Hew Recent Documents :t g BACnet Pe

Open - BACnet L

= 1001_01.532 rder .l

B Save ules D_Ej Strategy D
@ Save As tegy

[7]) Save Al

@ Footers

18
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NAVIGATING A MULTI-PAGE STRATEGY

For clarity, many strategies are drawn over several print-pages. To facilitate navigation through these pages,

CXpro"'® provides a Page Navigation panel.

To open it, select Navigation on the Home Ribbon.

= Engineering Centre - 8.00.00-286

File - Home Controller Strategy

’ Connect @ Copy Properties I[D Modules |Ez| Strategy Help F r." [
= Navigation [T Macras o =

L"Disc-:nﬂect L‘ﬁpasle Nawgat\un Macrus D Reopen Strategies

Configuration Database Di

Ui select Al ?E: Page Names @] search Interface M:
Site Clipboard - View L
Site List | |« 001_01.532 b % | Properties
@) Sites — —

5o BACnetIP

522 001 - Metwork

=, 001 - 001 - UCU32I3V
= 001- 002 - CBM24
%-E BACnet Serial

-2 001 - Network

"%E Sample Apps BACnet

The button turns green to indicate the panel is currently displayed:

-] Engineering Centre - 8.00.00-286

File - Home Controller Strategy

’ Connect @ Copy Properties | Modules |Ez| Strategy Help r‘] r.'l [
J Disconnect L‘ﬁ Paste Mavigation | Macros D Reopen Strategies Q =
f— Site | — Configuration Database D
i_1Select All List IE Page Names @ Search Interface M:

Site. Clipboard View L
Site List 2 E Havigation o E Properties

= 0 Sites.

s
B-Ig BACnet IP -
552 001 - Network -
-
&}, 001 - 001 - UCU3213V -

- 001-002 - CBM24
-Fo BACnet Serial
-3 001 - Network
“EE Sample Apps BACnet

The Navigation panel appears by default as a docked panel within the CXpro"® window, but by dragging its title bar
it can be repositioned within the window or even ‘popped out” as an independent window that you can position
anywhere on your monitor:

MNavigation H

I

MANO0133 rev 15 © Cylon Controls Ltd. 19
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The Navigation panel shows blank rectangles to indicate strategy blocks and a red rectangle to who the current

Strategy Drawing Pane . Dragging the red rectangle moves the display within the Strategy Drawing Pane :

Site Configuration Database Datalog Site Backup
ct All List Page Names @ Search Interface Manager Organiser
ard View Utilities
L x (] 001_01.532 b x | |Properties
ke

Al room e

ork E
n-vcus2wv |- oo oo . o oo

)2 - CBM24

ork
ACnet

Anzlog Sat;

[
Setpoin
MNavigation H

ELN

Analog !
m Room Ten

Labeling the pages within a strategy drawing

An alternative method for navigating a large Strategy is to use page names. A pane is available for this, to open it
click on the Page Names button in the Home ribbon:

[ea [

File - Home Controller Strategy

’Connect @Copy Properties Modules|az|5tr
h” Disconnect Iﬁpaste Navigation Macros |:| Re
i__' Select All Fage Mames @ Search
Site Clipboard View
Site List g3 4 001_01.532

EO Sites

EEE BACnet IP

Sty

[ roperies |[Eivtodues [Fstisteqy vt QO EOoOCoOoR
@]. o | B Mecros ] Reapen Sategies 2 Ly Ly Lo le
S LEtodaotion Sackup HE.Pr0
T [[EPeoe rames B sesrn

Configurstion Datshase Dstsiog  Ste
Interface Manager Organiser
vtaties

o@ oo o532 x| TN aE |
LS ~ | 4 X [ ShowPageNumbers On Drawing

&g B Page Number | Page Name

T B 001 - Hetwork o .

= 001 - 091 - UCURZIV
| 001 - 002 CBM24
-5 BaCnet Seral

T 52 001 - Netwark

2g Semple Apps BACnet

There are na items to show in this view. i

20
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The Page Names panel appears by default as a docked panel within the CXpro"® window, but by dragging its title

bar it can be repositioned within the window or even ‘popped out” as an independent window that you can
position anywhere on your monitor.

(o)
Q
@,
(o]
. . —+
The Page Names pane allows you to hide the page number on the Strategy Drawing: @
Q
w
Q=
#F connea | (Ficopy [Eproperties [ Modules [2] sratey Heip
Chseiean | | fg |[Pane ames| ] searcn o e Msags Oraaer T "
Site List = ag . m|_n|.x!1m~ — Ix Page Mames L -
2§ Stes | 4 X T ShowPage Humbers On Drawing
5-1g BAChe P PageNumber | Page Name
=2 = Network
001 - 001 - UCU313V
001 - 002 - CBM24

&S BACnet Serial
= 001 - Network
B-$o Semple Apps BACnet

‘There sre no items to show in this view. i

And allows you to add names for pages instead numbers:

[+ X | Page Names DR x
A ® [ Show Page Mumbers On Drawing

Page Number | Page Name |

MNew Page Mame

Fage s o
T4 K ko Page ke O Dersing

Fogeumbe o

I

5,501 e
g St s Bne

Double-click on the name in the Page Names pane to edit it:

Page Mames a B
+ X [ Show Page Numbers On Drawing
Page Number | Page Name |

Y -] |

MANO0133 rev 15 © Cylon Controls Ltd. 21
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and the new name is displayed on the Strategy Drawing:

Fie - | ome | Comtromer  Sirategy

#F connet | [jcopy E‘Wmﬂrmwnm r|° r‘E m r.r'b mr.

¥ Oisconnect | jpaste | [hamgation [BMocrss [ Reopen Strstegies

T Contigumation Dutabase Ditaioy  Sie._ Backam NE-Pro
Ciseectn | g |[gPage ames [ sewrcn larts Macager gt
s Cinors view frises
shetist o V% | Page Hames amj
) Snes ~ 4+ X [ ShowPage Numbers On Drawing
e-lg Bacnaip Page Humber | Page Hame
| TR 2

| = 001- 001 -ucuszav
| - 001 - 002 - CBM24
&-Fe BaCnet Serial

| @B 001 - Network

@-Zg Semple Apps BAChet

) Rask Tomp o
1
T bea
o
=5
uadberd T
AR
: bnactand 3 1

Click on a name in the Page Names pane to align the top left corner of that page in the top left corner of the

Strategy Drawing Pane :

o = Engineering Centre - 8.00.00-286

File - Home Controller Strategy

’ Connect @Cnpy | Praperties Modules Estrategy Help | m E!'l m Q m G |

_@‘ Disconnect LﬁPaste E Mavigation Macros D Reopen Strategies

Site Configuration Database Datalog Site Backup NB-Pro

Select All List |[[= Page Names  [&] search Interface Manager Organiser
Site Clipboard View Utilities
Site List 1B |« 001_01.532 ] I % | Page Names 1B N
E--@ Sites - + X [ Show Page Mumbers On Drar
B-xg BACnet P mT1OCe. L Page Number | Page Name |
-2 007 - Network 1 Inputs
-, 001-001-UCU3213v ||, . B . . . . . . . . 2

.= 001 - 002 - CBM24
EI--EE BACnet Serial
- B2 001 - Network
E-Ig Sample Apps BACnet

P
7 Toreabie Fyseess = |
(@ e Active High [0
71 On Level Active Law [0
~] OF Level :
On level 2.00: level: 4.00
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FINDING AN ELEMENT IN A STRATEGY

CXpro"™s Find pane is a facility for locating specific objects in a strategy,

(o]
It is opened by either pressing [Ctrl]+[F], or by selecting the search window from the Home tab of the Ribbon . &,
=
Q
Search Results g’?
X Delete [~ Select All [Module ~| TPe [Boolean | MNeme | <] Number [ ] QUFind Q Q °
- [T Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - MNetwork: 001 - 002 - CBM24 (2 matches)
: -Boolean
.. Boolean
This pane contains a number of lists in which you can specify a number of filters to reduce the kinds of items that
will be located — for example in the screenshot above, only Boolean modules are shown.
You can then step through all of the matching items in the strategy drawing using the mouse or arrow keys and
selecting the module discovered in the search results. The current match will be highlighted in the drawing:
gb Boolzan 1 gb Boolzan
EEED Outpt [ 71 Input A Output [
Input B Complement [ [ Input B Complement
[ Input C [ Input €
[ Input D [ Input D
|(
Search Results
X Delete [~ Select Al [Module =] ™pe [Boolean <] Name | <] Number [ ] QUFind Q Q
El- 7] Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - Network: 001 - 002 - CBM24 (2 matches)
Boolean
... Boolean
23
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ZOOMING AND NAVIGATING THE DRAWING AREA

The drawing area can be displayed in an enlarged or reduced view. The default view is 100 %, i.e. full size.
With a mouse, zoom in and out by rotating your mouse wheel with the control button pressed on your keyboard.

If you do not have a mouse with a mouse wheel or are using a trackpad, you may use the zoom slider at the bottom
of the drawing area to zoom in and out.

o A
[ Enable
Int=gration tme: %¥); Dervative... LY
>
! 100%

For navigating around the drawing area, you can use the scrolls located on the right and bottom of the drawing
area.

The mouse wheel may also be used to move around the drawing. Scrolling up and down with the mousewheel
will move the drawing up and down. Scrolling up and down with the Shift button pressed on your keyboard, you
may move right and left.

You may also use the right mouse button to drag the strategy around in the drawing area.

If you are using a trackpad, the Navigation Pane makes it easy to get around your strategy.

CHANGING THE DISPLAY

The following features of CXpro"® can be customized:

e Drawing Area (Grid Settings). To simplify positioning modules on the drawing area, you can choose a grid
of either lines or dots. You can also customize the size of the grid from 8-pixel to 56-pixel squares (see
page 25).

e  Colours. The colour of either the background or the grid can be customized using the Colour menu option
from the Display menu. In addition to the standard colours available, custom colours can also be defined
(see page 25).

e Macros. If the work you do in CXpro®® involves repetitive strategies or parts of the strategies, you can
create macros (see page 146) to automate much of that work. You can arrange those macros in groups
and, using an art tool, such as Microsoft Paint, you can draw icons to represent the macro groups and
individual macros you have created.
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MODIFYING THE DRAWING AREA (GRID SETTINGS)

From the Strategy tab onthe Ribbon , choose Grid . B Grid E] New Connections
?‘)" Grid Colour
l:'fBackgrnund Colour
Display
This opens the Grid dialog box, where you can Grid
specify whether or not to show the grid, and if it is _
. ¥ Show Grid on Strategy
shown, whether you prefer lines or dots. You can _
. . Style———————— Spacing
also set the spacing of the grid.
" Lines
16
' Dots
Cancel |
MODIFYING DISPLAY COLOUR SETTINGS
From the Strategy tab on the Ribbon , choose Grid i Grid BT}, New Connections
Colour or Background Colour . B Grid colour
r"ll" Background Colour
Display
In both cases, the Colour dialog box is called. This Color W
allows you to select from a range of colours. You can
also make custom colours, by clicking on the Define
Custom Colours button. When you have selected the I_ I_
colour you require, click OK . The colour is applied . -
immediately. | B |
Define Custom Calors = |
0K | Cancel |
25
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SAVING FILES

CXpro"'® allows you store files on disc by:
e Saving anew file
e Saving changes to an existing file
e Saving multiple files at once

Files will be saved in the "strat5" folder of the relevant site directory, under a numbered directory. The number of
the directory matches the number of the BACnet Router to which the targeted controller is attached - for example:

C:\CXproHD\Lan\strat5\001\001 OlFanCoil.stg

would be a strategy in a controller on the first BACnet Router of the site called "LAN".

Saving a new file

If a file is being saved for the first time, press [Ctrl]+[s] on your keyboard or choose Save from the File drop-down.

==

File - Home Controller Strategy

[ New Recent Documents
Open

= or 1001_01.532

[™) save

@ Sapat 2001 02,532

- [™ save (Ctri+s)
5

3 Save the strategy.

@ Foorers

QI Page Size

QI Printer Secaling
?_a Frint Setup
0 Print

@ Close

e

To Sample Apps BACnet
E-Sa Sample Apps Unitron

This produces the Save As dialog box allowing you to specify how the file is to be saved:

Save As

T e stratd » 001 v & Search 001 o

4]

Organise Mew folder R 4 (7]
| CAMPELOR A Neme
. ARCHIVE
. dbase
. DRAWINGS
. KEYPAD
. MACROS
. strats
. 001
. Upload

J Upload
L1 001_01.532

File name: | [ K= )

Save as type: V6 Strategy (*.532) v

“ Hide Folders Cancel

Saving changes to an existing file
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If you have made changes to an existing file and wish to save those changes, but do not wish to rename the file,

nor save it to a different location on the PC, you can save the file in two ways:

e  Press [Ctrl]+[s] from the keyboard or

e choose Save from the File drop-down.

@
File - Home Controller Strategy
D New Recent Documents

— Open

=k 1001_01.532

IE Save

@ Save As 2001_02.532

[]
53 @ save As

g Fo Save the strategy with a new name.
QI Page Size

EI Printer Scaling
iF&Prir‘lt Setup

= Print
@glose
@ﬂelp ®
| -..JE_E Sample Apps BACnet "[ o

Saving more than one file

If you have a number of files open and wish to save them all, choose Save All from the File drop-down. This saves

each of the files.

File -~ Home Controller Strategy

D HNew Recent Documents
[ Open
B Save

[¥] save As 2 CA\CXproHDV..\0014001_01.532

1001_01.532

| il 5""”[/'\\) 3 CACXproHD,.\DO1_03VAV.532
Q Footers
QI Page Size
EI Printer Scaling
‘f-a Print Setup
=8 print
® Licence Details

@Qose

rd
ul

ate
E

= 007 - Wet Systems
@, 1111 - CT Single Pump DPS

L _NETPENNFS 3 SR, SR S

@ Help (D About ¥ Exit

If one of the open files is being saved for the first time, CXpro"® will prompt you to specify a drive, directory, name,

and file extension for that file by calling the Save As dialog box.

MANO133 rev 15
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PRINTING

Including a footer in a printed strategy

CXpro'® can generate a hard-copy printout of the current strategy.

When you print files created in CXpro*"®, they include additional information at the end of the printed page in the
form of a footer. The footer includes the name of the site, as well as the BACnet Router and Field Controller for which
the strategy is designed. You can edit the footer to include your name, your company’s name, the name of the
project to which the file belongs, the number of the drawing if any, and the date and details of any revisions made

to the drawing.

How to edit the footer that will appear with the strategy when it is printed:

Choose Footers from the File tab of the Ribbon .

This opens the Footers Details dialog box:

Footer Details

Company Name Cylon Controls Ltd.

Company Address Clonshaugh Business and Technology Park.

Clonshaugh
Dublin 17
D17 ABG2
— Project
Project Title I Open-Plan Office User I E. Peelo
File |uu1_u1.53..1 Project No. |14
Drawing Mo, I 5
— Revision
Rev Date Drrawing Checked Remarks

A |23ﬂm15 |3

IEF‘ IDId

B
<
D

Save I

Cancel

Enter the required details and click Save.
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Altering the print set-up

To define how the strategy is to be printed, choose Print Setup from the File Tab of the Ribbon to open the standard

MSWindows Print Setup dialog box, where you can specify the required printer, paper, etc.

&
Print Setup x 2
73
— Printer
Name: Properties... |
Status: Ready

Type: Brother HL-2170W
Where:  WS5D-63b62ecc-5045-4af 1-b52e-8efadb 006811 .006F
Comment:

— Paper Orientation
Size: I Letter ;I " Portrait

Source: I.Pu.rtumaticalhrSvalect ;I % Landscape

Metwork ... | QK I Cancel
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Printing a file

To print a file, choose the Print option from the File tab of the Ribbon . This opens the standard MSWindows

Print dialog box to specify the required printer, pages to be printed, and the number of copies.

==
X
File - Home Controller Strategy
Prirter
[ iew Recent Documents
Name: Properties...

—y Open =

o 1001_01.532

B Save Status Ready

m Save As 2001_02:532 Type: Brother HL-2170W

Save Al Where:  W5D-63b62ecc-9045-4af1-b52e-8:faBb 0068 11.006F

@ Foater‘s Comment ™ Print to file
QI Page Size Prirt range Copies

] Printer Scaling & Al Number of copies: |1 =]
%y Print Setup O G ’71 o ’712

= Print ]

9 Prin c 112 912 33l

() Close 9 Print (Ctr+P)

Print the strategy. delp @ 0K Cancel
_— [©
E-Zo Sample Apps BACnet

Changing the size of a Printout

If a strategy is large, it may not be possible to view enough modules on each page with a standard printout. CXpro*®
has a Printer Scaling option, which allows you to decrease the printed size of the strategy so that more of it is
visible per page.

Also, if you have set a strategy up for printing on a particular printer, you may find that if you try printing on a
different printer it may not fit properly on the page. The Printer Scaling option allows you to adjust the printout
size to compensate for this.

To resize a printout, select Printer Scaling... from the File menu

This opens the Printer Scale dialog box:

Printer Scale | 100 = %

¥ Applyto all open documents

Cancel

Enter a scaling factor between 20% and 300%.

e  Factors from 20% to 99% will decrease the size of the modules in the printout.

e  Factors from 101% to 300% will increase the size of the modules in the printout.

Ticking the Apply to all open documents box will set all currently-open Strategies to print with the same scale.
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Fitting a Strategy to a page size when printing.
The Strategy drawing indicates where Modules will appear on the printed page, by drawing gray borders on the
Strategy drawing. In this example, the printer scaling is 100%

[oe)
Q
8,
o
—
Q
(%)
=
n

The Printer scale setting will change the size of the pages relative to the modules. Below shows an example of the

printer scale of 200%

The physical page size represented by the gray borders is set by selecting Page Size from the File tab of the

Ribbon . This opens the Page Size dialog:

Page Size

' Use Custom Page Size

= -
130 = « |?99 _I:l

|
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CLOSING FILES

You can close an open Strategy file in two ways:

Click the Close button at the top right-hand corner of the file window,

= CXproHD - 8.00.00-304 - O X
File ~  Home | Controller  Strategy @
& connet £ Copy Properties |[[5 Modules| §7] strategy Help
vl ol | e 0 B QQORG
#¥ Disconnect | [FPaste [ wavigation [[&] Macros [ Reopen strategies
site | — Configuration Database Datalog  Site  Backup NB-Pro
List |[E Page Namﬁ\@iwm Interface Manager Organiser
site View Utilities
Site List 8 x | 001_01.532 3 1\ Properties P x |
- Sites ~
BT BACnet IP
-5 001 - Network C Digital Constant T Int  Im=cer Constant
[n¥] - 2
=}, 001- 002 - CBM24 Oapa AL O AS)
o . Oupu B | Ot B Q)|
[]---E_E BACnet Serial [T [T &
[-3Ig DLL Stuff DD @ [T
2} EE fred Gonstant A: 0; Constant B: 1; |Gonstant A: 1; Constant B: 2;
o |Constant C: 0; Constant D: 1 |Constant C: 3; Constant D: 4
3o Local Network
-Zg Sample Apps BACnet
T Sample Apps Unitron
=
Ei iizp;\;é::iglisvﬁﬂ y Cooling Opimz=r A~ I, Cooling Opimz=r B+ b
@ Surwme | Demand [ Mancay [ Smrup ) 63 Sempei
& swopremp | S 0| |5 Tuescay | Stuadown ©| RIS
< > PageNames Modules  Properties
Strategy saved successfully. Connected to: BACnet IP (3], Remate - E Y m NUK
or
Sel lose f he File tab of th 2 -
elect Close from the File tab of the -
. File = Home Contraller Strategy
Ribbon.
D New Recent Documents
= Open
1001_01.532
(™) save
E Save As 2001_02:532
'
Save All
@ Footers
QI Page Size
!I Frinter Scaling
P Print Setup
= print
@ Close
=
Hel About
Close Zelp G)
= —_——
Close the strategy.
o
o=}

[li]

Hn

Io Sample Strategies v0.1
Test BACnet

o ~ample Apps Unitron

&

Q)
)
|

If changes have been made to the file since the last save, CXpro"® will prompt you to save it before closing.

If more than one file is open, selecting Close from the FileTab of the Ribbon closes the active window.
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SYSTEM CONFIGURATION DEFINITIONS

In order to properly communicate with and engineer Cylon BACnet Sites, the Cylon software installed on a PC must
be given specific configuration information describing the sites to which the Software will connect, and the methods
of connection to each of those sites.

What is meant by “System” during configuration?

The “System” is the current installation of CXpro"®? software.

What is a “Site”?

A physical BMS Site in the Cylon system is either a single Field Controller acting on its own, or a collection of Field
Controllers grouped into fieldbusses, co-ordinated by one or more Networks.

In the Cylon Software, a “Site” is the virtual representation of such a physical BMS installation, and that virtual
representation is specified using the Cylon Configuration utility.

What is meant by “Network”?

There are 2 distinct types of channels through which the Cylon Software can connect to a physical BMS installation:
e Serial Connection (RS232)
e BACnetIP

Each of these channels can be enabled or disabled, whether or not Sites have been configured to use them.
Disabling channels can prevent delays when connecting to or disconnecting sites, by avoiding ‘auto detection’
being carried out through unused channels.

34

© Cylon Controls Ltd. MANO133 rev 15



CONFIGURING SITES

When you set up a Site, you need to provide the following information:

e The method that the supervisor PC will use to communicate with the Site

e The name of the Site

w
<
%]
o+
(]
3
(@)
o
=}
=
(o]
=
=
)
=2
o
=}

e The directory on the PC where the site information is stored

e The number and type of controllers on the site

e The controller names

Defining the contents of a site

The Cylon software system must be able to communicate directly with individual controllers within a Site. In order
to do this, the software system must know how many controllers a Site contains and must be able to identify
individual controllers.

The following information must be specified for each Site:
e  The number of Networks on the Site
e  The number of Field Controllers that are attached to each Network

e The names of the Field Controllers on the Site

This information is specified when adding a Site to the system by right-click on the root node of the Site Tree (i.e.

the Sites node) and selecting Add Site

Fapnrr e i Add Site X
¥ Disconnect | [ Paste =
& |_"jj Site Name: []
L.l Select All List Directory: |
Site Clipboard
) ) Type of Connection for this Site:
Site List 23 € Serial Connection
. . + BACnetIP
Discover Site to open the Add Site d |a|0g' I™ Enable BBMD - Site Level
Import V7 Sites 1P Address | 0 .0 .0 .0 47808
Restare Sit s
astore Site Time toLive |50 seconds
=] Add Site =
- Networl
LB 00t - nm - CRAADR Qﬁ

or when editing an existing Site by right-clicking on its node in the Site Tree and selecting Site Properties

50 Sites
2o 10020801 Site Properties X
2
I BACRetlP vome: [ENEEEERD
B-Tg BACnet Serial
I Campus block B Directory: [ CAMPBLOR
o .
El-Ig PL Office PELTEIE Type of Connection for this Site:
== - e € Serisl Connecticn
001 - - q
[ 3 BACnetIP
TS ot assecymTERA Dat to open the Site Properties L e
H nable - Sif evel
L= 001 - Create BACnet EDE Data dialog:
58 002 - Net 1P Address | 0 .0 .0 .0 47808
o Commission BACnet Devices
E-im Sample Apps Time toLive |60 seconds
Bl-Ig Stores Edit Controllers =
Delete Site
Site Properties Cancel

Site Properties / Add Site Dialogs : Site Information section

Each site on the system is given a unique name to identify it to the user and Cylon programs.
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+* Name

The Site Name is used to identify the site at all ~'t¢ Information

places throughout the Cylon system. The Site Mame
name is entered in the Name field of the Add Mirartan: | PIOFFICE

PL Office

Site dialog box and can be edited in the Site
Properties dialog when editing an existing Site.

++ Directory

i : PL I
You use the Directory field to specify the S Ice

directory that will contain the site information. Directory | PLOFFICE

When adding a new Site, enter the name of the directory to contain the files for this Site. The name that you input
here will be assigned to a subfolder of the cXpro®? directory that will be created to contain the site information.

e The software will suggest a directory name as you type the Site name in the Add Site dialog.

e The Directory name is limited to eighty characters.

Giving two sites the same Directory name will cause the system to malfunction.

e The Directory cannot be edited in the Site Properties dialog when editing an existing Site.

Site Properties / Add Site Dialogs: Selecting the Network for connection to a site (Type of
Connection)

Type of Connection for this Site
(") serial Connection
(®) BACnet IP
+»+ Serial Connection (RS232)

If the Supervisor PC will connect to the Site by Serial communication (R$232), select Serial Connection

«* BACnet IP

Editing the number and names of controllers on a site

There are several reasons why you may wish to edit the information about the controllers on a particular site. For
example:

e Anew Cylon site has been set up

e A Cylon site connected to the PC has changed, (so the system information has to be changed to match)

e  You want to change the description of a controller

Cylon programs must contain accurate information about the number and types of controllers that each site
contains. This allows the supervisor PC to communicate accurately with the system sites.

You must specify the number and names of Networks on a site, and the number and names of Field Controllers
attached to each Network.
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To edit the controllers on a Site, right-click on the Site in the Site Tree and select Edit Controllers : )
1%}

¥, BACnet [, Compare o

Site Configuration =

0O

Site List > A g

3

E@ Sites o

25 10020201 s

25 BAChetIP §.

25 BACnet Serial

¥ o) Campus block R

Discover Site

EBackup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

Commission BACnet Devices

Edit Controllers b
Delete Site

e
=

--JE_E Sample Apps B
E]"'JE-E Stores Site Properties

Which opens the Edit Controllers dialog, showing all of the Networks on the site. When a Network is selected, the
dialog displays the Controllers connected to the selected Network.

Edit Controllers - Campus block R *
Metworks Controllers
1 Metwork(s) for Site:  Campus block R 2 Controller{s} for Network: 001 - Network
Address | Name Type Metwork | Device In... | Duplicate Address | MName | Type | Device In... |
: 1 001 - 001 - CBMO3 CEMOE 4
2 001 -002 - CBV-2U..,  CBV-2U4-3T-N 65644

< >

Add Edit Delete Add Multiple Add Edit Delete | Add Multiple |

OK I Cancel |

Note: You can also select a Network by opening the Edit Controllers dialog directly from that Network in
the Site Tree :

Site List n B Edit Centrollers - Sample Apps BACnet X
- Sites Hetworks Contrasers

Za 10020801 § Networkls)for Ste:  Sample Apps BACnet 1 Controlleris} for Netwark: 003 - FCU

-5 BACnetIP Address | Name [Type Network | Device in_ | Duplicate Address | Mame Tepe Device In...

25 BACnet Serial o -Wekiptems R 1 10100 10050100 Modulsti CELRE Moz

S Campus block R z i)
Sa PL Office

£ Sample Apps BACnet
53 001 - Wet Systems
-2 002 - #HU

1
z
5
a
5
6

B
Export ASPECT/INTEGRA Data

B2 00« update AChet EDE Data

B oo

Mg Commission BAChet Devices - 5

o SO e comratins S Lo L= o = | | |
Routerproperties ¥

The Edit Controllers dialog box is used to specify the Network and Field Controller numbers and names.
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By default, Networks are assigned sequentially numbered names in the format 001-Network, and Field Controllers are
assigned names in the format 001 - 001 - CBM24, with the Network or Field Controller number increasing in line

with the number of controllers on the site.

The Field Controller name must be unique in the Site, so the Router address is included - e.g. on Router address 1, and

Field Controller address 2 it can be either 201 - 002 - CBM24, or CBM24 - 002 - 001.

The default names are automatically assigned but can be edited as necessary.

The dialog box allows you to specify the types of Networks and Field Controllers contained in the site, and the number
of Field Controllers that are attached to each Network.

The left-hand pane of the dialog lists the Networks on the site. At the top of this pane, the Site Name and total

number of Networks are displayed:

ks

Metwark(s) for Site:  PL Office

A& Mame Type
001 - Metwork CER

Device In... Duplicate

The right-hand pane of the dialog lists the Field Controllers connected to the Network that is currently selected in the
left-hand pane. At the top of this pane the name of the selected controller and the total number of Field Controllers
attached to the selected Network are displayed:

Controllers
0 Controller(s) for Network: 001 - Network

Ad... & MName Type

¢ Adding Networks to a Site

Device In..,

Before adding Field Controllers, one or more Networks (fieldbusses or Subnets) must be defined. The fieldbusses can be

MS/TP or Modbus.

To add a new Network to the site, click the Add button underneath the Network list.

The New Router dialog will appear:

Mew Router

Network Number | B
Name | 002 - Network

(001 - Metwork’ or ‘Metwork - 001')

Controllerype [cr =]

Device Instance (0 to 4194302

IP Address | . . . |

[ Enable BBMD - Router Level

—
—

r
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The next available Network Number is automatically assigned, but you can manually enter a different value in the
Network Number field.

e Enter a name for the Networkin the Name field.

e Select the Router type from the Controller Type drop down list.
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e Enter a BACnet Device Instance Number .

e Optionally enter an IP address and Port Number for the Router.

e |f the Router is to be used as a BBMD, to transfer communications to a different BACnet network, check
the Use as BBMD checkbox.

Click the OK button to confirm your choice.

Note: Additional tabs are displayed if a Modbus-enabled router is selected, to allow different Address and

Name to be set for each fieldbus.

Edit Comms Controller Details Edit Comms Controller Details

MSTP1 | Modbus |

Address: 1 Address: 1
Name: |01 - Metwerk Name: |01 - Mtk
Mame format: ‘007 - UCxxex or U Cxxx - 001" Mame format: ‘007 - U Cxxxe’ ar U Cxmex - 007"
Defaul Type: [cer =l Default Type: |CBR/MOD =l
Device Instance Device Instance
Number. 010 4134302) 12221 Number. 0 10 4134302) 155151

Cancel Cancel

Note: If the router type is set to CBXi, then additional fields are displayed in the Edit Router dialog that
matches the Field Controller dialog described in Editing Controller information on page 40 and FLX
I/0 modules on page 41

Edit Router x

Network Number
Name | 02 - Netwark

(001 - Network' or "Network - 001

Controller ype | CBXi h

Device Instance Number | 554231 (0 to 4194302)
P Address :Port [ 152 . 166 . 85 . 146 | :[67 |

Modules

Addr...  Type Dipswitch Add

1 FLX-BRB. Delete

2 FLX-4R4-H
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Note: If the router is set to a type that does not support routing BACnet traffic to MS/TP networks, the
right-hand section of the Edit Controllers dialog will be disabled.

¢ Adding Field Controllers to a Site

To add a new Field Controller to the currently selected Network, click the Add button underneath the Field

Controller list. The New Controller dialog will appear.

New Controller

Address | 1

Name | 001 - 001 - CBM24
Mame format: '001 - 001 - CBood or 'CBooc - 001 - 001"

Caontroller Type | CBM24 v

DView All Controllers

Device Instance Number 5539| [0to 4194302)

The next available controller address is automatically assigned, but you can manually enter a different value in the
Address field.

Enter a name for the Field Controller in the Name field.

Note: A controller name cannot be more than forty characters long.

Select the Field Controller type from the Type drop down list. By default, only controller types from the current
product range are listed. However, if the 'View All Controllers box is ticked, all supported controllers will be listed.

Click the OK button to confirm the choices that you made in the dialog.

Set the Device Instance Number . This must be an ID for this controller that is unique within the Cylon BACnet Site.

Note: The number set here in the CXpro"® must match the Device Instance Number set in the Field Controller.

+» Editing Controller information

Clicking the relevant Edit button while a Network or Field Controlleris selected causes an Edit dialog to open, which
has identical parameters to the corresponding ‘ New ’ dialogs above. If you change the values of any of the
parameters in an Editdialog and click the OK button then the parameters of the selected Controller will be updated

to match the dialog.
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** FLX1/0 modules )
1%}
-+
If the site includes CBX-8R8 devices, their I/O capabilities can be expanded by adding FLX devices. The expanded B
I/O must be configured on each CBX-8R8 device as follows: ()
>
=2
In the New Field Controller Details dialog change the Controller Type to CBX-8RS8 : e
QU
Edit Controllers - Campus block R g
Metworks Cantrallars S

1 Network(s) for Site:  Campus blor New Controller - Network

Name | 001 - 002 - CEMO3
Name format: ‘001 - 007 - CBioo or "CBxac - 001 - 001

Controller Type | CBMO8

Device Instance Number

Cancel

Add Edit Delete  Device Instance Number mi Add Multiple

oK Cancel

CBVT
CBX-8R8
UCU32.13VAV

An I/O Modules table will become visible in the New Controller dialog:

New Controller

Address | 2

MName | po1 - 002 - CBX-8RS
Name format: '001 - 001 - CBxox’ or 'CBiocx - 001 - 00T'

Controller Type | CBX-8R8 ~

[¥] View All Cantrallers

Device Instance Number (0ta 4134302
Modules
Addr.. Type Dipswitch Add
Delete
There are no items to show in this view.
oK Cancel

Device Instance Number must not be empty!

If the CBX device has one or more FLX modules connected to it, add the same number of entries in the 1/0 Modules
table:

170 Modules 1/0 Modles 140 Modues
addess Type Dipswitch o 1 Addess Type Dipswich = | Bddiess Type Dipswich o
1 FLXaRS H 1 FLXGRS E
Thete ate no Rems t show in this view: | (1T Delcle,

2 FLX8RS

Device Instance Number must not be Device Instance Number must ot be [Device Instance Number must ot be
empty! oK Cancel empty 0K Cancel jemptyl oK. Cancel

If you attempt to add more modules than the CBX can support, an error message will be displayed:

ccconfig

%4 The msiimum /0 madules allowed for this controller have already
RaY been added.

When the correct number of FLX modules have been configured, enter a Device Instance number and click OK .
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Edit Controller Descriptions - East Hall “
Comme Controllers on Site: Field Contraller on Subnet
[EastHall 001 - Metwork
Totak [ 1 Totat| 3
&d. 7 Mame Type DeviceIn.. DuplicatzIL| | | d.. / Name Tope Device In.
1 001 -001 - CBM24 CEBMZ24 5001
2 001 -002 - CBX16 CBX8R8 456
ﬁ 4 001 - 004 - CET12. CBT1ZMAV 774
x
©
=
(o]
=
o
Add. Edit. Delete Generate Names. Add. Edt. Delete Generate Names.
Cancel

In the Strategy drawing, |0 blocks can be added up to the total on the configured FLX modules plus the CBX onboard

10.

Note: If a FLX module is deleted from a CBX configuration (in the Configuration Utility) after the Strategy
drawing has been set up, the blocks associated with that FLX’s 10 will be ‘greyed out’ to indicate
that they are inactive.
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+» Modbus devices

A CBX controller can communicate with up to 4 Modbus devices connected to its Modbus RTU port.
A CBXi Controller can communicate with 24 Modbus TCP/IP devices or 12 RTU devices.

These devices are configured in CXpro"® in a similar way to FLX modules.

To configure Modbus devices,
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1. open the strategy of the CBX or CBXi to which the Modbus devices are connected

2. inthe Site Tree right-click on the CBX or CBXi, and

w

Site List

select Configure Modbus Devices from the context menu

E@ Sites
2o 10020801

o BACnet IP

o BACnet Serial

rll:l f-lu.l-

1=
Io
25 PL Office

Campus block R

53 001 - Network
=, 001 - 001 - CBMOS

L > lE 001_01
(02 - (B SRS
Configure Modws Devices
Break
Copy Strategy To
Strategy operations 3

Export ASPECT/INTEGRA Data
Update BACnet EDE Data

Controller Properties

T

This will open a dialog that allows you to configure the CBX’'s Modbus RTU port to match the attached devices and

to add an Address and Name for each of those Modbus devices.

Configuring the CBX or CBXi’s Modbus RTU port

Configure Modbus Devices

E.
i [15] Electricity Meter
-[1] Lighting Offices

i [1] Lighting Production

Devices used: 3 /4

add | |

Configuration

Baud 9600 =
Parity hone ]
Stop bit 1 M

Inter-packet delay

200 ms (40-500)
200 ms (200-10000)

Deleting a device will disable any assodated point in the strategy.

Communication Timeout

Cancel

=]

When the RTU node of the Device Tree is selected, you can specify the Baud, Parity , and Stop bit settings that

all devices on the RTU network will use to communicate.

Note: With Modbus, all devices on an RTU network must be configured with the same communication
parameters for the network to function properly.

MANO133 rev 15
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Set an Inter-packet delay value that is reasonable for the devices on your network. Modbus devices commonly need

time for the RS485 transceivers to switch from a writing mode to a reading mode. Some Modbus devices will write
to their flash or perform similar operation before being ready for the next Modbus command to be sent. Set the
Inter-packet delay to a value that allows for the worst-case operation.

The Communication Timeout is the time the CBX will wait before giving up on one request and moving on to sending
the next request.

Note: The status output of a Modbus Analog or Modbus Digital module will display a value that is non-zero
for any failing Modbus transmission.

Adding and Removing Modbus Devices

Before a CBX or CBXi can access Modbus points, it must be configured with a list of Modbus devices that is available
to the Modbus Analog or Modbus Digital modules.

To add a device, click the “ Add ” button

Cenfigure Modbus Devices X

=)
Canfi i
[15] Electricity Meter S

[1] Lighting Offices Baud 9500 -
[1] Lighting Production
Stop bit 1 hd

Inter-packet delay 200 ms (40-500)

Communication Timeout 200 ms (200-10000)

Deleting a device wil disable any assodated paintin the strategy.

Devicesused: 3/4

Add oK Cancel
| o | _cna |

A new device will be added to the tree. Select it:

Configure Modbus Devices ®
ErRTU Configuration
- [15] Blectricity Meter
- [1] Lighting Offices Name Device
1] Lighting Praduction
E@ Address 1
Deleting & device will disable any associated point in the strategy.

Devices used: 4/ 4
:l Delete ok Cancel

and then edit the Name and Modbus Address of the Modbus device.
The Address must be one of the following:

e  Modbus RTU - A number between 1 and 255.

e Modbus TCP - An IP address with optional port, in the format nnn . nnn . nnn . nnn : pppp. The port (pppp)

is separated by a semicolon. The port is optional, and if omitted the default Modbus port of 502 will be
used.

e Modbus RTU device behind a Modbus Router - An IP address with an optional port and RTU address in
the format nnn . nnn . nnn . nnn : pppp / zzz The port (pppp) is separated by a semicolon. The RTU
address for routing (zzz) is separated by a ‘/’ character. The port is optional and if omitted, the default
Modbus port of 502 will be used. For routing, the RTU address is required.
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Note: The Modbus Addresses do not need to be sequential.

To delete a Modbus device from the list, choose the device, and click the “ Delete ” button.

At any time later, the Address of the Modbus device can be updated without any change to the Modbus Analog or

Modbus Digital modules in your strategy.

Accessing Modbus points in the Strategy

To access a point within any of the Modbus devices configured for a specific CBX, add a

Modbus Digital module (whichever is appropriate for the point) to that CBX's Strategy.

b x| Modules £

~
Favorites
Constants
Controls
Functions
Math

Schedules, Timers, and Logic

drixlrlxr > |r Flm

Setpoints, Inputs, and Outputs
Al

Analog Input
AO  anzlog Output
(2 mnalog Setpoint

S9 sacnet analog

S8 sacnet anaiog prority array
o
g BACnet Binary

a

@B Bacnet Binary priority Amay

DI

Digital Input

DO pigital Output
1L pigital Setpoint
23 Modbus analog

a
Gt Modbus Digial

Modbus modules are displayed as follows:

Modbus Analog 1 0 Modbus Digital 2
Lo
€ vahue in Vahue ot €3 [ vakee in Vale out [
[ Witz contrel Status £ [ Writ= control Status £
Device: Device 1 Register: 0 Device: Device 1; Goilfinput: 0

In the module Properties , specify which of the CBX's configured Modbus devices contains the required point:

[ X | Properties B x |
Lol ? |MndhusAnalﬂg j
=] |
Type Modbus Analog
Service Order 1
Synchronised Status  Disconnected
=]
Valuein Analog
Write control Digital
=]
Read Frequency 30
Modbus device Electricity Meter |E|
Dats type
On  Vedwiu e Data format i Offi
i
) 3 Vak= in ‘ Vah= ot @ ) Endian oy =
Writs control Status £ Word swap Mo swap
j I@ Registeraddress
. . B . . Default Value 0.0000
COV Value 0.1000
Min COV Time 30 —
‘Write Frequency 30
=]
Value out Analog ﬂ
Modbus device
This is the Modbus device this module will
communicate with.
v
>

Macros  Properties  Page Mames  Modules

Modbus Analog module or

Modules

Favorites

Constants

Controls

Functions

Math

Schedules, Timers, and Logic
Setpoints, Inputs, and Outputs

Al

AO analog output

Analog Input

(2) analog setpoint

e BaACnet Analog

?E BACnet Analog Priority Aray

2% sacnetsinay
@B sacnet Binary Priority Amay

DI

Digital Input
DO oigital output

£ pigital Setpoint
O
[

3-, Modbus Digital

Modbus Analog

Crlv vy v < g
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The modules are capable of interacting with the following Modbus entities:

Module Action Modbus Entity
Modbus Analog Reading Input Register
Modbus Analog Reading and Writing Holding Register
Modbus Digital Reading Discrete Input
Modbus Digital Reading and Writing Coil

For writing to occur, the “ Value in ” input of the module must be connected. For reading to occur, the “ Value out ”

output of the module must be connected.

If Write Control is connected, then the input value must be a 1 before COV or other timers are evaluated.

Reading data from a Modbus device is done periodically and controlled by the “ Read Frequency ” constant.

Writing can be performed either periodically or be triggered by a change of value. For a Change Of Value, if the
input value to the module changes (or, in the case of a Modbus Analog module, changes by a predetermined
amount), then a write is performed.

The Modbus Analog module can handle endian differences, word swapping, and interpretation of the value read from

the Modbus device.

¢ Removing a Controller from a Site

Clicking the relevant Delete button while a Network or Field Controller is selected, will remove the selected
Controller from the list.

¢ Adding Multiple Controllers

At certain times you may find it convenient to add several controllers to the site at once.

The Edit Controllers dialog contains an Add Multiple button underneath each of the Network and Field Controller

lists.
If you click the button under the Network list, you can automatically add several Networks to the
Site.
If you click the button under the Field Controller list, you can add several Field Controllers to the
currently selected Network.

When you click either Add Multiple button, the relevant Generate Default Names dialog will appear.

Add Multiple Controllers Add Multiple Controllers
Number of Contraliers [0 | Number of Controllers | 1
Controller Type |CBR v Controller Type | CBM0B v
[¥] View All Controllers [] view Al Controllers
Mame Format | 002 - CBR Name Format | 002 - CEMOS
(001 - <Text>" or "<Text> - 001" where 001 will be the incremented) {001 - <Text>" or '<Text> - 001" where 001 will be the incremented.)
Starting Device Instance Number (0 to 4184302) Starting Device Instance Number (0 to 4194302)
Cancel Avalid Device Instance Number is required! oK Cancel
46 © Cylon Controls Ltd. MANO0133 rev 15



These dialogs are similar to the Add dialogs for single Comms and Field Controllers, with the exception that the
Address parameter is replaced with a Number of controllers parameter.

This parameter specifies the maximum address that will be used to generate controller entries. What that means
is that controller entries are generated starting at the next available controller address and continuing as far as the

address specified in the Number of controllers box.
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For example, if controllers exist for the current Network up to address 5, and the Generate Default Names facility is

used with 10 in the Number of controllers box, then Controllers will be generated for addresses 6, 7, 8, 9 and 10.

Note: The Number of controllers parameter does not represent the total number of items that will be
added automatically. Instead, it represents the maximum address that will be generated.

¢+ Sorting the Controller List

The Network and Field Controller lists can be sorted based on:

e Address
e Name
e Type

By default, the controllers in the list are sorted by address. To sort by any of these columns, click the column header
at the top of the controller list.

+¢ Saving the changes made in the Edit Controllers dialog

When you click OK from the Edit Controllers dialog, the changes are immediately validated.
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CONFIGURING SERIAL PORT CONNECTION

In order to modify Serial Port settings, or to choose between serial ports if your PC has multiple ports, open the
Application Settings dialog by clicking on the Settings icon in the Settings group of the Home ribbon:

file = Home Controller Strategy

ﬁ Connect @ Copy Properties | Page Mames | Search r“ r‘l r‘] r‘] . 'g BACnet
‘e’ Disconnect L?j Paste BACnet Properties Modules Ezl Strategy Help g w Fh . - ) E& Strategies
Database Datalog Site ME-Pro | Settings

_____ [] Reopen Strategies

[ Navigation [IE macros Interface Manager Organiser
i Utilities Settings

Site Clipboard View

In the Application Settings dialog, select Serial Port Connection :

Application Settings *

Download Options
¥ Enable Serial Connection

Scan Options
Detected |3
Strategy Settings
COM Port I l
BACnet Configuration o com1 -
Serial Port Connection Port Speed Im vl

Commands

Livelog

(o]4 I Cancel Apply
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CONFIGURING STRATEGY DEFAULTS

By selecting the Strategy Settings option in the Application Settings dialog, you can set several default values for new

Strategies:
Application Settings *
Download Options ~ Strategy filles
Scan Options I Reopen Strategies
PP ¥ Enable auto-backup
| Strategy Settings | |
V¥ Autosave every |10 = minutes
BACnet Configuration
Serial Port Connection [~ Analog inputs default
Commands Temperature to Celcius -~
Livelog Mote: this value apply only to new analog inputs. Existing inputs will

keep their values

~ Analog value precision

Show this number of decimal places IZ ::ll

oK I Cancel I Apply |
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This can be opened directly by clicking on the Strategies icon in the Settings group of the Home ribbon:

le - Home Controller Strategy

,G"Connect @Copy

‘e’ Disconnect L?j Paste

j Properties | Page Hames| Search

Site
Select All List Navigation Macros
Site Clipboard View

BAChet Properties Modules EE Strategy Help

i ' ne
E m q G o E%:::te:g

Database Datalog Site MEB-Pro | Settings
Interface Manager Crganiser

Utilities Settings

|:| Reopen Strategies

Also in the Settings group of the Home ribbon, there is a checkbox that defines whether or not Strategies that

were open when CXpro"® was closed will be automatically opened when CXpro*P next starts.

v EﬁStrategies

Settings
qgen pen Strategies
ttinas

MANO133 rev 15
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CONFIGURING BACNET COMMUNICATIONS

In order to connect CXpro"® to a specific BACnet Site, you must set its system-wide BACnet Properties in the
Application Settings dialog.

These properties are the identity of the Network Adapter that will be used to connect the PC to the BACnet System,
and the Device Instance Number of that Network Adapter in the BACnet system.

Open the BACnet Configuration option in the Application Settings dialog by clicking on the BACnet icon in the Settings
group of the Home ribbon:

le ~ Home Controller Strategy

/O/C-:unnect @Capy Proper‘ties Page Mames Search i 'QBACH
[ e O; G Ce I

;”’Disc-:unnect LT‘jPaste BACnet Properties Modules Estrategy Help ' E&Strategles

= i Site o Database Datalog Site MNE-Pro | Settings i
i !aelect All List Mavigation Macros Interface Manager Organiser |:| Reopen Strategies
Site Clipboard View Utilities Settings

This opens the Application Settings dialog with BACnet Configuration selected

Application Settings x

Download Options Device Instance Mumber for this Computer
Scan Options Device Instance Number | (0to 4194302)
Strategy Settings

IP Address
BACnet Configuration

152.168.000.073 : Intel(R} Ethemet Connection (2) [219-LM j
Serial Port Connection

Port 147808
Commands
. Subnet Mask [255.255.255.0

Livelog

Retry Settings

Number of Retries |0
Time Out |20 seconds

v Enable BBMD - System Level
IP Address | 192 . 168 6 5 47808

Time to Live |60 seconds

I Enable BACnet NAT

OK | Cancel ‘ |

The Device Instance Number will be set to “-1”. This must be changed to a unique Device Instance Number.

In the IP Address drop-down list, select one of the PC’s network adapters to be used as the channel for all BACnet
communication. Set the Subnet mask in accordance with the local network policy — if in doubt ask your local
Network Administrator. The default is 255.255.255.0.

It is recommended that the Number of Retries is left at @ unless there is a clear reason for changing it.

Note: In order to avoid conflicts with Command settings for setand get, the BACnet Timeout should be set
to Number of retries =0 and Time out =20 seconds.

If you wish to connect to a remote BACnet site, enter that site’s IPaddress in the BBMD settings — System Level section.

Click OK to save these settings.
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Configuring BBMD

If you wish to connect to a remote BACnet Site, you must set a Network, a Site or the CXpro"® system to act as a
BBMD.
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What is BBMD?

Some BACnet services (e.g. “Who-1s") use ‘broadcasts’. These broadcasts are blocked by standard Ethernet routers
so that BACnet broadcasts are limited to the IP subnet of the BACnet device. A BACnet/IP Broadcast Management Device
(BBMD) is one way to get around this limitation on a BACnet/IP network of 2 or more IP subnets.

How a BBMD operates

A BBMD located on an IP subnet monitors broadcast messages on that subnet and constructs a “peer to peer”
message for each broadcast to pass it through any IP router. This “peer to peer” message is received by other
BBMDs on other IP subnets and transmitted as a broadcast on their attached subnets.

Since the BBMD messages are ‘directed’, individual messages must be sent to each BBMD. Each BBMD device
maintains a Broadcast Distribution Table (BDT), the content of which is usually the same for all BBMDs within the
network. Each BBMD must know the IP address of every other BBMD in the network.

Setting a BBMD in CXpro"®

BBMD properties can be set at the System Level, on a Site or a Network, and if more than one is set then it ‘cascades’
upwards. This means that if a controller attempts to communicate with a remote BACnet Site, it will use the Network-
level BBMD settings if any have been defined. If the Network to which the Controller is attached does not have BBMD
settings configured for it, then the Controller will use Site-level BBMD settings if any have been defined. If the Site
containing the Controller also does not have BBMD settings configured for it, then the Controller will use the System-
level settings.

BBMD Parameters

In the CXpro"® system, the following BBMD parameters can be set:
o IP Address
o Port Number
(] Time to Live (not available in Site-level parameters)

° Enable NAT ( Override “T am” ) (not available in Site-level parameters)
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Note: If a user wants to access a BACnet device across a firewall, they must setup a NAT rule on their LAN's
Firewall Router that maps a port number on the LAN’s public IP Address to an IP Address + Port
Number on the private side. The IP Address and Port Number must correspond to that of the BBMD

router.

<,‘:I External | Internal I:>

CXproHD
g —m BaChet P
/ BBMD
Router Router

Public IP Address Private IP Address
‘BACnet MSTP BACnet MSTP

In the diagram above, the LAN’s firewall router is set up to map a port number on its Public address
to the internal BBMD router address. The CXpro"® BBMD settings are then set to the firewall routers
external IP address & port.

In this scenario Discovery and the l-am messages reach CXpro"®, but when CXpro"® reads a property
for one of the discovered devices, it would by default use the source IP Address found by Discovery
(an internal IP address) instead of the actual BBMD address.

The Enable NAT ( Override "I am” ) checkbox on the BBMD settings in CXpro"® forces it to always use
the BBMD address for all communications.

++» System-level BBMD parameters

To set the BBMD parameters for the whole CXpro"® system, click on the BACnet icon in the Settings group within
the Home ribbon:

le ~ Home Controller Strategy

/G/C-:unnect @Capy Proper‘ties Page Names Search g r‘l r‘l r‘l 0 'Q BAC”TE
;”’Disc-:unnect LT‘jPaste BACnet Properties Modules Estrategy Help = w fh . - E&Strategles
Database Datalog Site ME-Pro | Settings

_ Site L )
i _iSelect Al List Na\rlgatlon I\ﬂacros Interface Manager Organiser [] Reopen Strategies

Site Clipboard View Utilities Settings

This opens the Application Settings dialog with BACnet Configuration selected. The BBMD - System Lev settings are at
the bottom of the dialog:

1me ULt |20 seconas

¥ Enable BEMD - System Level
IP Address | 192 . 168 6 35 47808

Time to Live (60 seconds

™ Enable BACnet NAT

OK | Cancel
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+»+ Site-level BBMD parameters

To set the BBMD parameters for a specific Site, right-click on that Site and select Site Properties

2o BAChetIP
2 BACnet Serial
%
E-Zg PL Office
{538 001 - New
..@’ oot -
% 001 -
=001 -
B 002 - Nen
25 Sample Apps

Io Stores

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

Commission BACnet Devices

Edit Controllers
Delete Site

Site Properties

to open the Site Properties
dialog:

The Site BBMD settings parameters are at the bottom of the dialog.

+»» Network-level BBMD parameters

Name: | Campus block R

Directory: | CAMPBLOR

Type of Connection for this Site:
" Serial Connection
¢ BACnet TP

Enable BEMD - Site Level

1P Address | 0 .0 .0 .0 47308

Time to Live |60 seconds

I Enable BAChet NAT

oK Cancel

To set the BBMD parameters for a specific Network, right-click on that Network and select Router Properties

- @) Sites
@=-2p 10020801
Zo BACnetIp
o BACnet Serial
B-3o Campus block R
5B 001 - Network
2-2n PL Office

B-52 001 - Network
B, 001 - 001 - CBMO3
ES, 001 - 002 - CBX-8RE
----- = 001 - 010 - CBTI3V!
o-8p sample 4 57 Open -0
B
o5 o002,
=g ek
..... E’ 2 Copy Strategy To
..... Elf 21
_____ gy Stteoy spemations
;’f 21 Export ASPECT/INTEGRA Data (CBXi Only)
= i Export ASPECT/INTEGRA Data (Entire Netwark)
_____ E; 21 Update BACnet EDE Data
""" = 2 Commission BACnet Devices
-2 003 -
-2 o4 - Edit Controllers
-2 0051 Router properties &
- 52 006 - b
-2 Stores

to open the Edit Router dialog:

Edit Router X

Network Number [E
Name [ 002 - Netwark

(001 - Netwark' or‘Netwark - 001

Device Instance | 554231 (010 4194302)

1P Address [ 192 . 168 .

35 . 146 |67

[T~ Enable BBMD - Router Level

1P Addtess ) . 0.0 [o
Time to Live [60 seconds
[T Enable BACnet NAT
Madules
Adar.. | Type [ Dipswitch | add
1 FLX-8RE Delete
2 FLX4R4H m

The 1P settings in this dialog include a checkbox to allow the router to be used as a BBMD.
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CONFIGURING SITE COMMUNICATIONS (COMMANDS)

The commands that CXpro"® uses to communicate with Cylon controllers can be adjusted from the Application
Settings dialog.

This can be useful in troubleshooting connection failures. It can be useful to tell the system to give the connection
more time to become established.
On the other hand, if you have a reliable fast connection it can be of more benefit to reduce the time taken to
establish connections, and so increase the speed and responsiveness of the system.
Command Settings
To adjust the Commands settings, open the Application Settings dialog by clicking on the Settings iconinthe Settings
group of the Home ribbon:
file = Home Controller Strategy
/G/C-Jnnect @Copy Properties Page Mames Search r‘l r‘l r‘l r‘] 1 'Q BACnet
o i =, = - g w FE‘E . ! -
& Disconnect ijPaste BACnet Properties Modules Ezlstrategy Help E&Strategles
..... Site Database Datalog Site ME-Pro | Settings
i_iSelect All List Na\rigation Macros Interface Manager Organiser [] Reopen strategies
Site Clipboard View Utilities Settings
In the Application Settings dialog, select Commands :
Application Settings X
Download Options Commands Time out (1-20s) | Retries (0-25)
Scan Options Contrber Detet 5 g
Strateqy Settings g?ug‘ge‘m g g
BACnet Canfiguration Set Block 20 2
Set Point 5 2
Serial Port Connection
Commands
Livelog
Reload
Number of Retries for Command NACKS (Failures) 3 -
oK Cancel | ‘
To edit a value, double-click on it in the Port Handler Command Settings dialog.
Clicking the “ Reload " button will cause all of the values to revert to their previous settings, and any changes made
will be lost.
Each command has a Retries setting:
e Number of Retries for Command NACKs (failures)
The retries in the main list apply to Timeouts, where no response is received. This parameter sets the
number of retries when a response is received, and the response is NACK, indicating a failure.
When the OK button is pressed, each edited value is checked to see if it is valid.
If a command Time Out is greater than 20 seconds then it will be reduced to 20 seconds, and if a Time Out value
is less than zero seconds, then zero seconds will be used.
If a command Retries value is greater than 25 then it will be set to 25, and if a Retries value is less than zero then
it will be set to zero.
54
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Profiles:

w
<
The following profiles provide advisory settings that may be helpful when requests from a site and its controllers, [
or manipulation of data, results in failures. 2
El
% TCP/IP Profile: &
Command Time Out Retry °5-’r,
Get Point 2000 1 >
Set Point 2000 1
Get Block 2000 1
Set Block 5000 1
Router Detect 2000
Controller detect 2000

+» Default Profile:

Command Time Out Retry
Get Point 2000 0
Set Point 2000 0
Get Block 2000 0
Set Block 5000 0
Router Detect 10000

Controller detect 10000
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MODULES - OVERVIEW

Modules are the building blocks from which strategies are constructed. They are the basic units of operation in
CXpro*P.

Modules perform tasks within a strategy such as
e bringing controller inputs into the strategy
e changing the values of points in the strategy according to mathematical rules
e comparing the values of points in the strategy
e recording the values of points in the strategy

e sending point values to the controller’s outputs.

Modules can be grouped and saved as in order to avoid repetitive tasks, i.e. if you use a particular strategy or part
of a strategy frequently, you can save it as a macro and reuse it without having to repeatedly re-create it.

ACCESSING MODULES

By default, Modules are available from the right-hand pane, by clicking the Modules tab at the bottom of the Pane:

b (= 11 — -

ition Database Datalog Site Backup ME-Pro
Interface Manager Organiser

Utilities
I x| Modules B2

~

ks

Favorites

Constants

Controls

Functions

Math

- Schedules, Timers, and. ..
Setpoints, Inputs, and...
' Statistics

Wav

v | v v v v . v v v v w

Virtuals

2 Page Mam... Properties Mowes

:ample Apps BACnet (3), J

The Modules Pane groups the available modules into Constants, Controls, Functions, Math , Schedules/Timers,

Setpoints/I/O , Statistics, VAV, and Virtuals . To access individual modules, click on one of the groups:
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=i _—_— - = - -9
onfiguration Database Datalog Site Backup NB-Pr
Interface Manager Organiser

Constants

Utilities
I X | Modules c
@,
~ >
- o
Favorites 2
o
o
=
(0]
7}

rcu Digital Constant

I_',..'.E Integer Constant

’5; Real Constant
Controls

Functions

Math

schedules, Timers, and...
Setpoints, Inputs, and...
Statistics

VAV

Virtuals

> Page Mam... Properties Mod

—

ted to: Sample Apps BACnet (3), |

There is also a “ Favourites ” group, where you can set up a custom list of modules that you use frequently or want

to be able to access quickly.
To add a module to the Favourites group, right-click on the module in the Modules Pane and select Pin to favorites :
.Setpoints, Inputs, an... - |

Al Analog Input

AO Analog Output

(7 pnplon cotmeint

) Add to Strate
oy g9y
e BA | Pin to Favorites |

by’

BACnet 2 Help

5]
L,: BACnet Binary

To remove a module from the Favourites Group, right-click on it and select Unpin from Favourites:

Modules n B
®
Favorites pn
I
(?\:1 Analon Setnoint I
Add to Strategy
A>B (o | "| s -
npin f&)m Favorites
I:_'.E Inte Removle(\grom list
Al anal Help
Constants y |1
r |
Controls ~
r J
| Functions > |
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PLACING A MODULE ON THE DRAWING AREA

In order to use a module in a strategy, you must place it in the strategy’s ‘drawing area’.

To do this, click on the module name in the Modules pane:

a

s CXproHD - 1.00.00-320

roperties I Modules

Mavigation Macros D Reopen Strategies

’Cunnect @Ca
.ﬂDlscamnect LﬁPa::Z r& r'é m rlrli;ﬁ Q G

Y |

File - Home Contraller Strategy G)

Site ———— Configuration Database Datalog Site Backup MB-Pro
List EPage Names|@sear(h Interface Manager Organiser
Site Clipboard View Utilities
Site List n g |« Strategy1 b X | Modules L |
E‘“@ Sites Ll ~ ®
=] JE.E BACnet P . T, S o Favorites b~
B-Z2 001 - Network e
= 001-001 - UCU32 . Ll r
= 001 - 002 - CBM24 Controls »
JE_E BACnet Serial Functions »
Sample Apps BACnet I i
=] _@_ 001 - Wet Systems .Math & I
E,¢ 1111 - CT Single P Schedules, Timers, a »
& 1112 - CT Single P Setpoints, Inputs, an.. -
& 1113 - CT Single P . L S T
B, 1114 - CT Dual Pu Al analog Input
= 1115 - CT Dual Pui
i
@ 1116 - CT Dual Pu . P JE o AO Analog Output
=, 1121 - VT Single Pr . L S T A
4 ~) analog Setpoint
&, 1122- VT Single P . e g Setp
-~} 1123 - VT Single P . T o S0 |83 eacnet analog
@J 1124 - VT Dual Put
-, 1125 - VT Dual Pur BACnet Analog Priority...
B, 1126 - VT Dual Pur e .
=), 1131 - Four Boilers L~ BACnet Binary
&), 1132 - Four Builers . L S T B v
DACrAt Dinans Nrinete o
&, 1133 - Two Boilers . L S N | =
= aine - noa
< > < > Page Mam... Properties Modules

f—

Connected to: Sample Apps BACnet (3],

Then click on the Strategy Drawing Area at the position where the module is to be placed (note the cursor changes

to the “Module Cursor” during this process):

a

s CXproHD - 1.00.00-320

Madules
Mavigation Macros El Reopen Strategies
E Page Names |@ Search

[ [ Ce G0,

Configuration Database Datalog Site Backup MB-Pro
Interface Manager Organiser

’ Connect @ Copy
", Disconnect L'a Paste

- oW

File - Home Controller Strategy G)

Site Clipboard View Utilities
Site List o g |« Strategy1 I X | Modules A |
B Sites -~ S x
&g BACnet P . o o o Favorites y A
3.5 001 - Network e
& 001 - 001 - UCU32' = U
= 001- 002 - CBM24 Controls »
o BACnet Serial Functions N
=] JE_E Sample Apps BACnet .M -
EE 001 - Wet Systems | = 4
@, 1111 - CT Single P Schedules, Timers, a... »
S, 1112 - CT Single P Setpoints, Inputs, an.. -
~& 1113 - CT Single P . o o R [
=], 1114 - CT Dual Pui . o o - ||Al 2nalog Input
., 1115 - CT Dual Pui
&
., 1116 - CT Dual Pur . S L T AO analog Output
= 1121 - VT Single Pr A
.: = )
.....@,1122-VTSmglePu L1 Analog Setpoint
-~ 1123 - VT Single P . o o © |23 sacnetanalog
EJ 1124 - VT Dual Pur
B, 1125 - VT Dual Pur BACnet Analog Priority...
&, 1126 - VT Dual Pur B i
.....E,HN-FuurEuilars . FE F Lo L@ BACnet Binary
E,¢ 1132 - Four Boilers v
- : DArnAt Dinans Nrinrte &
- 1133 - Two BOI.\EI’S v v || £ >
< > < > Page Nam... Properties Modules

Connected to: Sample Apps BACnet (3),
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Some modules (e.g. Analog Input) prompt for basic configuration information when they are first placed. When
this happens, fill in the dialog and click OK

c
= CXproHD - 1.00.00-320 - o
File - Home Controller Strategy @ 0%
Connect Copy ] Propert Madul
"' onne @ opy [E| Properties odules m g m m[g:a m r‘] 8-
;”'Disc-:mned LﬂPaste Nauigatiun Macrus D Reopen Strategies = c
ite Configuration Database Datalog Site Backup NB-Pro (T
Select All List |[[E] Page Names|[a]search Interface Manager Organiser w
Site Clipboard View Utilities
Site List ||« Strategy1 b X | Modules 0 x |
Ee Sites " A e
-Ig BACnetlP o R o Favorites s
B-Z2 001 - Network Tt
& 001 - 001 - UCU3Z = U
L..™ 001 - 002 - CBM24 . Point Name L. Controls »
So BACnet Serial : BE Functions S
E-Ig Sample Apps BACnet
= _@_ D01 - Wet Systems Paoint Name | Room Temperature Math [ 3
B, 1111 - CT Single P Schedules, Timers, a.. N
&, 1112 - CT Single P . A Setpoints, Inputs, an... -
-----Efﬂﬁ-CTSmg\eP . A
.=, 1114 - CT Dual Pur . oK cance! .. | Al' analog nput
B, 1115 - CT Dual Pui . T
+
E, 1116 - CT Dual Pur Lo Lo Lo AO Analog Output
=, 1121 - VT Single P S S P A
: ~) analog Setpoint
., 1122 -V Single P S S P L. g Setp
=, 1123- VT Single P R B o 2% Bacnet Analog
B, 1124 - VT Dual Pur
&, 1125 - VT Dual Pur BACnet Analog Priority...
E, 1126 - VT Dual Pur S S e B _
.....EJ’ 1131 - Four Boilers [ Lo FE L. g BACnet Binary
.=, 1132 - Four Boilers A T A ) » -
= EE S S DhZost Dingo, Boisgbo l
’_( 1133 - Two Boilers i v L€ >
< > < > Page Nam... Properties Madules
Setup block updated. Connected to: Sample Apps BACnet (3), I—Ji

The module is displayed on the Strategy Drawing, and as it has just been placed it is automatically selected. This is
indicated by a green outline:

= CXproHD - 1.00.00-320 = =

File - Home Contraller Strategy @

"Cannect @Copy ] Properties Modules Fﬂ F. Du m[h D& F
=

;”'Disc-:mned LEPaste Nauigatiun Macrus DReupenStratEgiEs

ite Configuration Database Datalog Site Backup NB-Pro
Select All List Page Names @Sear(h Interface Manager Organiser
Site Clipboard View Utilities
Site List L x (R Strategy1 b X | [Modules L x |
- Sites ” A ®
El-fg BACnet P o o Favorites [
- &2 007 - Network Al Femsbes R o e
& 001 - 001 - UCU3Z """’“'r“"“‘“:: = BRI o T b
= 001 - 002 - CBM24 L F FE Controls »
o . | overc= 0]
-5 BACnet Serial P P Functions R
B %.E Sample Apps BACnet e
EE D01 - Wet Systems 2 4
E, 1111 - CT Single P Schedules, Timers, a._
-, 1112 - CT Single P o o R Setpoints, Inputs, an... -
.=, 1113 - CT Single P L L o
=, 1114 - CT Dual Pui o o C ... Al analog input
..™, 1115 - CT Dual Pui Lo Lo Lo
+
@,1115-CTDuaIPU| Lo Lo P AO Analog Output
[, 1121 VT Single P S S P A
$ ~) analog Setpoint
=), 1122 VT Single P o L I |« g Setp
&), 1123 - VT Single P1 2: BACnet Analog
B, 1124 - VT Dual Pur
@, 1123 - VT Dual Pur S T, S BACnet Analog Priority...
E, 1126 - VT Dual Pur S S e B _
.....E,nn.;ourgguers [ Lo FE L. g BACnet Binary
E,WB!-Fouerlers i .
-----@,1133-Twn Emlersv R Lo R BACnet Binary Priority A...
[ APPEPR
< > < > Page Nam... Properties Modules
Setup block updated. Connected to: Sample Apps BACnet (3), I—Ji
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It is possible to examine and edit the properties of the selected module by clicking on the Properties tab at the
bottom of the Right-Hand pane:

8

= CXproHD - 1.00.00-320 - B
File *  Home | Controller  Strategy @

& connect | £ Copy  Properties |[[Ef] Modules | J?] strateay Help r& F m :11 m G
=

b”D\sc:mnect LﬁPaste Nawgation Macros D Reopen Strategies

e | 6 [ e e o Bt s re 7 "
Site Clipboard View Utilities
Site List L =< Strategy1 I X | Properties n B
B-§) Sites “ " ? ,—L|
g-Bg BAChetIP — S N ||CE =
i nput —
S S v | [Al e | e s
L1 001 - 002- CBM24 po-"m® Service Order 1
a A Overrice [§ Name Room Tem...
- £o BACnet Serial
B EI-E Sample Apps BACnet L R R R o Synchronis... Discennect...
252, 001 - Wet Systems = .
&} 1111 - CT Single P . R R R B Paintty.. Input Anal..
) 1112- CT Single P . R R R B Lowthresh... 0
&), 1113 - CT Single P High thres... | 0
&=, 1114 - CT Dual Pui o S S S S Lower sens... |0
@, 1115 - CT Dual Pui R P P P P Upper sens... 0
&=, 1116 - CT Dual Pui . S S B B Input error ~ 0.0000
&, 1121 - VT Single Py C o o o o Exponential... 60
-, 1122 - VT Single P Sensortype  PT1000
-5 123 VT SinglePr || S S S o Unit e
-5, 1124 - VT Dual Pur o L L L A Averaging 0
&, 1125 - VT Dual Pur o o o o S = =]
&, 1126 - VT Dual Pur
E‘, 1131 - Four Boilers
-, 1132 - Four Boilers
""Efn_}‘%’-fwngm_‘lysv . R R R R
< > < * Page Mam... Propertjgs Modules
Setup block updated. Connected to: Sample Apps BACnet (3), f}jf

You can edit the properties of the selected module by clicking in the property's value in the right-hand pane. Help
text relevant to the property being edited is displayed in the lower portion of the Right-Hand pane

@ - CXproHD - 1.00.00-320 - o

Fil F- Home | Contraller  Strategy @

H [4 A
_’Connect ﬁCopy Properties [DModules Estrategy Help F r. F D D r
ﬂDisc:mnect Lﬁpaste Na\ﬂgat\on Macros 0 = w rh é .

[[] Reopen Strategies

Site. Configuration Database Datalog Site Backup MB-Pro

{_iSelect Al List |[= Page Names |[&] search Interface Manager Organiser
Site Clipboard View Utilities
Site List 3 E |4 Strategy1 b X | Properties N |
=-§) Sites - A ? |Anzlog Input [1] =
B BACnetIP A = =
5.5 - Anzlog Input B =
B2 001 - Network Al . c c . . Type Analog Input
{1 001 - 001 - UCU32 Room Temperature yp g Inp
H Point € Service Order 1
L. 001 - 002 - CBM24 > . o o . .
a . ovemicz [ Name Room Tem...
Io BACnet Serial . co co . . synchroni Di R
B-2q Sample Apps BAChet ynchronis... Disconnect...
522 001 - Wet Systems =
@’ 1111 - CT Single P co co co co co co . . Pointty... Input Anal...
-, 1112 - CT Single P o o o o o o . . Low thresh-.. |0
-, 1113 - CT Single P L L L o L o . . High thres... 0
.=, 1114 - CT Dual Pu Lower sens... 1]
....@’ 1115 - CT Dual Pui Lo Lo Lo Lo Lo Lo . . Uppersens.. 0
@, 1116 - CT Dual Pui co co co co co co . . Input error  0.0000
....@, 1121 - VT Single P1 Exponential... 60
-, 1122 - VT Single P C C C o o o : : Sensortype  PT1000
=), 1123 - VT Single Py S ) ) Unit S
-, 1124 - VT Dual Pur o o o . . o . . Averaging 0
&, 1125 - VT Dual Pur o o o o o o . . =] j
-, 1126 - VT Dual Pur
....E’ 1131 - Four Boilers - - - - - Lo . . Lower sensor range
E’ 1132 - Four Boilers - - - - - - . . The settings specify the range of
=), 1133 - Two Boilers the input, after analog-to-digital
o v c =t 2. E
< = > < > Page Nam... Properties Modules
Setup block updated. Connected to: Sample Apps BACnet (3], | R .

Note: If you have multiple strategies open at once, ensure that you select the strategy into which you
would like to place the module before you select the module from the modules bar.

The module can now be selected, and edited, moved, copied, cut, or joined to other modules.
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Selecting modules on the drawing area

Before you can move, copy, cut, or delete a module, you must first select it. This can be done by:

c
@,
Clicking on the module symbol, a2
<
o
=
Analog Input 1 Analog Inipast 1 =
Al Room Temperature ’ Al Room Temperature <

I}, poim@m Point €3 T

Ohvemide [ m Ovemide [

Or by clicking and dragging from the top left to the bottom right of the module symbol(s) as shown. When you
release the mouse button, the module will be selected

D!T Analog Inpast ] Analog Inpast o) Analog Inpast 1
Al Room Temperature ) Al Room Temperature ) Al Room Temperature
Polm@m Point £ Fﬂ Point £ m
Ovemid= [[ Ovemid= [[ Ovemid= [[
R

To select more than one module on the drawing area:
You can select multiple modules at once by the following methods:
Press and hold down the [Ctrl] button while clicking the modules required.

if you want to select every item in the drawing simultaneously, click on Select All in the Strategy tab.

troller Strategy

£ Copy |:

= W
Stéd Al Mo
oller Clipboard

Click and drag a box around all the modules you want to select. When you release the mouse button, all
the modules within the box will have been selected.

~

) > Taneats Fomzig PO ¢

S oo S

} Tuneable Forad PID 2

IS Seore omn Oy

) > Tuneatk Forzie P 7|

I Seone e Oy

Tralog Tk
Al room remperarure

Selected modules (and points, which are represented by lines) are surrounded by coloured borders. Most modules
will have a red border, but one will be green. This is the module (or point/line) whose properties are currently
displayed in the Properties Pane —i.e. the module that is “in focus”.
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You can change which of the selected modules is “in focus” by using the navigation controls at the top of the
Properties pane, with the arrows:

4 Strategy1 b x| |Properties i |
o~ £ ﬁ ? Analog Setpoint [* »
m Analog Setpoint 1 : =
(7)) Raom sewpaint o Value 0.000000
ey S o
} Tuneable Forward PID 2 | E PointD.. Analog1Roo..
. MNu.. 1
(€3 Satpoint Output €3
Analog Input T|  pre— P Type ):\r:flog
Al Room Temperature 1 e : Value | 0.00
[ PoncCoped | Enzble ' Name Room Setpoint
[ o3 DR [y ' Unit  =C
N )
Integration time: $00; Dervative.. |

Or the drop-down, which lists the currently selected modules and points:

4 Strategy1 [ % | Properties R |
A ( » ? |Tuneable Forward «
m Anzlog Setpoint 1 ’
0 Room Setpoint
Point: 3 fre
' B Tunsshle Forward FID 2
R © Setpaint ot © Setpoint  Analog 1R..
Anzlog Input B 3 Py
Al Room Temperature A San Process... Analog (1) ..
| P Coped  [HEnane Gain Analog
[ ower3 " & Tnt=ortion Enable  Digital
© Derivative . Integrat... Analog
Integration time: 900; Derivative... et o—at P

Move, Delete, Cut or Copy a module or modules on the Strategy drawing area

In order to Move, Delete, Cut, or Copy a module or modules, you must first select the module(s) as described
above. Then:

Moving modules

To move the selected module(s) on the drawing area, drag any one of the selected modules. The modules and
their connected points (lines) will move together. Alternatively, you can also use the arrow keys on the PC’s
keyboard to move all of the selected modules at the same time.

Deleting modules

To delete the selected module(s) from the drawing area press the [Delete] button on the PC’s keyboard.

Copying modules on the drawing area

To copy the selected module(s) to the PC’s clipboard, so that they can be pasted to another part of the drawing
area or to a different Strategy, either

e  Press [Ctrl]+[c] on the PC’s keyboard, or
e C(Clickon Copy inthe Home tab:

Home Controller

innect @Copy
sconnect IEPaste

site Clipboard

A copy of the module(s) will be saved on the Clipboard until placed (pasted) elsewhere.
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Then, paste the module(s) to a specific point within the same strategy, or to another strategy, by first either

e  pressing [Ctrl]+[v] on the PC’s keyboard, or

e clicking on Paste inthe Home tab:

Haome Controller

c
@,
>
)
<
9
%
=
o
1%

nnect ﬁ Copy

sconnect EPast:R
]

L.|sele
site Clipboard

then click on the drawing area in the target Strategy with the mouse. The top left-hand corner of the module(s)
will be positioned on the point where the mouse was clicked.

Note: Pasted hardware point modules may adapt some parameters to the destination point but retain
others. For example, an analog input configured as PT1000 when pasted to a UniPut will change

to a voltage input but retain the max and min limits (in the Advanced button) which for PT1000
could be min 0 and max 0, leading to incorrect operation of the UniPut.

Tool Tip Data on Modules

To view details of a specific Module, hover the mouse pointer over the Block in the Strategy drawing.

‘Analog Output =

AO Heating Valve
; W§O Type: Cutput
.,.gT Analog/Digital Type: Analog
e 1B bit range: 0-255
| Type of Input Sensor: Volts
- |Lower actuator: 0
- |Higher actuator: 10000

- - - - - |Strategy lower: 0
— . . . . . |Strategy upper: 100
= . . |Cutputerrer: 0.00
. |5ensor Type: 0-10Kohms
. |Sequence on period: 0
| Unit °C

L]
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JOINING MODULES IN A STRATEGY

Modules in a strategy must be joined together to allow information to flow from input to output. The flow is from
left to right, so that controller input connection points are on the left of the drawing area, controller outputs are
on the right, and the modules are positioned between the inputs and outputs in the center of the drawing area.

Notes on joining modules
e Aconnection is possible only if both the input and the output are of the same type (analog or digital).

e An output of a module can be linked as often as required with inputs of other modules.

e Aninput of a module can be linked with only one output of a module.

Module connection points

Connection points are marked on module symbols as blue circles or squares on the left and right edges of the
module. When the mouse pointer is placed over a connection point, it changes to a cross-hair.

e  Circular connection points are analog.

e Square connection points are digital

If you want to connect two points, make sure they are both either digital or analog. You cannot connect analog to
digital or vice versa.

How to join modules

Place the mouse pointer over the required output of (A Analog Setpoint 1

the first module so that it changes to a crosshair. o "o Room Setpaint
[ Poizz

[43]

b Tuneable Fo
€} S=tpoint

Click and drag the mouse from the output to the ) Analog Setpaint 1
required input of the other module. You will see that o "o Room Setpaint

the crosshair changes back to a mouse pointer once | Point & L
you have left the blue connection pointand returnto  ———————— ! T } Tuneabls Fa
cross-hair format when you reach the next blue S e

Flintanratinm tim

connection point.

Release the mouse when you have reached the (A Anzleg S=ipoint T
required input. The two modules are now joined. The o2 Room Setpoint
connection between the two modules is marked by |
a coloured line. The default colour is black, but this
can be customized by clicking on the connection line
with the right mouse button.

Paint (3
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How connections are represented

By default, the connection between 2 modules is represented by a black line with the numbers of the points at
each end of the connection also displayed (as in the above example).

You can customize the way in which all connections are represented by right-clicking on the Drawing Area to open

the Display Options menu:

c
@,
>
)
<
9
a
=
o
1%

Display Options v

Point |
@

This gives access to the following options:

Hide All Lines N

L3

| Display Options v | DisplayLines v Show Al Lines |

T e

b Tunezble Forward PID +

 1|SEepem Otz ) (9j
o L L L @
o EED
GEED
€ Integration

F o S——

3l

=

Show All Lines N

L1l

’ || Displey Options v\ DisplayLines » | ShowAllLines I
=,

| DisplayLabels »‘ Hide X0 Lines |

b Tunezble Forward PID +

— T € Sewpoim Outpun 6|
go (L

& Gain

G

€ Integration

F o S——

2|
L=

=

Hide Labels

L1l

ol DisplayOptions  » DisplayLines ' |

Display Labels  » ide
I :EwNumhv b Tuneabl Forward PID *

E Show Name

j 1O Shaw Value Only simulation) €3 Satpaint Oupt €
g ki i L T T 5w -
- T T e
G
€ Integratior

F o S——

3]
L

=

Show Number I L

T‘ L EE
1 I Display Labels 3 Hide Tunezble Forward PID 1
Shoy Number P
o I\—‘ismwtﬁme d L S ot SOk
T — Show Value Only (simulation) — — T o
. & | P T e
ET Enatiz
|9 Integration

F N

L2l

Display Options | DisplayLines v ]

2l
e

5
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Show Name

Display Lines v ]
Display Labels  »|  Hide
Show Number

Sh%Name
—1| 3 3 — Shoth Value Only (simulation)
o7 T T

I
_|  Display Options »
|

Output ©

Show Value Only (Simulation) N
S 3= o S o
| Display Options v Display Lines v N S
— Display Labels v Hide I o } Tunesblz Forezrd FID 1
Show Number
Show Name T Outpt €
: Toom &= Shew Valuye Only (simulation) — :
:l T TS ey me

You can customize the line and label visibility of a single point (line) in the properties panel:

Properties L |

<>?| -

= Point Details Analog 1 Room 5.

Mumber 1
Type Analog
Value 0.00
MName Room Setpoint
Unit “C
=
Show Line True
Labels Show value onlyE

You can also change the default visibility using the New Connections option on the Strategy tab of the Ribbon :

Strategy
ECopy E 3R r|§|BACr|et Paints E @_ Create # # % #Ix Logging %Gnd E‘l New Cgnnections
?jPasle q= BACnet Units Manager ’ [ “E‘Conflguratlon ?}'Gnd Calour
| View Add [f{s] Reorder _ Strategy View Start/Pause Stop  Reset
__iSelect All | Modules Text Terminals Modules nﬁ' Strategy Details  Help Macros FIl"l Save New - l"/ Background Colour
Clipboard Strategy Macras Simulation Display
= =< Strateavt I % | IModules

This opens the New Connections dialog, where you can set the appearance of new module connections:
New Connections
v Display lines on newly created connections.

Configure how point information is display on newly
created connections.

IShow value anly [simulationLI

Show name

Cancel

Show value only {simulation]
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Connectors

Lines are a convenient and intuitive way to connect modules that are close together in the Strategy drawing.
However, clicking and dragging to connect modules that are far apart in the drawing can be impractical. To

overcome this, CXpro"® provides an alternative way to connect modules using named Connectors .

g Input
swTemp 'l
Poirit € frr~ < HWSHowTemp ] [ HWSHowTemp & — me_Te
Override [ o MImp
© LTmp
HWSHILImIt 7] Do il HiLS
igital Tnput 5] =
WSHiLimit = DB
Point 1 s 7<) HWSHiLimit BT
Override 1) ‘ 7 Analog Setpoint 0 5 L
0 m HWSTempDB 3 LSip
| Point £ ol B

A Connector creates an invisible channel of information between a single Source and multiple Destinations.

Add a Source Connector

To set up a Source Connector, right-click on any output on any module and select Add Source Connector .

Maximum 4
Nax

I Inp A Masimum G —
J Input B Show lines
Jmpuc |

3 Input D |
3 Input E Convert LirLE to Connectors
3 Input F
Jinpmc | Simulation Properties

3 Input H )

Add Source Connector

In the dialog that opens, enter a name for the point that will be exposed by the Source Connector you are creating.

Point Name

Point Name | MaxHWater

0K I Cancel |

The Source Connector is now created.

Maximum 4
lax
} Inpt A Masimum €
} Input B
b Inpatt C

Note: Points exposed by Source Connectors must be named.
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Adding a Destination Connector

To connect a module to a point exposed by a Source Connector you must create a Destination Connector as follows:

Right-click on any input of any module and select Add Destination Connector .

A-B Comparator L
QptA |  Owps[@my
A InoB | Comolement Eq i

Show lines

Add Destination Connector
Ccr[ﬁrt Lines to Connectors

Simulation Properties

A list of Source Connectors will be displayed.

Select Source Connector

MName I
[MaHWater ]

MaxHWater
Adder/Scaler Block 19 Cutput
‘WeatherCom Block 8001 Inpu

oK I:! Cancel |

Choose the appropriate Source Connector and click OK to complete the connection. The new destination

connector is added to the input of the module.

Deleting Connectors

The rules for deleting connectors are as follows:

Source: If a Source Connector is deleted, all Destination Connectors connected to the Source Connector will also be
deleted.

Destination: If a Destination Connector is deleted, it is the same as disconnecting an input from any output.
If the Destination Connector is the last one connected to the source, a dialog will be displayed asking the user if they

want to delete the source. If they decide to do so, then the Source Connector will also be deleted. If the user does

not delete the Source Connector , that point will be available for new Destination Connectors .
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Quick Searching for Connectors
e Jumping from a Destination Connector

Right-click on the Destination Connector and choose either Jump to Source or Jump To Other Destination .

[ Inpun A
MasHVizter () Srpemm——s () Inpi 8 | comp

Jump to Source
Jt Spto Other Destination

If you choose Jump to Source you will immediately be taken to that Connector .

c
@,
>
)
<
9
%
=
o
1%

If you choose Jump To Other Destination and there is only one available, you will immediately be taken to that Connector .

If you choose Jump To Other Destination and there is more than one available Destination, then the Search Results

window (below the Strategy Drawing window) will display them as a list so that you can select which one to view.

& npuza

[ & % Qe |G

Wasimum T

E Mezmm Sy <O ez
1mp DPS = 1 Sire G v
imp Trip < >
1mp Speed Search Results | x |
ap DPS
np Trip X Delete ™ Select All [Module ~| Type
ap Speed
o] N Numb:
1mp DPS 5| = | [E
i [ ]amaa
P Spee - [ Search results for "MaxHWater Destination Connectors” in strategy PL Office: {
p DPS.
Source Connector : MasHWater
p Trip

Destination Connector 1: MaxHWater
Destination Connector 2 : MaxHWater
Destination Connector 3 : MaxHWater

p Speed
OnOff
Modulating

e Jumping from a Source Connector
Right-click on the source connector and choose Jump to Destination .

w S
Jump to Destination I
Lo | P I

Ay

If there is only one Destination Connector , then that Connector will immediately be displayed. If there is more than
one, then the Search Results window (below the Strategy Drawing window) will display them as a list so that you

can select which one to view.

oS : Ma;a'naﬂ@“ - E;gumwmy I

Trip =

Speed 0 v
ps < >

P Search Results x|
pesd r Type

DPS X Delete [ Select All [Module | Tyee | ~|
Trip Name Number [ ] QUFind @ @

Speed
Ps

fip
oeed
S
lulating

[ [T Search results for "MaxHWater Destination Connectors” in strategy PL Office: 001 - Netwao
Source Connector : MaxHWater
Destination Connector 1: MaxHWater
.. Destination Connector 2 : MaxHWater
- Destination Connector 3 : MaxHWater

Convert Lines to Connectors

It is possible to quickly convert an existing Line to a set of Connectors (one Source and one Destination).

Right-click on a Line and choose Convert Line to Connector .

ET Leg trigger
Datalog number 1; Update

Convert Line to Connector

Simulation properties

If the point is not named, you will be given the option to name it.
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Viewing Point properties

The Properties panel in the CXpro"P Right-hand pane can be used to examine points and routing. To do this, select

a line (representing a connection between two modules, usually meaning a point). The properties of the point are

displayed in the Properties panel:

Properties R |
? B
=l Point Details Analog (9) Heati..,
MNurmber 9
Type Analog
Value 0.00
MName Heating Valve
Unit =C
=
Show Line True
Labels Show value only ..
Number

The point number that represents a
path of data in a strategy. There are a

Properties Page Mames Modules

Some attributes of a point (such as Name or Unit ) are editable and can be changed directly in the Properties panel.

Viewing BACnet properties

If the BACnet Properties option is enabled in the Home tab of the Ribbon,

Home Controller Strategy

nnect @Capy EI Proper‘ties Page Names @Sear(h
connect E Paste @ BAGnet Properties Modules EE Strategy Help
o Sity
{_iSelect All L:sf Mavigation Macros [] Reopen Strat

ite Clipboard View

then in the right-hand pane, alongside the Properties panel, there is a BACnet Properties panel:

- € Input £
3 ot F Y — —
> Properties BACnel':groperties

:

When a BACnet-exposed point (the line representing the point has hexagon indicators near each end) is selected

Al

Analog Input 51 [ A& HymEemm
Temperature o .g-
Point £ #T.”@ Tnput Aot
=g
o 0 [Om 2.00; OF: 4.00

B

and the controller is connected in CXpro*P

File ~ Home C

/G/C-Jrﬂ?ect @(
5‘ Disconnect Lﬁl
] 0

Site Cli
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then CXpro"® will interrogate the BACnet network in real-time, and live BACnet property values for the selected
point will be displayed in the BACnet Properties panel.

BACnet Properties O x |
[” Device properties
=
object-name (77}  Temperature
object-type (79) 1]
object-identifier (... Analog Input (0), ...
present-value (83)  1000.000000
status-flags (1...

-

c
@,
>
)
<
9
a
=
o
1%

event-state (36) normal

reliability (103) Mo Fault Detected
out-of-service (81)  False

units (117) 62

min-pres-value (.. 73.000000
max-pres-value (.. 120.000000
cov-increment (22)  0.100000

time-delay (113) 0 —
notification-class.. 0

high-limit (43) 0.000000

low-limit (39) 0.000000

deadband (25) 0.000000
limit-enable (...

event-enable ..,

acked-transiti... to-offnormal, to-..

notify-type (72) Alarm ;I

Properties BACnet Properties

Viewing Module BACnet Properties

The BACnet Properties panel can also be used to view and edit BACnet information related to certain modules as
well as points.

The following modules are supported:

e Binary input/output

e Analog input/output

e  Setpoints

e BACnet Schedules

e Unitron Schedules

e Broadcast transmit and receive
e Modbus Analog and Digital

e  Accumulator

e BACnet Trendlogs
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Viewing Device BACnet Properties

At the top of the BACnet Properties panel there is a Device Properties checkbox:

BACnet Properties

[~ Device properties
=

lhiccd s FTT

P S,

Checking this box changes the contents of the panel from the properties of the selected point or module, to the
BACnet properties of the device that contains that point or module:

BACnet Properties

[ Device properties

(=
ohject-name (77)
object-type (79)
object-identifier (...
present-value (85)
status-flags (1...
event-state (36)
reliability (103)
out-of-service (81)
units (117)
min-pres-value (..
max-pres-value (...
cov-increment (22)
time-delay (113}
notification-class...
high-limit (43)
low-lirit (39)
deadband (23]
limit-enable {...
event-enable ...

acked-transiti...
notify-type (72)

o a2

Temperature

0

Analeg Input (0, ...
1000.000000

normal

Mo Fault Detected
False

62

78.000000
120.000000
0.100000

0 —
0

0.000000

0.000000

0.000000

to-offnormal, to-...

Alarm ﬂ

Properties BACnet Properties

-Eﬁgn et Properties
I_@Device properties

ohbject-name (77)
object-type (79)
object-identifier (...
system-status (112)
vendor-name (121)
vendor-identifier ...
muodel-name (70)
firmware-version ...
application-softw...
location (38)
description (28]
protocol-version ...
protocol-revision...
protocol-servi..,
protocol-obje..
ohject-list (76)
max-apdu-length...
segmentation-su...
local-time (537)
local-date (36)
utc-offset (119

A x |
CBx CCBXBIS002F |
a
Device (8), Instan...
Operational

Cylon Controls, L.
1m
CBx
CBx 7.9.0f 18-08-2...

Plant Controller

Location not set-.. —
Plant Controller

1

14
acknowledgeAlar...
analog-input, an...
DES13002 A12A13..
430

Segmented Both
12:29:59
26/04/2019

’ =

Properties BACnet Properties

74

© Cylon Controls Ltd.

MANO133 rev 15



HOW TO ADD TEXT TO A STRATEGY

You can add text comments to a Strategy drawing by selecting Add Text from the Strategy tab onthe Ribbon :

Strategy
o [BO] B
EjPaﬂe
View | Ad I/c
..iselectAll | Modules Text Termir
Clipboard

Click the drawing area at the point where you want the text to be displayed.

|4 Strategy1
L

Analog Input 1
: |AI Room Temperature

The Add Text dialog box will be displayed:

Add Text ———

> mmzy

ialog Setpoint
‘om Setpoint

Font | caneel |

[ TAl Room remperature

c
@,
>
)
<
9
a
=
o
1%

To select the type of font in which the text should be displayed, click Font . The standard Windows Font dialog
box will be displayed in which you can choose a font, style, point size, etc. Once you have chosen the required font,

click the OK button.

Font
Fant: Font style
[ial] [Regular

\Arial Unicode MS

BankGOTHIC LT B

BankEOTHIC MD
[Baskerville Old Face « |Bold italic v

- Effect: Sample
I Stoksout
I Undedine AaBhyzz
Colour:

I Eiack - Script:
Westem =

Note: It is recommended that you always use "True-type" fonts. When the printing is scaled, non true-
type fonts do not scale properly.
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Inthe Add Text dialog box, type the text that you would like to include in the strategy

hop

-

s Add Text S

B1 DS floor temp sensors|
walog Setpoint
om Setpoint
Paim
Fant | oK Cancel |
I ’ |AI Room Temperature |
And click OK .

The text will then be displayed on the drawing area on the point at which you clicked the mouse.

3 |4 Strategy1
L]

BiDSfoor temp sensors,

(}l Anzlog Setpoint
4 10 Room Setpoint
| Point

Analog Input 1
AI Room Temperature

How to change text that has been added to the strategy drawing

To change text, select the text, and edit its content or font directly in the Properties pane.

1.532 I ¥ | Properties O x |
o A€ > ? -
iOutput =1ifInput = 18 deaC ; I J
{Output = 0 if Input = 23 degC | - R =
S Text Output = 1if Input < 18 degC...
Font Arial(g)
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VIRTUAL MODULES

Virtual modules are so-called because they do not result in point values being downloaded to the Cylon controllers, B
i.e. they do not represent real points. The basic function of a virtual module is to allow for greater flexibility in &}
connecting modules, e.g. backward connection of modules. Virtual modules are also used when creating macros, §
as they allow one external point of a macro to be connected, via a virtual, to many internal macro points. There B
are two virtual modules on a floating toolbar — one analog and one digital. &
Analog Virtual Module: |@'| |@'|

Digital Virtual Module: El |E—|

Placing Virtual modules on the drawing area

The procedure for placing virtual modules on the drawing area is similar to that for any other module.

Select the required module from the Virtuals group ~ Meduls L

in the Moules panel: oo ,
Constants »
Controls »
| Functions R
Math »
Schedules, Timers, and Logic »
.Setpumts, Inputs, and Outputs »
| statistics »
VAV »

Virtuals
V Analog Virtual L\)

V Digital Virtual

Properties Page Names Modules

And click in the drawing area (note the cursor ~ =~ =~ =~ | — 1 E
changes to the “Module Cursor” during this - =y
process) ture EL
Point | &
wemde@| 0 p— (S
- FE 5
=X
E . .
Point )
ven'ldeﬁml
The top left-hand corner of the module’s symbol =~~~ i ' — 1 E
will be placed on the point where the mouse was ; -
clicked. ture oI
Z | X
i ] I (1 o] =k
€31
&1
=
Point € frm
ven'ldeﬁml
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Rules for connecting to virtual modules

1. Ifthe point being connected to the virtual module has a point number, then this becomes the number of
all the inputs and outputs of the virtual module. Any modules that are then connected will have the same
point number.

2. If the point being connected to the virtual module does not have a point number, CXpro"® chooses a new

number and this becomes the number of all the inputs and outputs of the virtual module.

e Rules1and 2 describe how the inputs and outputs of the virtual module are numbered once a connection
has been made. This is why CXpro"® will not allow you, once the first connection has been made, to
connect another module that has a number. You can, however, connect a module if its point number box
is blank.

Numbering virtual modules

Since virtual modules are not downloaded, they do not use any memory in the controller and do not need to be
numbered in the Block Manager like other modules.

Virtual modules have their own numbering system. The first virtual module used in a strategy is numbered V1, the
second V2, etc.

Virtual modules in macros

Virtual modules are useful when creating macros as they allow one input to be used several times.

For example, to create a macro from the strategy shown, it would be necessary to include two inputs in the macro.

.......

DI Trigger

gb Boolezn 3
[ Inpat A Output [
Input B Complement

P p!

[ tnput €

(3 Inpat D

gk> Boolean 4

[ tnput A Output [T
3 Input B Complement [
[ Inpt €

[ Input D

...... _— .
.................... - EE = o O
............... B
[ Input B Gomplement [
............... o S
£ Input D
SITeE - o
Dl Trgger | - o
[ o Em—miE] B L—
\ Overide @

............... _— .
.............. TEE = o O
................... ¢

[ Input B Gomplement 3]
[ npur €
[ tnput D
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WHAT ARE POINTS?

A Point is an area in a Controller where data is collected and stored. The data stored by the point is referred to as

the Point’s “value”. Controllers in the Cylon system include input, output, set, and virtual Points.

Note: Cylon’s Controllers are sometimes referred to as “universal controllers”, where “universa
that they can contain both analog and digital Points.

WHAT ARE BLOCKS?

I” means

An important aspect of CXpro"® is the concept of blocks.

Blocks can be seen as units of measurement for the number of modules and points used in a Strategy — one block
corresponds to one module, one hardware input Point, one hardware output Point, or one virtual point.

The Managers dialog, accessible from the View menu, allows you to see at a glance which of the blocks in the

controller are occupied and which are not.

When Points or Strategies are downloaded to a Controller, the Controller must also be informed of how many blocks
are needed to store the required information.

BLOCK NUMBERS

If you are using Automatic Download (see page 85), CXpro*® automatically recognizes how many blocks are
required and it sends this information to the Controller.

If you are not using Automatic Download you must, when downloading Points and Strategies, send specific
“Setup” information to the Controller, instructing it as to how many blocks it must serve in the Strategy. This
procedure is called Sending Setup (see page 172).

An important aspect of CXpro"® is the concept of blocks.

Blocks can be seen as units of measurement for the number of both modules and points used in a strategy.

e Inthe CBM, CBV, and CBT controllers, the Hardware Point numbers are from 1 to 1024, and Strategy blocks go
from 1 to 1024. Note however that only Hardware Points 1-24 are used on the CBM24, only Hardware points 1-
16 are used on the CBM16, etc.

Block Allocation

in CBM, CBV and CBT controllers

In these controllers, there are a total of 1024
Strategy blocks.

Hardware points in these controllers do not use
strategy blocks, so that all 1024 blocks are available
for strategy modules.

Point Numbering

in CBM, CBV and CBT controllers

In these controllers,

There are a total of 24 hardware points (inputs or
outputs), numbered 1 - 24.

There are a total of 1024 digital virtual points,
numbered 1 - 1024.

There are a total of 1024 digital virtual points,
numbered 1 - 1024.

controller memory
(CBM, CBV and CBT controllers)

Hardware
Analog
or
Digital
Points
(inputs or
outputs)

Virtual Virtual Strategy Blocks

1024
1023
1022
1021

26
25
24
23
22

000 00000 6006
000 00000 - 6600
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POINT NUMBERS

In CXpro"P, the connections between modules are referred to as ‘Points’. These Strategy Points can represent physical
inputs and outputs on a Controller, or Analog/Binary values (referred to in CXpro"® as ‘Virtual Points’).
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Each Analog Input, Analog Output, Binary Input, Binary Output, Analog Value, and Binary Value is assigned a number, and
how these points are numbered depends on the controller type.

In CBM, CBV, and CBT controllers, controller terminals (i.e. inputs and outputs) - “hardware points” in CXpro"® - are
assigned numbers between 1 and 24. Each terminal can be either an input or an output so that there cannot be
two hardware points with the same number. For example, if there is an Analog Input 3 there cannot be an Analog
Output 3 or Binary Input 3 at the same time.

Note: In theory, hardware Point numbers could be up to 1024, but is limited by the Controller hardware
so that the current maximum is 24.

Analog Values (“Analog virtual points”) can be numbered 1-1024, and Binary Values (“Digital virtual points”) can be
numbered 1 — 1024, so that there could be for example both AnalogValue 3 and Binary Value 3.

Note: The combined number of Analog Values and Binary Values that can be exposed on a BACnet network
by a single CBM or CBT is 225. As a result, it is recommended to keep the total number of defined
setpoints in a Strategy below this value.

However, it is possible to have up to 100 additional setpoints that are not exposed on BACnet.
Such setpoints in effect act as constants, because they cannot be changed by the Strategy nor via
BACnet, but can be set using CXpro*'®.

In Strategy drawings generated by CXpro"® for CBM, CBV, and CBT controllers, it is possible to identify a Strategy
Point’s nature as follows:

e Ifthe number has brackets around it is a “hardware point” — Analog Input, Analog Output, Binary Input, or Binary
Output.

e If the number is not bracketed but is connected to a circular connection point, it is an Analog Value (“analog
virtual point”).

e If the number is not bracketed but is connected to a square connection point, it is a Binary Value (“digital virtual
point”).

e If the line representing the point has a hexagon near each end, then that point is exposed on the BACnet
network.
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Avsrage & Analog Output 10

‘Analog Input g
AI Area Setpoint g Ao Valve
Paint € ie3] ey 2 Input A Average T 2 Point | Overndz [
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DEFINING HARDWARE POINTS

Hardware points are the inputs and outputs of Field Controllers.

To define a hardware pointit is necessary to define the following features:

Point number
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Point name

Point type (input, output, digital, analog)
Unit of measurement

Damping (for analog inputs only)

Once the required hardware points have been defined in CXpro"®, they are then downloaded to the Field Controller
for which they are intended.

How to define hardware points

The procedure for defining hardware points is as follows:

Specify (Target) the controller for which the hardware point is being defined
Choose the module from the modules bar

Place the module on the drawing area

Complete the module dialog box

Save the hardware point definition

Log in to the Field Controller

Download the hardware point definition to the Field Controller

Defining Hardware points — Target the controller

in the Site List select the BACnet Router and Field Controller that you want to target. This specifies the Field Controller

on which the hardware point is being defined and the location in the database on the PC's hard disk in which the
point definition will be stored.

MANO133 rev 15
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Defining Hardware points - Place the module on the drawing area

Once you have selected a module from the modules bar , place it on the drawing area by simply clicking the drawing

area. A dialog box will appear prompting you to enter a name for the hardware point.

Enter a name and click OK to close the dialog box.

The top left-hand corner of the module’s symbol, i.e. the graphical symbol for the analog input point, will be placed
on the point on the drawing area where the mouse was clicked.

e Expandable I/O — Hardware Points on CBX + FLX devices

In the Strategy drawing, 10 blocks can be added up to the total on the configured FLX modules plus the CBX onboard

10.

Note: If a FLX module is deleted from a CBX configuration (in Controller Properties) after the Strategy
drawing has been set up, the blocks associated with that FLX’s 10 will be ‘greyed out’ to indicate
that they are inactive.

T Ankglnpr 3| Hysaresi Digha] Output =
Tempe iy i ! DO Hysteresis Block 15
emperature . ] e T Active High ) - DO
e .- ‘
£ " .o L
Overide | B T [ 5]
Oni 2,00; OFf: 4,00
.................... o P o B
Al Absohne Value 3 [ Hysteress Bock 15 Actve High -
= = N YT I mpﬂ@ﬂ.ﬂ). A
[ Tnput A Ompt @y Mastitizter € Souli——ty]D Iopt B [ Complement @ S
.......... —_— L L L
Max
.......... SEEE — L
.......... S oeE L
_—— - —1 |
Al Heating Water ©@eec ||
emp ©besd | |
|63 Input E Eﬂ BACnet Schedule
Oves S o F @ ScheduleNo. 1
..... . [Breas A S [ SEED o Ol
Tnput H Complement
P ples
""""" —— VAV Flow Calaulaton o
Al [ Ty ks
............... — A T
€9 Diff pres Flow 6|
63 Flow/k K-Factor £
............... o A  Saturday: 09i0
............... = yt 03:00 - 17:00
I

Note: Unlike CBM UniPuts, if UniPuts on CBX/CBXi devices are configured as Analog Inputs, they have all of
the parameters that are available in Universal inputs. Also, the “ Operation Mode ” parameters, which
a apply only to certain CBM UniPuts, are not used by CBX/CBXi.

Defining Hardware points - Save the hardware point definition

Save the edited strategy by choosing Save or Save As... from the File menu. The Save As dialog box appears:

= Save As
4« BACNETIP » strat5 » 001 v @& | Searchooi o
Organise *  Newfolder B~ @
BACNETIP A Name ‘
Archive
DBASE No items match your search.
DRAWINGS
Keypad
Macros
strats
001
Strategy v < >
File name v
Save as type: | V6 Strateqy (*.532) v
= Hide Folders Cancel
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Enter a name under which the strategy should be saved. CXpro"® enters a default file name that identifies the
BACnet Router and Field Controller for which the Strategy has been designed, e.g. if Field Controller #3 on BACnet
Router #1 was connected to a VAV, its strategy might be named: "001_03VAV.s32".

When the Save As dialog box is complete, click OK . The name of the strategy will appear in the Drawing tab:

4 001_03VAV.532
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Connect to the controller

Connect to the controller by clicking the Connect button on the Strategy tab of the Ribbon

File - Home Controller Strategy
"Conrlﬂ\%ct * @Copy [
’a, Disconnect u LEPaste

Download | .,

W
Tiselect All | g
Site Controller Clipboard

Download the hardware point definition.

You can download a strategy to a controller in just one step, by choosing Download from the Controller tab of the

Ribbon .

B N LL S

ne Cantraller Strategy
"&Communications li'l Downlgad

ct % Controller )’D Wipe C%\

#, BAcnet & Auto Online

Configuration

trolle

CXpro*"® will automatically wipe the Field Controller’'s memory, download the hardware point, and send the set-up
to the UG, i.e. the number of blocks it is to serve. While it is doing this, it will display the Downloading window. As
the point is being downloaded, the Downloading window displays the progress and in the System status section, it
shows which of the 3 stages (wiping memory, downloading strategy, or sending set-up) CXpro"® is currently
completing. If only one hardware point is being downloaded, the process will take place so quickly that the
downloading window will appear only for a brief moment.

It is more usual to download an entire

Downloading #
strategy, with several hardware points and
other modules. In that case, the SRl
Downloading window will remain visible for Hardware Points || NNMMM | =
longer and the progress of the download strategy Biocks NN [z

will be measured in the progress bars. Analog Setpoint Values

l—
Digital Setpoint Values
l—

BACnet Point Config

Sending strategy to controller
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Summary of procedure for defining hardware points

Point numbers for inputs and outputs

In practice, the procedure for defining hardware points is as follows:

e Define all hardware points whose values are already known, in the module dialog boxes and place the

corresponding modules somewhere on the drawing area.

e Save the strategy.

e  (lick Communications Setup from the Communications menu and enable Automatic Download.

e login

e Choose Download from the Communications menu.

1/0 Module Terminal Number  Type
CBX-8R8 1..8 Universal Input
9..16 UniPut™
FLX-8R8 adress 1 101 ...108 Universal Input
109 ... 116 UniPut™
FLX-8R8 adress 2 201 ...208 Universal Input
209 ... 216 UniPut™
FLX-8R8 adress 3 301 ...308 Universal Input
309 ... 316 UniPut™

When another input module is selected, CXpro"® automatically assigns it to it the next unused input, i.e. the unused
input with the smallest point number.

Defining digital and analog outputs follows the same principle. As outputs are numbered in the range 9 to 16,
CXpro"® assigns point number 9 to the first output.

For CBX and CBXi devices, point numbers are defined by the I/0 module in which they reside —internal I/O on the
CBX/CBXi device are I/O module “0”, any attached FLX devices are I/O modules 1,2 or 3
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A short cut to defining hardware points

To save time when defining the hardware points you can bring the definitions directly to the database by using the
Database Interface.

The types (“A” for analog, “D” for digital), point names, and point numbers and units can be written as comma-
separated or tab-separated lists in a word processing application, copied and pasted via the clipboard to the
Database Interface. This avoids unnecessary writing work and typing errors. Using external applications for text
handling also saves time because of their Copy, Search, Replace, and Pasting features.
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The point list shown below was created in Microsoft Windows Notepad. Other software applications, such as Excel
and Word may also be used.

A Room Temperature 1 °C

A Room Temperature 2 °C

A Outair Temperature South-East °C

A Outair Temperature North-West °C

A Supply Water Temperature 1 °C 5

A Supply Water Temperature 2 °C 6

A Valve 1 % 9
A Valve 2 % 10
D Pump 1 ON/ OFF 11

D Pump 2 ON/ OFF 12

When preparing a hardware point definition list you must separate the values (type, point name, unit, point
number, etc.) by using tabs or commas, not spaces.

Note: This shortcut for defining hardware point values should only be used for UCs that do not already
have hardware point definitions in the database on the PC’s hard disk, since existing database
entries are not deleted. The Database Interface does not check for uniqueness. This means that
there is a danger of defining more than one entry per point, which will cause a lot of confusion in
the later use of the point in other programs.
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WHAT ARE UNIPUTS™?

A UniPut™ can act as an input or an output so that you can now have a controller that fits your BMS design exactly
- no need to use an extra controller to gain an extra output while leaving an input on the original controller unused.
BMS sites can make more efficient use of a smaller number of controllers, saving on cost and complexity.

A UniPut™ can be configured as any one of the following:

or

an Active Input, reading between @ ... 10 V at 40 KQ, with 9-bit resolution.
an Active Output, outputting 0 ... 18 V at a maximum load of 26 mA
a Digital Volt-Free contact.

a digital input detecting the presence or absence of 24Vac

a relay switched output.

The Cylon range of controllers has several different combinations of UniPuts™ and standard Universal Inputs.

UniPuts™ are used in controller strategies through standard Analog and Digital Input and Output modules. However,
before it is possible to add a module for a UniPut™ to the strategy, the UniPut™ must be configured using CXpro*®'s
I/O Terminals dialog box.

88
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CONFIGURING THE FIELD CONTROLLER’S INPUTS AND OUTPUTS

Cylon controllers have a mixture of Universal Inputs and UniPuts™. The Universal Inputs are fixed as inputs, but UniPuts™
may be configured as analog or digital inputs or outputs using the I/O Terminals panel.
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How to open the " 1/0 Terminals " Strategy Details tab.

The I/O Terminals tab on the Strategy Details dialog can be opened by clicking the I/O Terminals button in the
Strategy tab of the Ribbon :

roller Strategy

£ copy E T WgBacnetr
[F) Paste & BacnetL
wad | .., View | Add 170y Reorder
Loiselect All | [podules| Text Termi Modules T Strategy
ler Clipboard Strategy
T
Strategy Details X
Display Address Type Input/Output | Name ~
- Cori
New Line om Universal Input -Slifejelrz
002 Analog Input Heating Water Temp
003 Analog Input Temperature FEee
strategy Blacks 004 Universal Input
Controller Limits 005 Universal Input
006 Universal Input Peset &l
Resources o007 Universal Input
008 Universal Input
Points Manager 00s Digital Qutput Hysteresis Block 15 A...
010 UniPut UniPut
Reorder Modules o UniPut UniPut
012 UniPut UniPut
BACnet units 013 UniPut UniPut
——— 014 UniPut UniPut
1/ Terminals 015 UniPut UniPut
01e UniPut UniPut
10 Universal Input
102 Universal Input
103 Universal Input
104 Universal Input
105 Universal Input
106 Universal Input
107 Universal Input
108 Universal Input
109 LUniPut UniPut
110 UniPut UniPut
m LUniPut UniPut
112 UniPut UniPut v
Ok I Cancel Apply

How to configure a UniPut™
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To configure a particular UniPut™ (U10), double-

click on its terminal number in the

Terminals tab.

The Configure IO Types box opens

Note: Terminals marked Universal
are not UniPuts™, so the
Configure 10 Types dialog for
these terminals does not allow
the terminal to be changed
from Input to Output

1I/0

Strategy Details

X

BACnet units

1/O Terminals

012 | Configure 0 Types

014 Point Type
gl: = Analog
101 © Digital
102

Paint Direction ——

X

& Input
© Qutput

Display Address [ Tpe [ input/Output | Name [~
Mew Line 001 Universal Input Configure
002 Anzlog Input Heating Water Temp
003 Anlog Input Temperature
Strategy Blocks ot ol P Figset
005 Uriversal Input
Controller Limits 008 i Pl Feset Al
Resources 07 Uriversal Input
008 Uriversal Input
Points Manager 009 Digital Qutput Hysteresis Block 15A...
010 UriPut UriPut
Reorder Modules 011 UniPut UniPut
012 UniPut UniPut
BACnet units 013 UniPut UniPut
—_— |01 UriPut UniPut
1/0 Terminals 05 UniPut UniPut
016 UriPut UniPut
101 Uriversal Input
102 Uriversal Input
103 Uriversal Input
104 Uriversal Input
105 Uriversal Input
106 Uriversal Input
107 Uriversal Input
108 Uriversal Input
109 UniPut UniPut
110 UriPut UniPut
111 UniPut UniPut
112 UriPut UniPut ©
OK | Cancsl Apply
Strategy Details X
Display Address [ Type [ Input/Output [ Name [~
Mew Line 001 Uriversal Input Cortigure
002 Analog Input Heating Water Temp
003 Anzlog Input Temperature
strateqy Blocks 01 i i FReset
005 Uriversal Input
Controller Limits fod e i Resetal
Resources 07 Uriversal Input
008 Uriversal Input
Points Manager 009 Digtal Output Hysteresis Block 15 A..
o010 UniPut UniPut
Reorder Modules o

103
104
10 [ |
108 —
107 Uriversal Input
108 Uriversal Input
103 UriPut UriPut
110 UniPut UniPut
111 UriPut UriPut
12 UniPut UniPut v
oK Cancel Apply
Configure 10 Types “
Point Type Paoint Direction
" Analog @ Input
" Digital T Output

Set whether the UniPut™ is to deal with Analog or | cenfigurelo Types X
Digital signals (the following illustrations show the — Point Direction
UniPut™ being set as an analog output), & Analog & Input

" “Bigital " output

=]

Cancel
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and whether it is to be an input or an output Configure 10 Types *
Paoint Type Point Direction
* Analog © Input
" Digital IL\’Output

oK l Cancel
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Click on OK to close the Configure IO Type box, Cenfigure 10 Types X
Point Type Point Direction
o« Analog o Input
" Digital & Qutput
0K i i Cancel
a Point Name dialog opens: Point Name
Enter a name for the point and click OK . Point Name | HW_valve
Ok Cancel
. . . . Strategy Details x
and the I/O Terminals panel will display the UniPut™'s =2
Display Address [ Type [linput/Output [ Wame T~ .
configuration (in the illustration, terminal 012 has | newu o el esting Wi Tem [eis
Strategy Blocks ou3 Analog Input Tempersture Reset
004 Universal Ing
become an Analog Output) R i i _—
Resources 007 Universal Input
008 Uriversal Input
Points Manager 009 Digtal Output Hysteresis Block 15 A,
| 010 UniPut UniPut
Reorder Modules o1 UniPut UniPut
012 Analog Output HW_valve
BACnet units 013 UniPut UniPut
— 014 UniPut UniPut
/O Terminals 015 UniPut UniPut
016 UniPut UniPut
101 Uriversal Input
102 Universal Input
103 Uriversal Input
104 Uriversal Input
105 Universal Input
106 Uriversal Input
107 Universal Input
108 Uriversal Input
109 UniPut UniPut
10 UniPut UniPut
m UniPut UniPut
ﬂz UHIEUI _Umfu\ v

oK Cancel Apply

Repeat this process until all required UniPuts™ have been configured.

Note: When the 1/O Terminals dialog is closed, point modules will be added to the strategy drawing for
any newly-configured terminals which were not already in the strategy.
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Changing the configuration of a UniPut™

If you want to change the configuration of an existing UniPut™, you must 'delete' its configuration from the I/O

Terminals panel.

Note: The Delete button on the I/O Terminals panel will not work if there is a module in the strategy for
that point. If you click on Delete when a point is selected for which there is a module in the
strategy, a message will appear to alert you of this fact.

CXproHD

. Point 12 is used in the strategy.
-_Jé You must remove it frem the strategy if you want to change its
cenfiguration,

In order to proceed in this case, you must delete the module representing that point from the
Strategy drawing area by selecting it and pressing the [Delete] button on the PC’s keyboard.

Open the I/O Terminals panel, by clicking on the 1/O Terminals button in the Strategy tab of the Ribbon :

roller Strategy
£ copy E T TgBacnetr
[ Paste & Bacnet L
ad | o, View | Add [fle] Reorder
L.iselect All | Imodules| Text Termi Modules & Strategy
ler Clipboard Strategy
r
. IO Terminals
Select the terminal number
Terminal Number Type | Input/Qutput | ~ Defaults
001 Analog Input
002 Analag Input Configure
003 Digital Input
004 Analog Input
005 Digital Input
006 Digital Input
007 Universal Input
008 Universal Input
009 Analog Output
010 Analog Output
o1 Digital Output
012 Analog QOutput
013 UniPut UniPut
04 UniPut UniPut
015 UniPut UniPut v Delete
o1& UniPut UniPut

W Hide 1/0 Terminals when finished. Cancel

. I/O Terminals
and click on Delete

Terminal Number Type | Input/Output | ~ Defaults
oM Analog Input

002 Analag Input Configure
003 Digital Input

004 Analag Input

005 Digital Input

006 Digital Input

007 Universal Input

008 Universal Input

009 Analog Output

010 Analag Qutput

011 Digital Output

012 Analog Qutput

03 UniPut UniPut

014 UniPut UniPut

015 Un!Put Un!Put - Delete
016 UniPut UniPut AH

¥ Hide 1O Terminals when finished. Cancel
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o
. I/O Terminals =)
The selected terminal has now been returned 8 El
(%]
to the blank ‘Uniput' Conf|gurat|on Terminal Mumber Type | Input/Qutput | ~ Defaults Q
001 Analog Input g_
002 Anal Input Confi
003 D?gaitl;? |2§Et == o
004 Analog Input o,
005 Digital Input 2
006 Digital Input
007 Universal Input °<,
008 Universal Input E
009 Analog Cutput o
010 Analog Cutput w
011 Diqita\ Cutput
The terminal can now be re-configured as o Unipes Uit
detailed in How to configure a on page 89 o bt Ut
. 015 UniPut UniPut -
016 u::PEt U::Pﬁt > m
¥ Hide /O Terminals when finished, OK Caneel
Example: Configuring Analog Input module properties
01_01.532 [- > | Properties A |

e General Information

Type

(not editable) shows that this is an Analog input.

Service Order

~ ? |Ana|og|nput[‘|] j
=]
Type Analog Input
Service Order 1
MName Outside Air Temperature
Synchronised Status Checking...
=]
T — = Point type Input Analog
Al ousige A Low threshold 78
Point £ High threshold 120
Ovarmids (7 m_l' Lower sensor range -50
Upper sensor range 150
Input error 0.0000
Exponential filter 20
Sensor type PT1000
Al H-}.a“tai\r?‘g [”a-ga_ Unit *C
Temp L Averaging 0
Po'lnt@lm—_ o
o . Point Analog (1): 0.00 Outside Air T...
Manual override Digital
v
> Properties Page Mames Modules

(not editable) indicates the order in which this block will be processed by the controller.

Name

Shows the text identifier for the point, which must be no more than 24 alphanumeric characters. Spaces, commas,
full stops may also be used. Each point in a Field Controller must have a point name that is unique within that

controller.

Synchronised Status

Shows whether the Strategy Drawing matches the Strategy in the connected Controller.
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e Constants
Low Input Threshold / High Input Threshold / Low Strategy Value / Hight Strategy Value
The threshold settings specify the on/off turnover point on a digital input or output.
Input Error

A constant with the same unit as the input value, which is added to the input value to compensate for errors in
input arising from factors such as resistance of long cables or positioning of sensors. Temperature values (sensor
type PT1000) are corrected in mV. To compensate for 1 °C, the input error is 2.5 mV. For example, a decrease in
temperature of 2 °C requires an input error of -5.0 mV to be entered. This feature is only available for analog
passive inputs.

Exp. Filter Constant

An individual time constant for the analog input., behaving as a damping filter. The measured input value will be
averaged over the time specified in seconds by the Exponential Filter constant, so that short-term variations of the

measured value can be filtered out if the Exponential Filter value is longer than the sensor response time.
Sensor Type
Select the required filter from the Sensor Type list. Some of the available options are:

e Pt1000: This configures the analog input for reading temperatures from a standard Pt1000 sensor. The
Controller will convert the measured resistance (voltage) to a temperature signal.

e 0-10 V: This converts the hardware voltage signal 0..10 V DC to a software value in the range 0..100 %.
For example, the voltage signal 6.7 V DC will be convertedto 67.0 %.

e 0-20 mA:This converts the hardware current signal 0..20 mA to a software value in the range 0..100 %. For
example, a current of 15.0 mA gives the software a value of 75.0 %.

e Pulse(V/F): This is designed for reading voltage-free contacts, which can be operated at a frequency of
up to 12 Hz. The value of the input will be incremented by 1 after each detected pulse. Evaluation and
resetting of the counter will be done by using the Meter Module (module 63).

Additional sensor types can be allowed for by defining extra units of measurement - see Appendix :: Adding units
of measurement to the system on page 213.

Unit

The Unit list box contains a collection of text strings, one of which will be displayed together with the point value.

Choose from the list the type of unit that corresponds to the type of input, e.g. if an analog input point represents
a temperature reading in degrees Celsius, you may choose DegC from the Units list box. If necessary, additional
units may be defined in the C:\CXproHD\ (SITENAME)\SYSTEM\site.ini file. Appendix :: Adding units of
measurement to the system on page 213 contains details of how this is done.

e Outputs
Point

The output of the Analog Point module assumes the type, name, and units of the point module. A point number is
automatically assigned (though this can be edited by selecting the connecting line, which represents the point
itself)

Note: Point numbers 1...8 represent controller inputs 1...8.

Point numbers 9...16 represent controller outputs 1...8.

94

© Cylon Controls Ltd. MANO133 rev 15



Viewing used blocks

To check which blocks have been used in a Strategy, select Strategy Details from the Strategy tab of the Ribbon :

R T T [

Strategy

Hcopy T E - figeacnet points Ezl

FqPaste 8 BACnet Units
..... View Add e Rearder tegy

. | Stra
_iselect All | modules| Text Terminals Modules nﬁstrate%Detalls Help
Clipboard Strategy

n 'l | A And nd -3

This opens the Strategy Details dialog:

Strategy Details

Strategy Blocks | Controller | Resources | Peints Manager |

001 Comparator ~
002 BACnet Scheduls

003 Absolute Value

004 Masimum

005 Analog Gate

006 Limitto Dor 100

007 Rounding

008 Intsger Constant

003 Real Constant

010 VAV Dfferential Pressurs
011 Not Used

012 Not Used

013 Not Used

014 Not Used

015 Not Used

016 Not Used

017 Not Used

018 Not Used

019 Not Used

020 Not Used

021 Not Used

022 ot Used

023 Not Used o

Viewing the list of blocks
Click on the Strategy Blocks tab to see which of the available blocks have been used in the active strategy and which
have not.

Strategy Details

Strategy Blocks | Controller | Resources | Points Manager |

007 Comparstor ~
002 EACnet Scheddle

003 Absolute Value

004 Maxmum

005 Analog Gate

006 Limitto Dor 100

007 Rounding

002 Integer Constant

009 Real Constart

010 VAV Dfferential Fressure
017 Not Used

012 Net Used

013 Not Used

014 Not Lsed

015 Not Used

016 Not Lsed

017 Not Used

018 Net Used

019 Hot Used

020 Net Lsed

021 Not Used

022 Not Used

023 Mot Used v

In the above example, the Strategy Blocks tab indicates that the first block (block no. @01) is being used as a

Comparator module.
Block 802 is an BACnet Schedule module, block 003 is an Absolute Value module etc.
Blocks 011 to 023 have not been used in the strategy.

To view the remaining blocks (in the above example, blocks 824 ... 1024), use the horizontal scroll bar to move
down the Strategy Blocks tab.
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Viewing the blocks associated with each point

The Points Manager tab allows you to examine points in a strategy, listing the strategy blocks to which each point is

connected.
Strategy Details “
Strategy Blocks I Cortroller | Resources  Points Manager
Hardware Analog Points
1
Hardware Digital Points
Analog Points
Digital Points

In this example, Analog Point number 2 is connected to strategy blocks numbered 3 and 4.

96 © Cylon Controls Ltd.
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KEEPING CXpro"® AND CONTROLLER STRATEGIES IN SYNC

Strategy Compare

When connected to a site, it is possible to compare the strategy in CXpro"® with that in the Controller.
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To compare CXpro"? and Controller strategies,

Connect to the Controller by clicking on the Connect button in the Home tab of the Ribbon :

a :

File - Home Controller Strategy
’ CoEect m Copy Properties I Modules | Strategy
b" Disconnect LﬁPaste e Navigatiun ||E| Macros |:| Reopen
Ui select ANl List E Page Mames @ Search

Site Clipboard View
Site List 1R |« Strategy1

E‘"@ Sites
3o BACnet P
DB oo -Netwerk |
= 0o1-001-ucuszv il .

Right-click on the Field Controller in the Site List and select Strategy operations > Compare Strategy To Controller ,

@-Eg PL Office
-0 001 - Network

: i @,!W
i o = S —
- Anakeg Inp
Bl iz S@ampleApps[ Y Jnalog I
=== 001 - Wet Lo Temperatu
E,, mnm
E,, 1112
@g 1112 - Copy Strategy To
=
L4 1114 Strategy operations 3 E‘t Reorder Module Blocks
@, 1113
@’, 1116 - Export Aspect Data
&=, 1121 - Update BACnet EDE Data Compare Strategy To Controller
@,,1122—.;Jm5r T " 1 T

Alternatively, you can select Compare from the Controller tab of the Ribbon .

e Contraller Strategy

%Communications I't'l Download @Co are E:';Version r.{B

k. % Controller ’BWipe Controller Show Compare % Time and Date L—.j 5

% BACnet Ii"l‘ Auto Online "_|:!| Maximums :.' L
Configuration Operations

Only strategy modules are compared.

Note: Parts of the strategy that can be modified using tools other than the Engineering Tool (e.g. CCView)
are not compared. For example, the sample interval on a Datalog module is excluded from the
comparison, but the Type of datalog is included.
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Compare Process
When the Compare process is requested, the Select Items to Compare dialog is displayed:

Select ltems to Compare

¥ Hardware Blocks

[~ Range | 007-024

v Strategy Block:

™ Range | 001-1024

¥ Analog Setpoint Values

[” Range | 001-1024

[V Digital Setpoint Values

[~ Range | 001-1024

¥ BACnet Points
[~ Range |001-224

¥ Select/ deselect all

Compare | Cancel |

This allows specific subsets of the strategy to be compared if required.

Clicking the Compare button starts the process, and shows the Uploading progress dialog:

=

Uploading

Controller

Hardware Points ’i,?
strategy EBlocks || RN | 1025

Analog Setpoint Values ,3—
Digital Setpoint Values ’7,—
BAChnet Point Config lil—

Receiving analog setpoints...

dore_|

and when the upload is complete, a comparison report dialog is displayed

Site : BACnet Real Comms Controller No.: 2 Field Controller No.: 1

Select blocks to update

Type [ Service Or... | Block Type | Difference

FLX Madule 1 Configuration FLXModule at address <1> Is configured on controller but is not configure
Strateqy Blacks 1 Boalean The Output “Complement” has address: - <Unconnected> on the Contralle
Strategy Blocks 3 Adder/Scaler The Input “Input B* has address: - <Unconnected> on the Controller - <2>
Strategy Blocks 5 Modbus analog The black of type Modbus analog at address 6 on the strategy is not presen
Strateqy Blacks 1025 FLX part configurat.. The ‘Module at 1° valug is: - <FLX=4R4> on the Controller - <None> on the
< >

1 Show only blocks with differences © Showall blocks
PC Controller

A Jump to., "

I Compare is complete, (Select to start a new upload.)

This dialog lists all of the differences between the PCversion of the Strategy and the Controller version, with a facility
to jump to each of the modules that contains a difference, so that the difference can be manually resolved.

When the differences have been resolved, clicking on the Close button terminates the Compare process.
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Strategy Synchronization

CXprot® will evaluate whether its copy of the strategy and the Controller's are fully synchronized at the following
times:

e When a module is selected in the Strategy drawing
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e When a strategy is closed following a partial download

e When Scan Mode is enabled

If any potential discrepancy is found, the user will be prompted to run the Strategy Compare feature.

Modules in the drawing that do not match the controller strategy are marked with an icon showing a red circle

containing an “x” to indicate that it is no in sync:

A-B TR .1
7 Inpz A output [y
&) Input B Complement [F

The user is not blocked or forced to take any action, and no changes take place in the background.

Note: The checks apply to all strategy modules with the following exceptions:

* Macros

¢ DI Modules

¢ Set Point Modules

¢ |0 Modules (On UC16 controllers)
e Comment Modules

When a module properties are edited:

When a module is selected, its Synchronised Status is displayed in the properties inspector:

Synchronised Status Checking...
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When a strategy is closed following a partial download:

A partial download takes place when the Automatic Download feature is disabled. In this case, selecting Compare from

the Controller tab of the Ribbon will opena Select items to Download dialog allowing different subsets of the strategy

to be downloaded individually.

This dialog is similar to the Select Items to Compare dialog used in the compare process (see Strategy Compare on
page 97).

However, if you carry out a partial download the setup block is not downloaded. The next time you close the
strategy, the Synchronisation process will register a discrepancy between PC and Controller strategies. When this
happens, a warning will be displayed stating that the “setup block was updated but not downloaded” and
suggesting that the setup is downloaded:

Cylon Engineering Centre

'0' The setup block was updated but not downloaded to the controller.

k. *
This may cause synchronization issues between the controller strategy
and PC strategy. It is strongly recommended that you download the

setup to the controller before continuing.

Do you want to continue anyway?

Yes | Mo |

Clicking on the No button will allow you to save the setup block. If you do not wish to do so, click the Yes button
and the strategy will be closed without updating the setup block on the Controller.

When Scan Mode is enabled

When Scan Mode is activated (see Activate scan mode on page 136) the PC version of the strategy is compared to

the Controller version and if any discrepancies are found, the mismatched modules will be identified by a flashing
‘highlight box” and a message in the status bar will inform the user

100
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READING LIVE POINT VALUES (LIVELOG)

The LiveLog feature in CXpro"® allows you to read the values of points in the controllers on your site (i.e. it reports
“live” or in real-time from the site).

As well as reading point values, the Livelog also scans time schedules, the BMS network, and its Fieldbusses, and,
if configured to do so, it will log those values to a text file. It can also show HOA values.
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Configuring Live Log

Livelog can scan just one strategy or all open strategies, can either append to the log or wipe the log each time it
starts and can write the log to a file for later analysis.

To set up these options, select LiveLog Setup from the Controller tab of the Ribbon

Contraller | Strategy

¥4 Communications |ty Download [, Compare B version [ soard Diagnostis | [ 1 [ F&Livwg Setup = =
T3 Controller '} Wipe Controller 7] Show Compare | B Time and Date B} statistics Qo £ [ Livelog Report 7 <
o = = Scan Override Livelog Interface Config:
% BACnet 2 Auto Online & Maximums ‘a Lock and Unlock Paint ®; Upload BACnet Foints | gyilder
Configuration Operations Testing Keypad
a g |« 001_01.532 I % | Properties F“, LiveLog Setup

~ | ~ Configure LiveLog operation.

This opens the Livelog Setup dialog.

Livelog Setup
Scan Update
" Al Opened Strategies " append
% Active Strategy * Overwrite
Scan Interval (<60s) 5

¥ Log To File

| \SYSTEMNiowin.log

In the Update section, select Append to cause the Livelog to add new scan data to the end of the existing list, or
Overwrite to cause the Livelog list to be replaced each time a scan is completed.
Update

" Append

(* Overwrite

In the Scan section you can either click the All Opened Strategies radio button to allow the LivelLog to show point
values from all of the strategies that are currently opened or else restrict the log to the point values of the active
strategy only, by clicking the Active Strategy radio button.
Scan
(" All Opened Strategies
{* Active Strategy

Scan Interval (< 60s) 5

If you chose to scan the Active Strategy only, enter a number between 1 and 60 in the Scan Interval edit box. This
represents the number of seconds CXpro"® will remain idle after scanning the strategy before it will scan the strategy
again. (The LiveLog continuously scans the strategy until you press the Stop Scan button on the Livelog dialog)
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If you would like the results of the LivelLog to be written to a text file and saved, click the Log to File checkbox. By

default, logs are saved to \SYSTEM\iowin.log

To view the contents of the Livelog text file, click LiveLog Report in the Controller tab of the Ribbon :

Controller | Strategy

& Communications | py Download [&, compare B version [ Board Diagnostis | 1 1 [E] Gtivetogsetup = [
%Contm\ler ¥} Wipe Contraller Shawcampare B3 Time and Date B3 Statistics Q' ® f Fg LiveLog Report /
. Bl = Scan  Override Livelog ‘T%] = Interface Cor
%BACnet ﬁ Auto Online = Maximums '@ Lock and Unlock Point ﬂ Uplbad BACnet Points Builder
Canfiguration Operations Testing Keypac
a g 4 001_01.532 I X | Properties
2
413

This will open the log file in your default text editor:

£ iowinlog - Notepad = =

File Edit Format View Help
\Currently Scanning Scanning Real Points (1-16)

2881_981.s32 PL Office 881 - Network ee1 - ee1 - (BM24

881_81.s32 PL Office 881 - Network ae1 - @81 - CBM24

Running Livelog

Select from the Site List the site the BACnet Router and Field Controller containing the point that is to be read.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

=

File - Home Controller Strategy

~ CU%Ed £ copy praperties | [JEJ] Modules 7] strateay
#¥ DiscBnnect | [§FPaste o [ Navigation Macros [ ] Reopen
..... ite
Tiselectan | | st |[EPage Names [ Search
Site Clibboard View

Activate LiveLog by clicking the LiveLog option in the Controller tab of the Ribbon

File ~  Heme  Controller = Strategy

& Connect | ¥ Communications | gy Download [, Compare B version R BoardDiagnestis. [ 1 [&] Btivetos setun E
¥ Disconnect | G Controller X} Wipe Controller [7] Show Compare | Tl Time and Date T} statistics QAo ER) LiveLog Report q
5 = = san Override Livelal gy Intert
iy sacnet 4 Auto Online B Maximums & Lock and Unlock o . Upload BACnet Paints | gy,

Site Configuration Operations Testing

site List 2| |4 001_01.532 b x| [Prog ivelog (Shift+F3)
|E..§) Z\te; Iy | ~ 1‘ View Livelog output.
This opens the Livelog dialog:

m Livelog

Livelog of Sie |
Strategy Target [ p| Office 001 - Network 001 -001 - CBM24.
Mode. PointNo | Point Mame Point Type | Value Override | Time
p 002 Heating Water Temp Analog 001 14:31:58
'+ Points 003 Qutside Air Temperature  Analog 0.0 14:31:58
c
c
Scanning
& 10 Points
© Analogs
" Digitals
Override Stop Sean Clear
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LiveLog - Scanning Definition

In the LiveLog dialog, you can view the following parameters for the LiveLog, and change them where it is

appropriate to do so:

e The name of the current strategy

e The Mode of the Livelog, i.e. whether the LiveLog will log points, schedules or the network status
e The Target Controller for the current strategy

e The type of points to be scanned

e  Whether or not points will be overwritten

Strategy name tab

L] Liveluy —

Livelog af Site ]
1

The name of the strategy which is actively being scanned is displayed on the strategy name tab . If you chose the scan
Active Strategy option in the Livelog Setup dialog box (see Configuring Live Log on page 101), the file name tab will
display the name of the active strategy. If you chose the scan All Opened Strategies option in the Livelog Setup dialog

box, there will be a file name tab for every open strategy.

Strategy Target

Strategy Target | pL Office | 001 - Network [ 001 - 001 - cBM24

This window shows the target of the currently selected strategy. The values cannot be changed in the LiveLog dialog.

LiveLog mode
KMode

* Paoints
~

~

The LiveLog interface changes, depending on the mode that is being logged:

e Points mode

In this view, you can see points in the selected strategy, their types and values, and you can overwrite them if
required.

e LivelLog: Time Schedule mode
You can examine the time schedules in the selected strategy with this dialog box.
e LivelLog: Network mode

You can view the status of the RS485 Fieldbus with this screen, i.e. which controllers are online or offline, and which
controllers are servicing or not servicing.
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Scanning definition

Scanning
& 10 Points
" Analogs
" Digitals
The Scanning section of the LiveLog window allows you to decide which values to scan.
To scan the values of the controller’'s hardware points, click IOPoints .
To scan analog points only, click Analogs in the scanning section. To scan a specific number of analog points, enter
a range of point numbers in the edit box under Digitals .
To scan digital points only, click Digitals in the scanning section. To scan a specific number of digital points, enter
a range of point numbers in the edit box under Digitals .
Override Status
When a scan has been stopped, you can change the override status of any point listed in the LiveLog window by
selecting the point from the list and clicking on the Override button at the bottom left of the window.
| Point No | Paint Mame ‘ Point Type | Value | Cwerride ‘ Time |
‘ 002 Heating Water Temp Analog 0.01 15:44:08
Qutside Air Temperature Analog
D\ret'de Stop Scan | Clear |
This opens the Override Hardware Point dialog, where the current override status of the point is displayed and can
be changed if necessary.
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MANUALLY OVERRIDING POINT VALUES - THE OVERRIDE POINT DIALOG

Overriding points

Point values can be overridden using the Override Hardware Point dialog, which allows you to set a point in a strategy to
a particular value, regardless of conditions at a controller’s inputs or outputs, or conditions within the strategy itself.
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e When a hardware output is manually overridden (disabled), the modules in the strategy do not affect the
point value.

e  When a hardware input is manually overridden (disabled), the hardware signal which is connected to the
input (PT1000, transmitter, dry contact, etc.) is ignored by the input.

In both cases, the overridden hardware point keeps the value that is assigned to it in the Override Point dialog.

The only way to change the value of a hardware point which has been manually overridden to another specified
value is to use the Override option again, assigning a new value in place of the first.

Note: Some specific controllers, such as CBX-8R8-H and FLX-4R4-H, have “HOA” controls built-in to them.
When these HOA controls are active, CXpro"® cannot affect them but can display the overridden
values, but not affect them.

Removing manual override status from a hardware point (enabling) means that the point can now be influenced
by the connected hardware or strategy once again. The length of time that a hardware point will remain in the
overridden state can be set in CXpro*P.

It is only possible to disable and enable hardware point values from CXpro"® if the PCis connected to a controller

(either directly or via a BACnet Router) and CXpro"® Connect button is active.

Whether hardware points are overridden by the CXpro"® Override Point dialog, or by HOA switches on the Controller

itself, CXpro"'® is aware of the override state and value and displays it in the LiveLog window.

Point No Point Name Point Type Value Cwverride Time
Anl Qutput 209 Analog 1 . One Hour © 11:32:50

Point Mo Point Mame Point Type Value Override Time

Anl Output 209 Analog 46.00 H i 11:31:09

Point No Point Mame Point Type Value Override Time
Anl Qutput 209 Analog :11:31:39

Point No Point Name Point Type | Value Qverride Time

Anl Qutput 209 Analog 1 | Continuous : 11:33:18

The point’s Strategy module has a digital output labeled Override, which is set to a value of 1 if an override is in effect
(i.e. the hardware point is ‘disabled’), or @ if the point is not overridden (i.e. the point is ‘enabled’).

Anzlog Cutput I Digital Output 2
AD Analog Qutpur ‘ DD Boiler Enable
3 Point | om0 3 Point | ovemz=[H)
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Using the Override Point dialog:
To open the Override Point dialog, either:

1. Right-click on a line or module and select Override Hardware Point Value from the context menu:

1]
s ’ R s =1
: Show Point Route .
- . Anzlog Input 3 Subtracion
Convert Line to Connector Al Named paint o - A-B-C-D
. - ’ ; . oo
< Simulation properties . = Display Options >
. Override Hardware Point Value . S . Owverride Hardware Point Value
rO— -1 ] T

2. orclick on the Override buttoninthe Livelog dialog

Livelog of Ste |
Serategy Teget  [Pnimeat [001 - Network name [001- 002 - cexans

Moce Pownt No | Point Name Pout Type Valve Override  Time
001 Aralog Mardware 0 035101

[ Qemnde Stop Sgan Clear

The relevant Override Hardware Point dialog (analog or digital) will open:

Owverride Hardware Point Owerride Hardware Point

PointType | Analog PointType | Digital

Paint Mumber I 1 Paint Mumber |2

' 1Hour Override * DOff ' 1Hour
Durati o
Lration " Midnight ¢ Continuous

Override o
Durati
Lration " Midnight ¢ Continuous

Value IlOU0,00U Change I Value IOFF ;I Change I

Status Status
’7 Received point value from controller ’V Received point value from controller

Close | Close |

The Override Duration can be set to one of the following states:

e inactive at all times - Off

e  active until the controller time passes 00:00 - Midnight

e active for one hour from the time at which it becomes active - 1 Hour
e  active at all times — Continuous

e [fthe override is caused by a Controller’s HOA switch, the override state is reported as “HOA”

The ' Midnight ' and ' 1 hour ' options are provided to conveniently avoid problems that could arise if the override is

not removed when it is no longer required.
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Note: Even if '0ff'is selected in the Override Duration for Hardware Point section, setting a value (analog) or
state (digital) for the point will still have an effect. When the Override button on the dialog is

pressed, the value is sent to the point in the controller strategy, which stays at that value until the
next time that the controller scans its strategy.

Enter a value for the point.

In this instance, a value of 100 is being is being entered for an analog point. value [100 Change_|
A value of 0Off or On can be entered for digital points. vaiue [Off | [_change
Select the length of time that the value of the point will be changed in the Override £ 1 Hour

Duration

Override Duration for Hardware Point section of the dialog.

ight lﬁlkonﬁnuous

The point will be set to the entered value when the Change button is pressed: Value | 100 Cha

Click the Close button to close the dialog.

Notes about overriding BACnet points
Inputs

When an input is overridden via CXpro"®, both the “out of service” and the “override” flags are
automatically set.

When an overridden input comes out of its CXpro"® override both the “out of service” and the
“override” flags are reset. It will be put into service regardless of the state it was in prior to going
into override.

To override an input via BACnet, the “out of service” flag is manually set by writing to the “out
of service” property. Then the desired value is written to the present-value. The OWS can clear
any CXpro"® override by putting the point back into service and then back out again. From CXpro*®
side, the “override” flag will disappear and be replaced with an “overridden” flag.

Putting an input in service will clear all overrides both CXpro"® and BACnet and will flag the change
appropriately on both protocols.

Outputs

When an output is overridden via CXpro"®, both the “out of service” and the “override” flags
are set. The information in the present-value property will still be delivered to the hardware layer
despite being out of service.

When an overridden output comes out of its CXpro"® override, the point is put back in service, and
both the “out of service” and the “override” flags are reset.

To override an output via BACnet, it is presumed that the priority array will be used, and clear all
overrides and flag the change appropriately on both sides.

All 1/0 blocks have an output labeled Override . This output is true any time the point is “out of

service” or “overridden” via CXpro"P. This way the point reflects the status of the data regardless
of whether it is being overridden via BACnet or CXpro*®.

MANO133 rev 15 Cylon Controls Ltd.
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HOW TO ENABLE A HARDWARE POINT VALUE (REMOVE MANUAL OVERRIDE STATUS)

Removing manual override status from a hardware point (enabling) means that the point will once again respond
to hardware connections or strategy conditions.

If the override duration on a hardware point has been set to 1 hour or until Midnight the point will be enabled
when the specified period has elapsed. However,

e If the override is identified as “HOA” you must use the switch on the Controller to disable it.

e if the override duration has been set to Continuous the following procedure must be carried to enable
the point:
Open the Override Point dialog by selecting Change Point from the Controller tab of the Ribbon or by

clicking on the Override button in the Livelog dialog, and select the point to be overridden.

Select the Off optioninthe Override Duration section of the

dialog,

Override [:b " 1 Haour
Click the Change button to apply the change. Duration Midnight ¢ Continuous

Click the Close button to close the dialog.

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click

the Restart button.

The next time the Livelog scans that point, its new value will be displayed. The LiveLog window displays
the symbol 9 beside the value of points that have been changed.

Note: Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to
be monitored more effectively.
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HOW TO CHANGE THE VALUE OF A SETPOINT

The value of a set point can be changed using the Change Set Point Value dialog box, in a similar way to changing the

value of a hardware point.

The procedure for changing the value of a setpoint is as follows:
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To open the Change Set Point Value dialog either:

1. Right-click on a setpoint module or the line and click Change Setpoint Value option from the context menu:

Analog Setpoint = o Absohut Vak
() sorsurpme Al -

[ Foint (3 [+ ¥ oy E

..................... c Show Peint Route

0_’_1 Digital Setpoint B c o o Convert Line to Connector
Digital Setpoint C o o
- . B . Simulation properties
T Change Set Point Value |

Change Set Point Value

2. orclick on the Override button inthe Livelog dialog:

[ PointMe | Paint Name | PaintType | value | override | Time |
002 Heating Water Temp Analog 0.01 15:44:08

Outside Air Temperature __Analog 0.01

D-vetde Stop Sean Clear

The relevant Change Set Point Value dialog (analog or digital) will open:

Change Set Point Value Change 5et Point Value
Point Type I Analog Point Type I Digital
Paint Number |2 Paint Number | 1]

Value | 0.00] Change | Value | Off | Change |

Status Status
’7 Received point value from controller ’7 Received point value from controller

Close | Close |

Enter a value for the point.

Value |100 Change I

In this instance, a value of 100 is being is being entered for an analog point.

A value of 0Off or On can be entered for digital points. value [Off ~][_chenge_|
The point will be set to the entered value when the Change button is pressed: value | 100 Cha

Click the Close button to close the dialog.

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click the Restart
button.

The next time the Livelog scans that point, its new value will be displayed. The LiveLog displays the symbol 9
beside the value of points that have been changed.

Note: Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to
be monitored more effectively.
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WHAT IS A STRATEGY?

A Cylon Field Controller interacts with HVAC and other equipment by varying its outputs in response to inputs such
as temperature, switch settings, air flow speed, etc.

The way that the controller’s outputs react in response to the controller’s inputs can be defined by the user. The
definition is called a ‘strategy’.
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A strategy is the ‘user program’, stored in a Cylon Field Controller, which configures the controller for a specific role
in a BMS site. It can be described as the “implementation of a solution to a requirement on a site”.

In CXpro"®, a strategy is designed graphically using the algorithmic modules available on the modules panel. It is

saved as a strategy file on the Engineering PC and then downloaded to the controller for which it was designed,
where it tells the controller how to behave within the BMS site.

The simplest of strategies is made up of algorithmic modules, hardware, and virtual points. Strategies are often more
complex, however, and can also include time schedules, trendlogs, and alarms.

AN EXAMPLE OF A STRATEGY

The Problem

The heating system of a building is too costly to run constantly.

The Solution

The heating system should be switched off when the outside air temperature rises above a certain point (for
example 23°C). It should not be switched on again until the outside air temperature drops below another pre-
defined point (in this case, 18°C).

The Strategy

A strategy to implement this solution to the problem can be designed in CXpro"® and downloaded to the controller
connected to the heating system, where it will be applied.

The strategy shown below uses the Hysteresis module to compare the outside air temperature to the two set points
defined in the module (in this case, these are set at 18 °C and 23 °C). If the outside air temperature is greater than
23 °C, the H outputis unset (off). If itislessthan 18 °C, the H outputis set (on).

The strategy is saved and then downloaded to the Field Controller connected to the heating system.

Analkog Input El I Hysteress =1 Digital Output 3
Al Temparature I ﬂ - DO Heating Enable
e T Wi ST - e
Cvemidz [0 Active Low [0
T 7 |Onlevel: 2.00; OF level: 4.00 ’
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HOW TO CREATE A STRATEGY

To create a strategy, follow these steps:

e Select Site, BACnet Router, and Field Controller in the Site List and double-click to open its strategy:

Engit ing Centre - 8.00.00-286

S oEm|

Fie - Home  Contioler | stutegy |

# Comnect 3| tHconr

Foisconnea | | Fpaste

Download | -

add corder Strate
Text Terminals Modules T Strateqy Details ~ Help
Strategy

site Controller

=-§) Sites
&-2g BACnet P
258 001 - Network
& 001 - 001 - UCU3213V

B E 5AChet Points
W oacnet units

B create

8]

B Manager
View StartPause Stop  Reset
Macros [ Save New

Macros Simulation

Connected to: Sample Apps BACnet (3], Remote - BACnet

Q Q %q«luggmg
» H & Conriguration

Bcid
B Gria Colour

7 sacksround Colour

BT} New Connections

Display

@

Favorites

Constants.

Controls

Functions
Math

Schedules, Timers, andL...
Setpoints, Inputs, and 0.

ddel=l=l=l=|~ =

Al snalog Input
AO  analog output
(2 analog setpoint

3: BAChet Analog
‘BACnet Analog Priority Array
E: BACnet Binary

‘BACnet Binary Priority Array
DI pigital tnput

DO Dpigital output

24 oigital Setpoint

Statistics

VA

Virtuals

-

f———————100% OVR CAP NUM SCRL

Engineering Centre

There is no.
Strategy?

o

Click Ok to open a blank strategy

Connected to: Sample Apps BAChet (3], Remote - BACnet

@ = Engineering Centre - 8.00.00-286 = =
File ©  Home  Controller | Strateqy ®
# Connet 3| ooy B G Guoers E ) create oy Qj @, Logaing o 1} New Connections.
Foisconnea | L | Zypaste & 5acnet units BBy Manager | € Configuration | B Grid Colour
Downiosd | = Rda U0 Reorcer Stotegy View Startpause Stop Reset
Ject Al o s e R s (|| (o D e E ([ e
Site Controller Clipboard Strategy Macros Simulation Display
ste
[=K3) =
=} Favorites N
= -
52 001 - Network Constants. ~
& 001 - 001 - UCU3213V
& 001-002- CBM24 Controls »
Functions. N
Math )
Schedules, Timers, and L. )
Setpoints, Inputs, and O... -

Al analog mput
AO  analog output
Bmm Analog Setpoint
E: BACnet Analog
‘BACnet Analog Priority Array
E: BACnet Binary
‘BACnet Binary Priority Aray
DI pigital input
DO pigital cutput

21 oigital Setpoint

Statistics

VA

Virtuals

Al

—

—————— 100% OVR CAP NUM SCRL

If the selected Feld Controller does not already have a strategy, you will be prompted to create a new one:
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e  Select a module from the modules panel

LRl Engineering Centre - 20000286

e - Meme  Comvober | Susew
# o 4 | Cheom : El
Fowcena | | proae & sacnat uns
O et e o Tomials Mot 6 Sty Dt "
Cigtoara Snateny
sasayt

B cene
wansger
.}
Nacros [ Sare e
aares

Q O Qe

SutBruse Stop Reser

Simudaion

BACH Sarisl
Sample Apps BACnet

IS
&

B

Connected to: Sampie Apps BACnel B, Remate - BACnet

and place it on the drawing area

e - Engineering Centre - B.00,00-285

3 @ st Ui E| L=

By Manager
o moctes Sy | View
T S 0 oar e e | Y. o

Stastegy Maron

e - veme  Conomr | Sty

L. o
o D IE_M
st | AR

site Contioller Cigosrd

#comea

¥ Oiscsnmest B Ay sacret Foines

9 o odm

SuPhse Stop Reset

Simudation
40 st el

Sto it
;gnu B
By Bacna
| 8B
e
&

- 001 -001- ucusaraw
- pon - 002 - CBM

£o BACnw Seral

-8 Sampi 4pps BAChat

Connectea to Samps Apps BACet B, Remate - BACRet

If the module represents a point you will be prompted

Engineering Centre - 20000286
e - Heme  Comvober | Susew
o ¥ Gicem [ I e El B ceste Q. Qecuing
o vicseea Byrue O acnat unes By Mg i Gy contigurion
DO et Al i e o s 6 Sty Oeti " | s 8 Sare e | SIS 108 et

Ste | Contolle Cigpomra Seteny Hacon Simuitian
Stelis N0 L
E—gslu -

g Bacne e

| &2 001- Hetwor

| e oo oon- wcvszr

| L oo

-2 BACaM Seial

-2 Sample Apps EACnet

Point Name
et e [Fompres

E » |l N

Setup black updated. Connected to: Sampie App: BACnel B}, Remate - BACnet

x|

B o

B sua coioue

7 Sackground Coour
Dipin
3@ Modies o]

B e Cannections

Fantes
Consarts

omonls

Funcaons

watn

Schedules, Temers, andL
Syo, s, 0
Al Irgut
AO ariog ouman
(2) soaog setpont

ale|v|=|s e[ m

23 sacnet nsiog
Bacrat ansiog Prcry Aevsy
23 sacnet inary

Bagnet

Pty ray
[ Tg——

DO pigtal Output
-

Statises ,
w -
Vil .

o

P Gua Caowr

7 Beasround Colour
ool
30 wosuies s@

D uew conmections

Faamas ,
Constarts ,
Contls .
Funcions. ,
watn .
Schedules, Teners, a0l
Setpoints, Ioputs, and 0.+
Al anaiog Input

AOQ ansiog Duiput

(2 anakg sepone

23 nacnet anaiog

Bt Analog Priorty Svay
23 sacnatmnany
Batnet Binary Prorky Aray

DI oighal tnput

DO pigral output

L bigial Setpoint
Statncs ,
av ,
Vietsals v

to enter a name. Enter one and click

®
o
& suacone
I Buskground Colour
Oisplay
- e

B e Cannections

Fantes
Consarts

omonls

Funcaons

watn

Schedules, Temers, andL
Sypo, s, 0
Al ansiog rout
AO ariog ouman
(2) soaog setpont

ale|v|=|s e[ m

23 sacnet nsiog
PSR-
23 sacnet inary

Bacnat Binar peonty Aray

[ Tg——

DO pigtal Output
-
Statises ,
w -
Vil .

Ok .
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The module is now on the drawing area. It can now be moved, deleted, copied, or linked to other modules.

2 Engineering Centre - B00.00-286 - olEl
7, S 3] 0 O 0 e B 8 new comctons
Contigurtion | BP Gid Ca
Strategy e o) o O Z
25 . £ Aagei ol
Saniaion Doy
« propartas o O Modules oo
Favarites »
Constants. »
Controls. »
Functions v
3B Semple Apps BACnel o -
Schedules, Timers, and L =
Setpoints, Inputs, and 0. -
Al insiog Input
AOQ  snalog Output
Al Aralop o 7] Analog Setpoint
omparmre N
[ =& ey BACnet Anahog

Setup biock updsted

BACnet Analog Prioity Array
83 sacnetBinary
BAet Binary Pricaty ATaY
DI pigitl Input
DO pigital Dutput

L pigital Setpoint
Statistics »
v »

Virtuals »

Connectea to: Sample Apps BACnet (3], Remote . 8ACnet

To operate on a module, it must be selected by left-clicking on it,

® 001 - 002 oMz
-5z BACet Sesal
-8z Semple Apps BACnet

0 Al analog tnput

Qo AO  anaiog Outout
©

. oTION
R 29 B0t nalog

(7) analog setpoint

BACnet Analog Pronty Armay
l Poit  Analog 1) Tem
1 ) 2% manet sy

BACnet Binary Prionty Amay

or by dragging a selection box around the module symbol (or symbols)

Controls

Functions.

Math

Schadulas, Timers, and L.

PIEaC A

Setpoints, Inputs, and O
Al analog input
AQ anlog Output
() analog Setpuint
23 sacatanaiog
BACnst Analog Prorty Aay
22 et
BACnst Binary Priorty Aray
DI oigital tnput.

DO pigital output

8 it St

Once a module has been selected, it can then be:

moved
deleted
cut
copied

pasted

by using the mouse to drag the module to its new location;
by pressing the [DELETE] key on the keyboard;

by pressing [Ctrl] + [x] on the keyboard

by pressing [Ctrl] + [c] on the keyboard

by pressing [Ctrl] + [v] on the keyboard

Note: Pasted hardware point modules may adapt some parameters to the destination point but retain
others. For example, an analog input configured as PT1000 when pasted to a UniPut™ will change

to a voltage input but retain the max and min limits (in the Advanced button) which for PT1000

could be min @ and max 0, leading to incorrect operation of the UniPut™.
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Place all the required modules on the drawing area and join them

(@]
Place other modules required to implement the strategy on the drawing area. &
=
Modules must be positioned from left to right on the drawing area. Hardware inputs must go on the left side of &4
the drawing area, hardware outputs on the right. Between the inputs and the outputs, organize the modules so [
that a signal flows from left to right across the strategy. ®
(0]
q 001_01.532 [ 34 @

N o= T T T o e

Point ()| | Input | aaive Hih [ 8 Point Ovenide [0

Ee e . .
o o .Clr\ Isve.l: 1:3::.0H Isvé\:4:2)l). _

Join the modules together as required, by placing the mouse pointer over module inputs or outputs

4 001_01.532 24
-~
‘Analog Input Bl o Hyszresis = o ) Digia] Output 5
AI Temperature ﬂ DO Heating Enable
Poirz £ 3 |6 Input | aaive Hih [ 8 Point Ovenide [0
Overrice [ | AcvzLow @
C © " [Onlevel: Z.00; Off level: .00

and dragging to another modules output or input.

‘Anzlog Input 3 o Hyszress s o Digia] Output 5
AI Temperature J DO Heating Enable
Pomt— [Smpe [ Acive High @3 C [ painc Overdz
Overnde [0 o | Actve Low [ C
Gn Fevelt 2.00: OF Evel 4.00

CXpro'® displays lines between linked modules:

‘Anzlog Input 3 o Hyst=ress BN o Digral Output 5
Al Temperature 0 ﬂ : 0 DO Heating Enable
Point €| ) E)] € Inpt [ Acive High ) 5 Point Ouemice 0
Ovenide [0 | Acvelon @
On Jevek 2,00; OFF level: 4,00 :

If you cannot see a line connecting the two modules, right-click on the drawing area and select Display Options >

Display Lines > Show All Lines from the menu that appears

. Display Options 3 . Display Lines 3 . Showlgl Lines

oL .DisplayLabeIs ’ .Hide Lines

Continue joining modules until all the required connections have been made.

4 001_01.532 X
.................... -
Analog Input 3 Hysteresis 15
Al Temperatura C : J """ Heating Enable
| Paint (3| T 3)3[np..|t | acive High e
[ oem=@ : : [ amelon@m
o : Onlevek 2.00; O levek 200 | © 0 0
L v
< >

MANO133 rev 15 © Cylon Controls Ltd. 115



an04dxD

Automatic point selection

When two unconnected modules are linked together, CXpro® automatically selects the next available virtual point.
This is the lowest numbered unused point. This number is entered in the two modules that are linked, as an input
and an output, and it is also displayed at either end of the connecting line. In the example below, the number of
the virtual point connecting the two modules is 1 and it is displayed at both ends of the connection:

Analog Input = Hysteresis 15

Al Temperature S ﬂ-
Point £ ll.J illl 2 Input Aotz High 0
Ovemide Active Low [T

On level; 2.00; Off level: 4.00

If you cannot see the point number at either end of a connection line, click Module Setup from the Display menu.

right-click on the drawing area and select Display Options > Display Labels > Show Number from the menu that

appears
_1| ..................................
A . Display Options 4 Display Lines ’ l --------------
-1 Display Labels » Hide

P — Shotkl\lumber

N [ Shobiame

N : Show Value Only (simulation)
,:lm . r— 4“\&;“ | I .....

When the output of a module which is already connected is connected to the input of another module, the point
number of this output will be written in the input.
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Selecting a connection line

(@]
To select a line connecting two modules, click the line with the left mouse button. Selected lines are displayed with &
a green highlights. Selected lines can then be: u%
2
moved by using the mouse to drag the line to its new location %
‘g.

deleted by pressing the [Delete] key on the keyboard

When a connection line is deleted, the point number in the input of the target module will be removed.

If this connection was the only one for the output of the source module, the point number will be removed from
there too. The point will now be available for other connections.

Naming a point

To give a point a name, select it and then edit the text in the Name property on the Properties pane.

- ¥ | Properties L x |
~ ? |D|g|ta| Output [9] j
= -
Type Digital Output
Service Order 9
Name Heatinl
Synchronised Status Checking...
=
Point Digital (3): false Heating En...
=
Point type Output Digital
Low threshold 101
Hink thrachnld a5 ﬂ
Name
This is the name of the module,
IAI Absohute Value w
When finished, press enter and the name will be displayed on the module in the Drawing Area.
- % | Properties o x |
~ ? |Digital Output [9] |
=] -
Type Digital Qutput
Digital Output Service Order 9
Heating Enable MName Heating Enable
Synchronised Status Checking...
=
Point Digital (9): false Heating En...
=
Point type Output Digital
Low threshold m
Hink thrachald as j
Name

This is the name of the module.

IAI Absohute Valse e

The name can have no more than 24 alphanumeric characters. Spaces, commas, and full stops may also be used.
Each point in a controller must have a point name that is unique in that controller.
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Assigning a unit to a point

In the case of Analog points, the Units list box (which is displayed in Properties pane) contains a collection of text

strings, one of which will be displayed together with the point value.

To specify a type of unit for a point, select the line that represents it, and select a value from the Unit list.

I X | Properties L - |
2 2| =]
&l Point Details Analog (3) Temperature [C]
Number 3
W Type Analog
Value 0.00
o S = Name Temperature
| =,
e Ung e
El “Fdays
Show Line Vears
Labels Months
Weeks
Days
Hours.
Unit Min

This is the unit of measure for th Sec

If the point is a digital point, select the required unit in the Low Unit and High Unit list boxes. The units of a digital
point are text strings, which are displayed instead of the digital values @ or 1.

[ % | Properties 18
_______ - ? | =
------- =1 Point Details Digital (9) Heating Enable [, |
----- MNurnber 9
"""" Type Digital
S Value false
MName Heating Enable
Hesting Enable Low Unit
High Unit
=
"""" Show Line

Labels

If the list does not contain the unit you require, additional application-specific units can be entered manually in
the C:\CXproHD\ (SITENAME) \SYSTEM \site.ini file. For details on how this is done, see Appendix :: Adding
units of measurement to the system on page 213.

Additional units of measurement can also be added if points are defined using the shortcut method (see A short
cut to defining hardware points on page 87). When the tab (or comma) separated list of point definitions is
prepared, units of measurement which are not already defined in C: \CXproHD\ (SITENAME) \SYSTEM \site.ini
can be used. When the definitions are pasted to the Database Interface, the new units of measurements will be
added automatically to site.ini.
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Creating Strategies - Set the values of the module's Constants

(@]
=
Many modules can be configured by setting internal constant values. These are accessible in the Properties pane §
when the module is selected. For example, the Timer with Constant Inputs module has the following properties: =]
i
I % | Properties i x | =
= Temer win Gonsmne. 2] ™ ? | j 05!;
2 o
1 Trigg=r ‘ Output [0 Type Timer with Constant Inputs @
0 Reset ‘ co'"ple'"e"_'t_a B Service Order 16
[On deley: 10; OF dely: 10; Mini._. - -
— — = . Synchronised Status Disconnected
=
Trigger Digital
Reset Digital
=
On delay 10
Off delay 0
Minimum en time 0
=
Output Digital
Complement Digital
v
> Properties Page Names Modules

Creating Strategies - Add explanatory text if necessary

Text can be added to the drawing area to label parts of the strategy to explain the purpose of certain modules, or
groups of modules, within the strategy,

You can add text or edit text that is already in the strategy drawing. You can also delete, cut, or copy the text in a
strategy.

For details see How to add text to a strategy on page 75
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HOW TO REORDER BLOCKS IN A STRATEGY

It is possible to change the order of blocks within a Strategy, which can help to optimize the servicing process.

From the Site List , right-click on the controller and select Strategy Operations > Re-Order Module Blocks

g s
B-%o PL Office
=52 001 - Network
L=
B-8a SammaAppsBxE’
- 52 001 - Wet 5
& -
L= 112
-E, 113
E{, 1114 -
L& 5
&, 1116 -
L= 121-

e s NaNalal

Copy Strategy To
Strategy operations +| B3 Reorder Module Blacks

Export Aspect Data
Update BACnet EDE Data

B, 1122 - Verowrarerarrmo—rme

This opens the Reorder Modules tab in the Strategy Details dialog:

Strategy Details
Display

Mew Line
Strategy Blocks
Controller Limits
Resources

Points Manager

BACnet units

1/0 Terminals

Reorder Madules

Highlighted modules are serviced based on time, and not service order.

Service Order | Module | ol A
1 1-Comparator
2 2-BACnet Scheduls A
3 3- Absolute Value
4 4 - Maximum LI
5 5-Analog Gate
6 6-Limitto 0 or 100 LI
7 7-Rounding
8 8- Integer Constant
9 9-Real Constant
10 10- VAV Differential Pressure
11 11-BACnet Schedule
12 12 - Holiday Schedule
13 13- Time Schedule
14 14 - Comparator
15 15 - Hysteresis
16 16 - Timer with Constant Inputs
17 18- Raal Cnnetant hé
Find |

QK I Cancel HApply

The list shows modules in their Service Order .

Note: Some modules serviced based on a time schedule, not necessarily according to their Service Order .
Any modules in the list that are in this category will be highlighted.

Select a module in the list and use the buttons on the right-hand side of the dialog to change its position in the list:

E S 5 [ R

Move the highlighted block to the top of the list (Service number = 1)
Move the highlighted block up one position in the list

Move the highlighted block down one position in the list

Move the highlighted block to the bottom of the list

Highlight the selected block in the Strategy drawing.

Repeat until the list is in the required order.
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HOW TO UPLOAD SETPOINT VALUES

(@)
@
It is possible for all of the controller values for all setpoints in a single Strategy to be retrieved in a single operation. 25
=
oa
From the Site List , right-click on the controller and select Strategy Operations > Upload Setpoints £
Q
Site Navigation = or'é"
E@ Sitex é
E| East Hall
= 007 - Network Fr 0] Strateqy D 22

N (101 - 001 gy
- G Open '001_01,532"

=, 001 - 004 45
[]... HQ Black 2 Ea' =y I ——
[-] Local Metwork, Copy Strategy To | | | |
E‘ CommsCantrol Strategy operations Re-Crder Module Blocks r
: ucsz-m “ +
ucsz-oz2 Showr Globals [ssues Report Le |
002 - UCC4net Show Globals Table Cormpare Strategy To Controller B
E2- 8 Dptinizer T
BB Sample Strategies Dpdalc B et D ala ST TTTTT

This opens the Upload Setpoints dialog:

r ~
Upload Setpoints
Paint Name Address |T pe 4 | Local Controller
a 1 Analog iR} 00o
ad 2 Analog .00 .00
[¥] aB 3 Analog 3no 3no
¥ Select/Unselct Al ‘ Update Selected | | Close: |
Ready

Select the points to be uploaded and click the Update Selected button

NAMING STRATEGY FILES

When saving Strategy files, it is recommended that you use a name which indicates the site, the BACnet Router
number, and the Field Controller number.

For example, the strategy for the Air Handling Unit controller, which is Field Controller number 1 on the Rooftop subnet
(which is BACnet Router number 1) on the Office Block site might be named 0ffice 001-01 AHU.STG
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HOW TO OPEN AN EXISTING STRATEGY:

A Strategy file can only be opened if it is Associated with a controller.

You can open a contoller’s Associated Strategy in one of the following ways:

1. Double-click on the controller in the Site Tree

‘ Site List

=] @ Sites

25 BACnet 1P

Ig PL Office

-8
=)

=1

3. Right-click on the controller in the Site Tree , and select the filename

Site List

Tg BACnet Serial
-5 001 - Network

v
Sample Apps BACnet
_@_ 001 - Wet Systems

11 - CT Single Pump DPS

a3

=] 0 Sites

2o BACnet|

=-5 01 -

21

4. Select the controller in the Site Tree , and select Open from the File drop-down

File - Home

D New
[=r0pen
BEVE

@ Save As

Save All

@ Footers

QI Page Size

QI Printer Scaling
F Print Setup
= Print

(D Licence Details

@Qase

P

2o BACnet Serial
2o PL Office

MNetwork

ﬁn '001_01.532' Ctrl=0

Break
Copy Strategy To

-

Strateqy operations

Export Aspect Data

Update BACnet EDE Data

123 - VT Single Pump Speed

Controller Strategy
Recent Documents g
1001_01.532

2 CAOXproHDA,.\00T_03VAV.532

@Dhep (Drvout XK Exit

1B, 1113 - CT Single Pump Speed

Note: If the strategy for the selected controller is already opened, all of these options will be disabled

(greyed-out).

Note: If you want to open a different strategy file for a controller you must first remove the existing

association, then associate the controller with the required strategy.
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STRATEGY ASSOCIATIONS

What is an "Associated" Strategy?

Each of the Field Controllers in the Site List can have a Strategy Drawing file 'associated' with it, which means that

(@]
=
]
)
=3
=}
]
(%]
o+
=
Q
-
(1]
@
1]
7]

CXpro*® is aware of the filename of the strategy corresponding to that Field Controller. When a Field Controller is

selected, its associated strategy can be opened by double-clicking, or by selecting from the right-click menu.
The icon representing the field controller changes when the Strategy file is associated with it.

The relationships between controllers and strategy filenames for a particular site are stored in the file

C:\CXproHD\ [siteFolderName]\SYSTEM\associations.xml

Note: CBXi controllers at the ‘network’ level can also have Strategies associated with them.

Creating Associations

New strategies

When a new Strategy Drawing is created, a target controller must be selected. When that Strategy is saved for the
first time, it is associated with the selected target controller.

Existing strategies - manual

site List R |

= 9 Sites

Bl-To BACnetIP
I = |

E| Io BACnet Serial

! B2 001 - Network
.m0 [

1 2g PLOffice | Select

LB oo-1[ ne ctri+N
.=, 0 Import Strategy

B-To Sample 4

=52 001 -

A strategy can be associated with a field controller by right-clicking on the Field Controller and selecting "Select". A
list of all existing strategy files that are eligible to be associated with the selected controller will be displayed.
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Breaking Associations

Associations can be broken using a toolbar or right-clicked popup menu option; the link between the Site Tree
Field Controller and the Strategy Drawing is removed.

Site List + B
B-§) Sites

Zg BACnet IP

E1-8g BACnet Serial

i -5 001 - Network

: 1.5 001- 001 - UCU3213VAY

g-2g PL Office

i @22 001 - Network

EE Samp"eApp = Open 001_01.532° ctri=0

Brepk
Copy strategy To
Strateqy operations 3

Export Aspect Data
Update BACnet EDE Data

If an association is broken for an opened Strategy Drawing, then the Strategy Drawing will be closed and the user
will be prompted to save it if changes have been made. Breaking an Association allows the User to associate a

different Strategy Drawing to the Field Controller, using a toolbar or right-click popup menu option on the Site

Tree Field Controller.

Copying associated strategies

From the Site List, it is possible in a single operation to create a copy of the strategy associated with any Field
Controller node and associate that copy with another Field Controller node, as long as the target is of a compatible
controller type and does not already have a strategy associated with it.

Note: A Strategy cannot be copied if it is open and has been modified but not saved (the user is prompted
to save the Strategy so that the Strategy can be copied).

To copy a strategy in the Site List interface:

1. Right-click on the source Field Controller node —i.e. the controller to which the existing strategy is associated.

2. Inthe pop-up menu, select Copy Strategy To

= EE PL Office
-5 001 - Network

=, G

EE Sample Ap| = Open 00101532 Ctrl=0

Break
Copy Str&tegy To

Strategy operations »

In the Copy Strategy dialog that appears, click on the Field Controller to which you want the copied strategy

w

to be associated
Copy Strategy

Copying Strategy ‘001_01.532' from
Site  |PL Office
Comms Controller 001 - Network

Field Controller 001 - 001 - CBM24

To
&1 Sies

e[ 130 BACnet P
512 001 - etk
=

&-[15g BACnet Seiial
&L 122 001 - Netwark
1% 007 - 001 - UCU321 3y
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The Copy Strategy dialog displays the source Site, BACnet Router, and Field Controller node details as well as the
Strategy that will be copied.

The To box contains a "tree" list of potential target Field Controllers, grouped by Site. Potential target Field Controllers
are those that:

(@]
=
]
)
=3
=}
]
(%]
o+
=
Q
-
(1]
@
1]
7]

e are of a Controller Type that is compatible with the source Field Controller Node

e donot already have an Associated Strategy

e donot have a newly created Strategy

The next available Field Controller node is always selected on the source Site. If no Field Controllers are available on the
source Site then no Field Controller is selected and the Site Tree is shown collapsed (closed).

The Copy button is enabled when a Field Controller Node is selected. When it is clicked, a new Strategy is created

and opened with the contents of the source Strategy being copied, including the Database names and Keypad
Details. The copied Strategy is then Associated with the Target Field Controller node.

Importing a Strategy

The Copy Strategy To function applies to strategy files that reside in the current Site file structure. It is possible that
files which were associated with a specific folder have been copied to locations outside the Site folders, and will
not be found by the Copy Strategy To process. In that case, the Import Strategy function may be used.

To Import a strategy in the Site List interface:

1. Right-click on the target Field Controller node

The target Field Controller is the controller to which the Imported strategy will be associated.

2. Inthe pop-up menu, select Import Strategy .

| Site List L |
=Y Sites
25 BACnetIP
El-2o BACnet Serial
{522 001 - Network
! LB
El-2g PL Office
D55 001- [ Wew ctri=N
E,E Impoﬁtrategy
EE Sample /

Select

The system will scan for suitable strategies for import

Impart a Strategy

And display a list of the results.

Impaort a Strategy

Cancel
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Note: It is possible that the list will be blank because a strategy file will only be listed if:
a. It does not reside in the current site.
b. It has the correct embedded site, BACnet Router address, and field controller address.
c. Itis not already associated with any controller.

You cannot for example import a strategy from controller number 806 on BACnet Router 5 on a
remote site onto controller number 005 on BACnet Router 5 on the local site. Neither can you for
example import a strategy from controller number 006 on BACnet Router 5 on a remote site onto
controller number 606 on BACnet Router 2 on the local site.

i.e. The file to be imported must have originated on the same controller on the same site.

3. Select a strategy file and click OK . The strategy will be copied to the current site, and the copy will be
associated with the selected controller.

OPENING MULTIPLE STRATEGIES

CXpro"'® allows you to have several strategies open at once. Each strategy must be opened individually as described
above. Each strategy can be minimized, maximized, and arranged in a number of ways in relation to the other open
strategies.

DOWNLOADING A STRATEGY

When you have created a strategy in CXpro"®, you must download it from CXpro"® to the targeted controller before
it will function.

Note: When downloading a strategy to a controller, CXpro"® automatically wipes the controller's memory
and sends set-up.

Note: The targeted controller should not be powered down for at least 40 seconds after a strategy write
has been initiated by any of the methods above.

To download a strategy to the targeted controller:
1. Open the strategy and connect to the controller

2. Download the strategy

Note: When you download a Strategy to a BACnet controller from CXpro"®, any configuration that has been
set by a separate B-OWS — e.g. an Alarm Recipients list — will be wiped. You must re-download

the Alarm Recipients list, and any other B-OWS specific configuration after the Strategy download is
complete.
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Open the strategy and connect to the controller

fa)

Select the target controller in the Site List and open its associated Strategy by double-clicking or selecting Open [

from the File menu or right-click menu. @

w

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon : %

V(i;.

== [
File - Home Controller Strategy

Properties I Modules | Strategy
Na\rigation Macros |:| Reopen
Sit
L:s: Page Names @ Search

Site Clipboard View

’ Co Eed @ Copy

5" Disconnect L?j Paste

Download the strategy
Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Contraller Strategy

%Communications lil DQWMQE% Ifgc-:m
% Controller )tE Wipe Controller S5hov
¥, BAChet 2 Auto Online

Confinuration

When you use Automatic Download, CXpro"® automatically deletes all previous points and strategies from the
controller as these could conflict with the strategy being downloaded. It then downloads the strategy and sends
the set-up (i.e. it informs the controller of the number of blocks it must service in the strategy).

While this is happening, the Downloading window is displayed.

Downloading *

Controller

Hardware Points _ ’T
Strategy Blocks _ W

Analog Setpoint Values _ ’W
Digital Setpoint Values ([N |14
gacnet Point Confia [N | 212

Sending BACnet data via file transfer...

| Abort |

The progress bar at the top of the downloading window shows the progress of the download, while the status box

(at the bottom of the window) tells which of the three stages in the download process (wiping the memory,
downloading the strategy or sending the set-up) CXpro"® is currently completing.

The Downloading window also includes a Complete box, which displays the number of the block of the strategy,

analog point or digital point that is currently being downloaded. In the above example, the progress bar shows
that the download is 79% complete, the complete box tells us that CXpro"® is downloading block number 251 of
the strategy and the status box tells us that CXpro"® is busy downloading the strategy to the controller.

Wipe the controller's memory

Wipe the controller’s memory by choosing Wipe Controller from the Controller tab on the Ribbon .
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e Controller Strategy

' 4ﬁ(:ummunicati:ms ' t Download

E’E.Compare

IQ(Iczuntrc;llrar T Wipe ﬁntroller @Show Comp

¥ BACnet 2 Auto Ofline

Configuration

i

This opens the Wipe Controller dialog box, allowing you to choose individual parts of the controller memory to be

wiped

r Clear Strategy [ Clear schedules
[ Clear Points
[ Clear Modem Strings

r Clear Keypad

[ Clear Hardware Point:

[~ Clear BACnet Data
INo change 'l

Murmber of datalogs

[~ Wipe All

Wipe Controller “

BaAChet Cptions.., |

Current 5tatus
’7 Idle

Wipe | Close

Click Wipe to close the Wipe Controller box.

CXpro"® will display a message to confirm that the controller’s memory has been wiped. Click OK to close the

message box.
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e How to check the controller type to which you are downloading

(@]
=
To find the type of the controller to which you are downloading, open the Strategy Details dialog by clicking on g
o B . =3
Strategy Details in the Strategy tab of the Ribbon @
@)
o
r Strategy =3
. F 8
C = BACnet Paint: —-
@ opy E net Points E E ®
[F) Paste & BaCnet Units @
= Add [fle} Reorder —Strategy | Viev
Text Terminals Modules D_EES“"’“%DW“S Help Macr
Clipboard Strategy
Strategy Details X
Display Number | Type ~
Comparator
New Line 2 BACnet Schedue
Strategy Blocks i ab::j:rlnLEanalue
5 Analog Gate
Controller Limits & Limit to 0 or 100
Resources 7 Rounding
8 Integer Constant
Paints Manager 9 Real Constant
10 VAV Differential Pressure
Reorder Modules " BACnet Schedule
12 Holiday Schedule
BACHet units 13 Time Schedule
14 Comparator
1/0 Terminals 15 Hysteresis
16 Timer with Constant Inputs
17 Not Used
18 Real Constant
19 Adder/Scaler 4

I~ Show used blocks only

0K I Cancel Apply

Click the Controller Limits tab.

Strategy Details X
Display Cortroller Type lw

New Line Number of Madules per Strategy IW

Strategy Blocks Number of Datalogs per Strategy qu_

Controller Limits
Inputs Cutputs

Resources
Universal Inputs 16 Universal Outputs 0
Digital Inputs 0 Digital Outputs 0
Analog Inputs 0 Analog Outputs 0

Points Manager
Reorder Modules

BAChet units

170 Terminals

Vanable 10 [15

0K I Cancel | Apply |

In the example shown, the Controller Type box shows that the selected controller is a CBX-8R8 controller.
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Edit the strategy

Edit the strategy by placing and joining the required modules on the drawing area and editing their values and units.

Download the strategy
When you have completed the strategy, you must then download it.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

=0 s

File - Home Controller Strategy
Properties Modules EE Strategy

’ Ccﬁed @ Copy
b” Disconnect LEPasle Navigatiun Ma(ms I:‘ Reopen

_____ Site
i_iSelect All List Page Mames @ Search

Site Clipboard View

Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Controller Strategy

‘&Communications li‘l Download @Compare
IaCmﬂ:mller ’t}Wipe Controller Show Compare
% BAChet & Auto Online

Configuration Ope

A warning is displayed:

CXproHD

‘Warning: Downloading will wipe the controller and cycle the outputs.
Continue? / ls

Mo |

[~ Do not ask me again during current session. Yes

The Downloading window will appear, to display the progress of the download.

Downloading X

Contraller

Hardware Paints ,ﬁ 16
Strategy Elocks ’ﬁ 500
Analog Setpoint Values _IF
Digital setpoint Vaiues | RGN 54
BACnet Point Contig || 212

Sending BACnet data via file transfer...

Close | Abort I

When CXpro"P has downloaded all the blocks that you specified, it will automatically close.
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STARTING A STRATEGY (SENDING THE SETUP)

When the memory of a Field Controller has been wiped and the strategy has been downloaded to it, the Controller
must be told how many blocks are to be serviced. This is called the Setup of the Strategy. Sending Setup is also
referred to as starting the strategy. If you are using Automaticdownload, CXpro"® sends the Setup automatically when
you download a strategy to the controller. (See Error! Reference source not found. on page Error! Bookmark not
defined.) Otherwise, you must send the Setup as described below.
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Select the Controller in the Site Tree , and connect to it by clicking on the Connect button in the Controller tab of

the Ribbon
File - Home Controller Strategy
’ onnect %Communications t Dow
g" connect "_'g Controller ) Wipe
¥ BACnet £ Auto
Site Configuration

Open the Controller Configuration dialog by clicking on Controller in the Controller tab of the Ribbon

ne Controller Strategy
"&Communications I‘ﬁ Download
ct %Cogoller ’BWipe Contr

#, Bachet 2 Auto Onlin

Configuration

Controller Configuration

Mumber Of Strategy Blocks To Service m Send
Last Composed Strategy Last Modified Receive

Time |14:00:16 = Date |10/08/2018 =— Time |1—‘1:C'C':1E- = Date |10/08/2018 —

User ID

User Name
Drawing Reference

Strategy ID

Min Service Time

1771

Time Synchronisation Wait After

Current Status
Attention ! Error receiving setup.

Clase

The number in the Number of Strategy Blocks To Service box, X (which is automatically entered by CXpro*"® but can be
changed by the user), activates the first X blocks of the strategy in the Field Controller. This number, X, must be
greater than or equal to the number of the highest numbered block used by the strategy. Otherwise, the parts of
the strategy which occupy blocks with a higher number will not be serviced, and their point values will not be
updated, which may cause the strategy to fail.
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Note: If you cannot see how many blocks you have used in the strategy, open the Strategy Details dialog
by clicking on Strategy Details in the Strategy tab of the Ribbon

r Strategy
£ copy I E A & BACet Points | |E
[F) Paste & BACnet Units
- View | Add s} Reorder —Strategy | View
L.jSelect All | [pModules| Text Terminals Modules Dﬁstrate%Detalls Help | Macr
Clipboard Strategy
Strategy Details X
Display Humber | Type s
1 Comparator
New Line 2 BACnet Schedule
Strategy Blocks i ’:’Ibai?’_li:nvalue
Controller Limits 2 E‘:nlutg g‘:ﬁ w0
Resources 7 Rounding
8 Integer Constant
Points Manager 9 Real Constart
10 WAV Differential Pressure
Reorder Modules " BACnet Schedule
12 Holiday Schedule
BACRet units 13 Time Schedule
14 Comparator
1/0 Terminals 15 Hysteresis
16 Timer with Constant Inputs
17 Mot Used
18 Real Constant
19 Adder/Scaler 4

[~ Show used blocks only

OK | Cancel ‘ |

The Strategy Blocks tab lists all blocks in the targeted controller. The highest block number that is
marked as used is the number of blocks the controller must service.

The Last Composed section of the Controller Configuration dialog automatically contains the current PCtime and date.
If the strategy is uploaded later, this time and date will indicate when the strategy was started.

The User ID parameter allows the application engineer to enter a unique identifying character. If the strategy is
uploaded later, this number will indicate who started the strategy.

In the User Name field, the engineer can enter the name of the person that started the strategy and this can be

retrieved from the controller if the strategy is uploaded. A string of up to sixteen characters can be entered in this
field.

In the Drawing Name field, the name drawing can be entered. It is recommended that the name of the drawing

containing information relevant to the strategy is stored here. If the setup is uploaded from the controller the drawing
name will be displayed in this field.

The effects of sending the setup
Sending the setup to a controller has the following effects:

e All blocks entered in the Number of blocks to service section will be serviced, even if they are not occupied

by modules. For example, if you entered 100 as the number of modules to be serviced, the first 100 blocks
will be serviced by the controller.
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e A controller that is sent a setup with blocks to be serviced, but without any strategy, will not send any output
signals and will not read any input signals.

Note: If a strategy is downloaded after setup is sent, the strategy is serviced immediately. This means the
outputs will receive values from the strategy immediately after downloading. It would be preferable
to download the strategy before sending setup since untested strategies can cause problems in
devices connected to the outputs if the output values are unstable or incorrect.
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e  Output points of modules that occupy serviced blocks take their values from the module.
e [f the controller is running without a network (stand-alone), the green LED is constantly illuminated.

e If the controlleris running on a fieldbus (connected to a BACnet Router), the green LED flashes with regular
pulses.

e Analarm appears on the monitor of the connected PCif the alarm feature is active.

e The keypad program, if one exists and has been downloaded to the controller, will be started.

MANO133 rev 15 © Cylon Controls Ltd. 133



an04dxD

TESTING A STRATEGY WITH SCAN MODE

It is important to test a strategy at various stages in its creation, to check for mistakes or faults in its design. This is

done by using Scan mode .

Preparing to test a strategy

To test a strategy the following conditions must be satisfied:
e The strategy must be open (see How to open an existing strategy: on page 122).

e The strategy must have been sent to the controller (See Downloading a strategy on page 126).

Note: Make sure that the downloaded strategy and the open strategy are the same.

e  The strategy must have been started (see Starting a strategy on page 131).

How to test a strategy

In Scan mode, CXpro"'® allows you to view the changes in values in a strategy as the strategy is serviced in the controller.
This is useful for testing strategies and parts of strategies for correct operation. In Scan mode , the point values of an
uploaded strategy are read by CXpro"®, displayed next to their respective inputs/outputs, and updated in real time.
To activate scan mode:

e Open the strategy and Connect to the controller by clicking the Connect button on the Strategy tab of the

Ribbon
e Display the strategy's point and constant values (page 135)
e Setthe Scan mode (page 135)

e Activate scan mode (page 136)

In scan mode, the variable point values of a strategy are updated in real time as they are serviced by the strategy
and displayed clearly in the module symbols on the drawing area. In the Rescale to 0 or 100 module of the example
above, the values of the 3 input points were changed to 10, 20, and 149.86, and its output was changed to 100
as they were serviced by the strategy.

e  Watch the changing values of the modules in scan mode to ensure they are being serviced correctly by
the controller.
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How to Display the strategy's point and constant values

Display the point and constant values of the strategy by right-clicking on the Drawing Area and select Display Options
> Display Labels > Show Value Only (simulation)
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i || Display Options 4 Display Lines 4

Display Labels 4 Hide

Show Number

Show Mame

Show Valtr.\e\ Only (simulation)

Setting the Scan mode

CXpro"'® can scan either the current active strategy or all of the currently open strategies. To set this, open the
Applications Settings dialog by clicking Communications in the Controller tab of the Ribbon

Contraller Strateg
*4, Communications |

% Controller 7?
&, BACnet L

Configuration

Select the Scan Options tab in the dialog, and select either the Scan Active Strategy or the Scan all Strategies radio

button.
Application Settings >
| Download Options [ Strategy Scan
— ¥ Scan Active Strategy
Scan Options
" Scan all Strategies
Strategy Settings
i BACnet Properties
BACnet Configuration Time Between Scan (s) laﬂ—
Serial Port Connection

Commands

Livelog

QK Cancel Lpply

Click OK to close the dialog.
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Activate scan mode

Begin scanning by clicking Scan in the Controller tab in the Ribbon .

g

Controll

ler

Strategy

‘a Communications Iil Download |_—7é| Compare % Version r{ Board Diagnostics | 1 | 1
"3 Controller )ﬁ Wipe Controller Show Compare % Time and Date I'_.'_| Statistics o‘ ®
. I, . ] . O Sean | Overridt
% BACnet [ Auto Online Maximums @ Lock and Unlock % Point
Configuration Operations
—

The CXpro"® window will change to the CXpro"® scan mode window, hiding the Site List , displaying the Page Names

pane and disabling all of the Ribbon items except the Scan button

Operations Testing Keyosd
. Page Names +0

Verdying Madue 3

A+ X @ ShowPageNumbers On Drawing
Page Number | Page Hame

Al

There are na items to show in this view.

e

=T ]
omE lal

Connedted ta: PL Office 4, Remote - BACnet. | L 100 num

To deactivate scan mode, i.e. to stop scanning the point values of the strategy, click the Scan button again.

Suggestions for testing strategies

If a number of modules are selected in the strategy when Scan mode is activated, then only those modules
will be scanned.

The module to be tested must have been downloaded to the controller. That is, the Block number of the
module must be within the range of modules which were downloaded to the controller (see Downloading
a strategy on page 126)

A strategy should be tested in small steps during the creation process. Simple faults such as selecting the
wrong module or joining to the wrong inputs and outputs can be difficult to correct in a finished strategy.
There is also the danger that faults can result in other faults appearing in different parts of the strategy or
in other controllers.

At the end of the creation of a strategy, the whole strategy should be tested again. This prevents later
problems and time losses during the setting-up process in the site.

The strategy should be checked module by module from left to right, starting with the hardware inputs
and finishing with the hardware outputs.

Individual strategy parts can be functioning correctly themselves but cause problems when connected to
other correctly functioning strategy parts. For example, the direction of analog values may fall in the range
of @ %to 100 % or the range of 100 % to @ %. Digital values and their inversion may also cause confusion.

Test a strategy before copying it or using it in another controller. Otherwise, all copies of the strategy will
also have to be tested.

Manually overriding hardware points allows simulation of each environmental situation to which the
strategy would be exposed.
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SECURING CBM DATA

Unlike other BMS controllers, in the CBM Strategy information can be secured against accidental loss or
unauthorized modification by password-protecting the ability to view or edit strategy information and system
information.
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How to password-protect a range of blocks in a CBM strategy

To lock a range of blocks in a strategy, select Lock and Unlock from the Controller tab of the Ribbon .

Controller Strategy
JQ(Zommunications Ii"l Download E’élCompare ‘%Version "T'\Board Diagnostics r
% Controller ’QWipe Controller Show Compare % Time and Date "_.j Statistics 1
% BACnet ltl‘ Auto Online Maximums | :.' LockEnd Unlock |
Configuration Operations

This opens the Lock and Unlock dialog

Lock and Unlock

Lock
Enter Password |

Unlock

Current Status
Idle

[ g

Close

Enter a numerical password (note: the Enter Password field will only accept numbers) and click Lock

Lock and Unlock

Lock
Enter Password | ****

Unlock

Current Status
Idle

A

Close

The Lock Blocks dialog opens. Specify the start and end of the range of blocks that will be protected:

Lock Blocks

Enter Start Block

12 =]
Enter End Block 3&
oK | Cancel |

Click OK to close the Lock Blocks dialog

When the lock command has been received by the controller a confirmation message is displayed in the Lock and

Unlock dialog.

All of the strategy blocks within the specified range are now locked, and cannot be accessed until they are unlocked
using the password set above.
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How to access locked strategy blocks

If a range of strategy blocks in a CBM controller have been locked, it is only possible to access, view, and edit them
by first unlocking them, using the password set during the locking process.

To remove password protection from a locked range of strategy blocks, select Lock and Unlock from the Controller
tab of the Ribbon .

Controller Strategy

4ﬁCommunications Ii"l Download E’éCompare 1%\-"ersion "T{Board Diagnostics r

I%Cor‘ltmller ’mWipe Contraller Sh-:wC-Jmpare %Time and Date 'ﬂstatistics 1

% BACnet Ii"l‘ Auto Online Maximums | :.' LockEnd Unlock | &
Configuration Operations

This opens the Lock and Unlock dialog. Enter the required numerical password (set during the locking process) and

click on Unlock .

Lock and Unlock

Lock |
Enter Password I waxa]

Unkock |

Close I

Current Status
Idle

When the blocks are successfully unlocked in the controller, a message is displayed in the Lock/Unlock dialog.

The strategy blocks are now unprotected and can be accessed from CXpro"® as normal.

138

© Cylon Controls Ltd. MANO133 rev 15



HOW TO EXPOSE POINTS ON A BACNET SYSTEM

When the Strategy has been configured for a controller that is part of a BACnet Site, the points within the controller
that are to be available to the BACnet system must be specified by selecting BACnet Points from the Strategy tab of

the Ribbon

(@]
=
]
)
=3
=}
]
w
o+
=
Q
-
(1]
@
1]
7]

oller Strategy

s LB [T
IE| Paste

E AR r. BACn Pmnts E D
& BACnet Units

d | o View Add 10 Reorder Strategy | Wi
["iSelect All | podules Text Terminals Modules & Strateqgy Details Help Ma
er Clipboard Strategy
L A P

The BACnet Points dialog opens, listing all of the points used in the Strategy:

| BACnet Points >
| - Select BAChet Points
| BACnet | Export | Point Name |_Point Addr_| Point Type |
O Room Setting 5 Analog Setpaint
| O MaxHWater 23 Analag Virtual
O Adder/Scaler Block 19 Output 29 Analog Virtual ‘
O WeatherCom Block 8001 Inpu 30 Analog Virtual
O Heating Water Temp 2 Analog Input
O Temperature 3 Analog Input
O Alarm Enable 2 Digital Setpoint
O DigVirt_3 E Digital Virtual
Im} Schedule No. 1 {On) 4 Digital Virtual
O Hysteresis Block 15 Active High 9 Digital Output
~BACnet Point Usage———————————— [~ Binary Unit String Usage

Maximum BACnet iu‘;
Used BACnet i 10

Maximum Binary Unit 132
Used Binary Unit ;3

Available BACnet 214 Available Binary Unit ;29
Export Total ig

i—Setpoint Limits
Max Unexposed Setpoint and BACnet 324 Unexposed 0
Available Setpoints / BACnet Points 314

Resolve Duplicate Point Mames i

oK i Cancel i |

Tick the checkbox beside each of the points that are to be exposed, then click on OK .

Note: In BACnet, the point name must be unique. In the Cylon BACnet system, they may not be unique, so
some duplicate names may appear in the list. If this is the case, click the Resolve Duplicate Point

Names... button.
This opens the Resolve Duplicate Point Names dialog, where names can be changed.

Note: The BACnet Points dialog also includes columns of the checkbox to identify points that should be
included in any export to ASPECT® / INTEGRA™ — see ASPECT® / INTEGRA™ Export on page 210.
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HOW TO VIEW BACNET POINTS FROM A CONTROLLER

You can view BACnet points from a Controller by selecting Upload BACnet Points on the Controller tab on the Ribbon

ne Controller Strategy
‘ﬁcammunications ﬂ-‘ Download f’é.cumpare E:',Version "T'\Board Diagnaostics | 1 I 1 = F&Li\reLog Setup =
ct IE Controller ﬁWipe Controller E Show Compare % Time and Date I'_.'_| Statistics o" ® LE‘B LiveLlog Report I
o~ O o Scan  Override Livelog g ————————— |nterfz
ﬁ BACnet M Auto Online = Maximums @ Lock and Unlock Paint 'f Upload BACnet Points g1
Configuration Operations Testing

This opens the Controller BACnet Points dialog. The points are automatically uploaded so that they can be viewed,
and the dialog shows the progress of the upload and the points that have been uploaded:

Controller BACnet Points le

Uploaded BAChet Paints

Paint Mame |F’ointAddr‘ Paint Tupe | Active Unit | Inactive Unit |

Status
Uploading BAChet paint 41 of 225
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SECTION 7 : NAMING OBJECTS
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WHY OBJECTS ARE NAMED

Objects in the Cylon system, such as controllers, points, time schedules, datalogs, etc. are given names to make
them more identifiable. For example, it is easier to recognize a datalog named “Water Supply Temperature” than
one named “datalog_1", which is the default name of the first datalog used inside a controller, automatically given
by the database.

RULES FOR NAMING OBJECTS

When naming an object in the system, the following rules should be remembered:
e Names inside a controller must be unique.
e Names can have a maximum of 24 characters.
e Allalphanumeric characters are permitted, except commas.
e If the name of an object in a controller is changed to a name that already exists in that controller, the
name of the original object will be deleted.

PROCEDURES FOR NAMING OBJECTS

The following list contains some of the objects in the system that can be named:
e Sites
e  Field Controllers and BACnet Routers
e  Points (both hardware points and virtual points)
e Datalog and Time Schedule modules

NAMING POINTS

Types of point

There are three main types of point in the Cylon system:
e A hardware point is an input or output of a Field Controller.
e Avirtual point is used to save internal information for a controller.
e A setpoint is a type of virtual point, but its value is constant, whereas the value of a virtual point is
determined by the strategy.

Hardware points, virtual points, and setpoints can be either analog or digital.

How to name points

Only hardware and setpoints can be named in CXpro"®. Virtual points are identified by their block numbers. The
procedure for naming or changing the name of a set point is the same as that for a hardware point. A brief summary
of the procedure is presented below. (For a more detailed description of how to name a point, see Defining
hardware points on page 83)

e  Open the strategy.

e Select the Point module on the drawing area that is to be named or have its name changed.

e Enter or edit the text in the Name field of the Properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

The Database Interface module can be used to enter/edit/delete names of hardware points non-graphically.
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Virtual points which are placed in a strategy as digital setpoints or analog setpoints are points which are controlled
from outside the Field Controller . The name of such a virtual point should indicate how its value is passed to it. The

following table illustrates this:

Setpoint name How to set point value is controlled
Controlled by 3rd party block
Controlled by 3rd party block

=z
Q
3
>
5
o
=
I}
(o]
—
1%

Outair Temperature_LG

Room Temperature_WG
Can be changed via the keypad

Can be changed via PC (B-OWS)

Set point_KP
Gain Factor_PC

NAMING FIELD CONTROLLER TIME SCHEDULES

Controller Time Schedules are saved and serviced just like modules in a controller. Naming Controller Time
Schedules make it easy to locate them for editing, either using the PC, supervisor software, or a keypad.

How to name a Field Controller time schedule

The procedure for naming or changing the name of a Controller time schedule is defined below:

e  Open the strategy.
e Select the Point module on the drawing area that is to be named or have its name changed.

e Enter or edit the text in the Name field of the Properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

When naming the schedule, it is a good idea to indicate the module’s function. For example, if the module is a
time schedule for the heating system of the site, and is set for Monday to Friday only, the module might be named
“Heating Schedule (Mon to Fri)”.
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NAMING DATALOGS

Datalogs are saved and serviced just like modules in a controller. The contents of a Datalog can be viewed and analyzed
using the Datalog Manager module. So that they can easily be identified by the Datalog Manager, they are
automatically given the same name as the point that they are logging. They are given this name when the point is
connected to the datalog. In the Reports program, datalogs can be configured and archived.

How to name a datalog

Datalogs are automatically named as soon as they are connected to a point:

Open the strategy that contains the datalog.

Detabg i

N Datalog_1

" [ Anakg inpt
5 Digitzl inpt

0 Enable

) Log trigger

Datlg numban 1 Updas

- [intzrval 500; Link: O Datzlog

. |Trioger Options: Ay Edgs; Deha:
1.00; Bxtended length: 0

‘Anclog Input 3
Temperature

Al

Heating Enable

o Sl . . . .]
D»lerﬁdeE‘J . . ]

" |On level 2.00; OF leveli 4.00

Join the datalog to a point by clicking on the point to be logged, and dragging to the Datalog’s input:

Detabg i

~ Datalog_1

o “Analog nput
: ‘%igna\ input

©/ Dbk

[ Eiegwigeer

Datalog numbern: 1; Update

+ [int=rvak 500; Link: & Datalog
Triggr Options: Any Edgs; Deha:
1.00; Bxtanded length: 0

g

‘Anclog Input 3

Digital Output
Al remperarure

Heating Enable

Paint
Overidz 0

" |On level: 2.00; Off level: 4.00

The name of the Datalog is changed to the name of the point and displayed in the Datalog module in the strategy.

Databg T

g —
el Anzlog mput
| Digil input
: Enabl

|5 Log trigger
" |Dataleg numbsan 1: Update
- [interval: 500; Link: 0; Datzlog
Trigger Options: Any Edge; Deka:
1.00; Bxtanded kength: 0

“Anlog Input 3
Al remperanure

S
}ng” "

If you want to modify the name that is automatically given, you can edit it by selecting the datalog module and

Heating Enable

On level: 2.00; OF level: 4.00

editing the Name field in the Properties pane.

It is a good idea to give an indication in the name of what part of the site the datalog belongs to, but it is not
necessary to indicate in the name that the module is a datalog, as it will only appear in list boxes allowing the
selection of a datalog. Names that are given to only speed up the copying of strategies (for example, “Temp.
Channel 1”, “Temp. Channel 2”, “Temp. Channel 3”,...), and to save time for creating dynamic graphics, are not
helpful for the end-user.

Choose Save from the File menu to save the changes made to the strategy.
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MACROS - OVERVIEW

If your work in CXpro*"® involves creating the same or similar strategies repeatedly, you'll find Macros useful for
reducing the time involved in these tasks. A Macro is a set of strategy modules grouped together into a single unit.

Macros and Macro Templates

A Macro Template is used to create a macro within a strategy. It is a definition of module types and connections,
and when it is inserted into a strategy a new Macro is created containing new instances of those module types
connected together to match the Macro Template.

e Each time a Macro Template is inserted into a strategy, a new Macro is created.

e Each Macrois an instance of a Macro Template, but a strategy can contain multiple Macros that are based on
a single Macro Template.

e  Macro Templates can be stored, and copied between strategies and controllers.
e  Each Macro can be configured and adjusted independently of the Macro Template used to create it.

e When a Macro Template is saved, it acts as a CXpro"® module.

Example: An “Adder” macro.
An Adder/Scaler module accepts four inputs 2, B, C and D, and operates according to the equation
Output = A*C + B*D
It can be made into an Adder, which operates according to the equation
Output = C + D

by ensuring that its A and B inputs are always set to 1. This can be done by connecting a Real

Constant module to the A and B inputs as shown below.

R Real Constant 1 AdderiSealer 13
bt
AW
Outpart A € 3 6 € Input A Output £3
Output B 63 € Input B
Gonstant A 1.00; Constant B: .00 |~ ° ° [@ InpncC
R

This combination of modules can be saved as a Macro Template and reused whenever an adder is required.
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MACRO STRUCTURE

Macro Templates are stored in CXpro"® in groups and sub-groups. A maximum of 10 Macro groups can be created.
Each Macro group can contain 20 sub-groups and each sub-group can contain up to 100 Macro Templates. In total,
20 000 Macro Templates can be created and stored in CXpro*®.

For example, you may want to store all Macro Templates relating to heat control strategies in a group called Heat.
This group may contain a sub-group called Boiler, which would contain Macros for boiler control strategies, such
as Optimizer, Heating Curve, etc.

c
2.
S
o
<
Q
(o]
=
o
(7]

MACRO DESCRIPTION (HELP) FILES

A Macro Description File is a Help file generated by the person who created the Macro Template and is associated
with the Macro Template (it is opened by right-clicking on the Macro button). It is normally used to describe the
function and usage of the Macro Template.

When a user right-clicks on a Macro in the Macro property window, CXpro"® opens the editable description file
associated with that specific Macro Template. If none exists, CXpro"® opens a blank text file, which when saved will

be associated with that Macro Template. This file can be used to provide documentation about how the Macro should
be used or to record history, author, or changelog details for the Macro Template.

The program used by CXpro"? to open the history file, e.g., MS Wordpad, must be specified in the
C:\CXproHD\System\wn3000.ini file under uClé6et.
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HOW TO CREATE A MACRO TEMPLATE

There are a number of steps involved in creating a Macro Template:

Create the strategy.

Add modules to the Macro Template.

Select the inputs and outputs for the Macro Template and change their names if required.
Set names for each of the points within the Macro Template if required.

Choose a Macro group and sub-group and give the Macro Template a name.

Choose whether to insert the Macro Template into the active strategy as a Macro.

Save the Macro Template.

N o Uk W e

The following guide to creating a Macro uses as an example a typical strategy that you might want to save as a Macro
—a “weather compensator” strategy. As an exercise in creating Macros, you may want to follow this guide, using the
weather compensator as an example.

Create the strategy

Create the strategy or part of a strategy on which you are basing your Macro Template. (If you are forming your Macro
Template from an existing strategy, then open that existing strategy).

Example — Weather Compensator macro

For example, if you were to create a Macro Template from a weather compensator strategy, you
would place two Real Constant modules and two Rescale to 0 and 100 modules on the drawing area
and join them as shown below:

The third input of the first Rescale module ( Rescale to 0 and 100 ) is to be the input of the Macro. It
is marked Outside Air Temperature in the diagram below.

The output of the 2" Rescale module ( Rescale from 0 to 100 ) is to be the output of the Macro. It is
marked Flow Temperature Setpoint in the diagram below.

: __Weather Cum ensator -
0 ... 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 ... 80 °C

A=B0, B=20 o
R Real Constant = 18 T Rescake from 010 100 &
A=20, B=80 I KA, I .
R Real Constant 7 Output A g 7| Lower Limit A Outpart £ Flow
A" - Output B &= —5]& Uppar Limit B _Temperature
mp__n,q@.n. [Constant A: 80.00; Constane B: 2. =€ Input Setpolnt
Output B ] (FTS)
Gonstant A 20.00; Consant B: 2. C u}m Rescale to 0 and 100 20 R
1T €3 Lowveer Limit A Output 3 |
5| Upper Limi B
Outside Air Temperature (OAT)[S I

Rescales input temperature
sothat 0 ... 20 °C becomes 0 ... 100
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Select the modules for the macro

The next stage in creating a Macro is to select on the drawing area the modules and any text that you want to be
included in the Macro. Selected modules are marked by red squares around their edges.

To select the modules for the Macro, you can drag the mouse from the top left-hand corner to the bottom right-
hand corner of the strategy to draw a box around the entire strategy so that each module and its inputs and
outputs are selected. It is not a problem if, when drawing the box, you included some unwanted modules — they
can be easily removed at the next stage.
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‘Weather Cum ensator
0 20 °C Outjlde Alr Temperature is mapped to a Flow Temperature Setpomt of 20 0 °C

A=80, B=20 o
R Real Constant = m/u Rescle from 00 100 =2
A=20, B=80 o N T o
R Rzl Corstant 2 Outpm\Ga aQLcmsrLi'nitA Output £ Flow
Y o Output B ) pr———7|@ Upper Limit B Temperature
mp_,t,q@ﬁ. Constant A: 80.00; Constant B: 2.. {3 Input SBtPOII'It
Output B € fro (FTS)
Gonstant A: 20.00; Constan: B: 2. " [T 10 Resckto0and100 2 C
=TT & Lower Limit A Outpat &
77| Upper Limit B
Outslde Air Temperature (DAT) S Input
| |np||+ p s
sothat0..20°Cbecomes0..200

. Weather Cumpensatur . .
ﬂ 2[] °C Out5|de Alr Temperature is mapped to a Flow Temperature Setpmnt of 2[] SD_“C_

Real Constant =] 90U Rescalefrom Do 100 21
A - H . . . . . . . [ A .
R Real Constant = Output A € € Lower Limit A Output Flow
Ay Output B € € Upper Limit B Temperature

owrol  lemmaneesr]  mows setpoint
WP“&‘q_. . - T

(Gonstant A: 20.00; Con B 100 RescaletoQand 100 20

L) a
:[ 9 Lower Limit A Output 3 e
T £ Uppsr Limit B

‘Dutside Air Temperature (OAT)[& e | )
Rescales input temperature
5o that 0 ... 20 °C becomes 0 ... 100
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Add the selected modules to the Macro Template

Select Create from the Macro section of the Strategy tab on the Ribbon .

er Strategy

Q £ copy E = BACnet Points E Rose | %

8 Lﬁpaste .l= BACnet Units Marager ’
T — View Add [l{e] Reorder  Strategy View = Start/Paus
5] UiSelect Al | Madules Text Terminals Modules 1o Strategy Details Help Macros | [ Save New

Clipboard Strategy Macros

This will open the Add Modules to Macro dialog box, in which all of the modules that you selected for the Macro
Template will be listed.

Add Modules to Macro

Modules Selected for Modules Added to
020 Rescale to 0 and 100 -
021 Rescale from 0 to 100 -
022 Real Constant

023 Real Canstant s
1025 OQutside Air Temperature (OA

1026 A=20, B=80 <
1027 A=80, B=20

MOTE: Hardware modules can not be pes— = \
added to Macros. ontinue... ancel |

Note: A Macro cannot include hardware points, so if any were included in the selection they will not be
listed in the Add Modules to Macro dialog.

Note: If you click the macro button or macro menu without first selecting the modules for the macro,
you will be prompted to do so with the following error message:

Cylon Engineering Centre

1, Plesse select the modules for the macro

Select the modules in the left list box that you want to include in the Macro by holding down the [Ctrl] key and
clicking each one with the left mouse button. The selected modules will be highlighted.

Add Modules to Macro

Modules Selected for Modules Added to

020 Rescale to 0 and 100
021 Rescale from 0 to 100

022 Real Constant
023 Real Constant
1025 Outside Air Temperature [O&

1026 A=20, B=80 < |
1027 A=380, B=20

MOTE: Hardware modules can not be Continue Cancel
added to Macros,
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Note: For illustration, only the functional modules have been selected in this example. It is also possible
to include text in a Macro Template for clarity.

Add the selected modules to the Macro Template using the following buttons:
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Add a selected module or several selected modules to the Macro Template
Add all modules to the Macro Template
Remove a selected module or several selected modules from the Macro Template

Remove all modules to the Macro Template

This Add Modules to Macro list box displays all the modules that have been added to the Macro Template. If you add

a module or modules that you later decide you do not want, you can remove that module or modules from the
Macro Template using the remove buttons (see above).

Add Modules to Macro

Modules Selected for Modules Added to

020 Rescale to 0 and 100 020 Rescale to 0and 100
021 Rescale from 0 to 100 021 Rescale from 0 to 100
022 Real Constant 022 Real Constant

023 Real Constant
1025 OQutside Air Temperature ([OA&

1026 A=20, E=80 < |
1027 A=80,B=20

023 Real Constant

MOTE: Hardware modules can not be o | - I I
added to Macros. ontinue... ancel

In this example, all 4 modules of the weather compensator strategy are required for the Macro Template and so
they are added to the list box on the right. The text has been excluded in this case but could be included for extra

information.

Click Continue... when you have added the required modules to the Macro Template.
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Define the Macro Inputs, Outputs, Group and Name (the Create Macro dialog box)

Pressing the Continue.

an04dxD

Create Macro *
~
""" R Rzl Consmant = © [ T ResmEfomOwing = ’
Y )
R Real Constant = Output A G 5 751 Lower Limit A Ourpan €
Y o Output B ) fo=—T7|(O) Upper Lim: B o
NM*\GK A 0.00; B: 0.00 I3 Input
Output B ) fr=
[A: 0.00; B: 0.00 ) T 00 Resmlewmianail0 =) | oo
..... A a . . . . . . . . . .
T Lower Limit A Output €
..... {6 e i ® S S
€& Input
o S S v
< 3
[ Macro Inputs/Outputs [ Macro Grouping
|
Inputs Outputs
| Name
!
| Group |Legacy Macros vl
|
Click a Module node to add Input Click a Module node to add Output Sub Group | Wet Systems :l'
Macro Manager...
|

Macro Point Configuration |

I Insert into strategy on save

Save Cancel |

.. button in the Add Modules to Macro dialog will open the Create Macro dialog box:

The Create Macro dialog shows the four modules that were added in the Add Modules to Macro box and allows you
to edit input and output names, create Macro groups and sub-groups and create a history file to record any changes
that may be made to the Macro Template later.
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Define the inputs and outputs for the macro

This step refers to the Weather Compensator example (see page 148).

c
When you click on a module output or an unconnected module input in the drawing area of the Create Macro [
o
dialog, it is highlighted on the drawing area and added to the relevant Macro Inputs or Macro Outputs list at the =
. (o]
bottom of the dialog. g
1%
Create Macro Create Macro
R Real Constant Bl [f09° & Rescale from 0 100 2% R Real Constant Bl 100 & Rescale from 0w 100 20
A R ~ 2
R Real Gonstant = [ om=ag 6 Lower LimiA] Outour 3] R Real Constant = [ oapan 7| Lower Limit A] Oup{
N | ompuEq) & Upper LimiB | 2V C TS — & Upp=r Limit 8|
st Gl [Corstont & 0.00: Concart 5.0.0 | T e ADhy  [ConmamAi0.00; Consam B 0.00 - s
oG Esmmmessmel ==
Gonstant A: 0.00; Conswr B: 0.00 T 100 Resmk002nd 100 Gonztant A: 0.00; Gonaant 8 0.00 T 100 Resmlew0and 100 5
11A L;«elenAl s el . .
T Upper Limit B
7 npu
Macro Inputs/Qutputs Macra Grouping Macro Inputs/Outputs Macro Grouping
Inputs Outputs Inputs Qutputs
003 Uppe Change Name Change Name . ooz Upee Change Name 004 Inpu Change Name =
— & r— r G
Change Change Sub Gro Change Change Sub Gre
Macro Point Canfiguration [” Insert into strategy on save Macro Paint Configuration [ Insert into strategy on save

Note: If you click on a connected input, an error message will be displayed: “Cannot select a module
input that is already connected to a line.”

Note: The number beside each module input is the Node number and does not relate to the module
number.

Note: The default name for node 3 in the illustration is “Inpu”, but this can be edited - see Change input
or output label if necessary on page 154.

To remove an input or output that has been added to the Macro Template, click on it in the drawing area. The
input/output will then no longer be highlighted in the drawing area, and it will be removed from the relevant

Macro Inputs or Macro Outputs list.

You can rearrange the order of the inputs or outputs to the Macro, by clicking on an entry in the relevant Macro

Inputs or Macro Outputs list and dragging it up or down within the list.

MANO0133 rev 15 © Cylon Controls Ltd. 153



an04dxD

Change input or output label if necessary

By default, the text that will be displayed on the Macro module as a label for each input will be “Inpu” and for each

output will be “Outp”:

O
- test

© Inpu | oup &

but these names can easily be edited.

To edit a Macro input or output name, select the
input/output name in the relevant list box

Type a new name in the relevant Name edit
box and press [Enter].

An input or output label can have no more than
10 alphanumeric characters.

Outputs

Outputs

005

154
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Name and group the Macro

In order to use a Macro Template that you have created, you must give the Macro Template a name, and assign it to
a Macro group so that it can be accessed from the Macro bar .

e Macro Name

c
2.
S
o
<
Q
(o]
=
o
(7]

In the Macro Name box, enter a name for the Macro Template.

The name provided here will appear on the Macro instance when it is displayed on the drawing area. It can have
up to 63 alphanumeric characters.

In this example, the name given to the Macro Template [2EiE F e
is “WeatherCom”.

Mame WeatherCom|
Group |Cylon Macras v
Sub Group |BACnet =

Macro Manager...

Note: The following names cannot be used when naming a macro, because they are used to indicate
Inputs, Outputs, constants, etc. internally within CXpro*®:

pi (n) where n=anumericvalue in the range 0-9
po (n) where n=anumeric value in the range 0-9
sb

c (n) wheren=anumericvalue in the range 0-9

bc

When the Macro Template is named, choose a Macro group and sub-group for it

e Macro Group and Sub-Group

From the Group box, select the group to which the Macro Grouping

Macro you are creating will belong. MName |WeatherCom

Yy 8 8

The Macro Group chosen for this example is heating. Group |Cylon Macros =
H Cylon Macros

If no Macro Group exists, you must create a new group Heating S

(see How to create a new macro group and sub-group Macra Manager...

on page 158 ) by clicking the Macro Manager... button.

From the Sub Groups box, select the sub-group to Macro Grouping

which the Macro Template you are creating will belong. Name |[WeatherCom

The sub-group chosen for this example is Boiler. Group [Heating -
. Sub Group |Boiler -

If no sub-group exists, you must (see How to create a

Boiler
new macro group and sub-group on page 158 ) by Rari Ma”age'!

clicking the Macro Manager... button.
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Set names for all points in the Macro

When creating a Macro Template, there is a facility
to edit the names of all the points in the Macro in a

single interface. A Macro Point Configuration button

. . . Macro Point Configuration
is available on the Create Macro dialog:

Clicking the Macro Point Configuration button opens paciolRontCon i guration

Macro Details

Name | WeatherCom
Group [Cylon Macros
Subgroup | BAChet

the Macro Point Configuration dialog:

Simply enter textin the Name column against each _I_:um‘-‘ Name lf”f Value ol
nalog o
. . 9 Analo: “C
point and click the OK button. 10 analog <
*C

1 Analog
H Analog

Note: If the modules selected when
creating the Macro included any
Setpoints, it is possible to set labels
for specific setpoint values

Note: This is different from setting the Input and Output names (labels) as described in Change input or
output label if necessary on page 154. Those input and output names are labels displayed on the
Macro module; the point names set here are the descriptive names stored for each of the points
in the Strategy.

Choose whether to insert the macro into the active strategy

The 1Insert into Strategy checkbox allows you to

immediately insert a new Macro based on this Macro
Template into the active strategy. I‘wnsert into strategy on save 5a

If you want to insert the Macro into the active strategy,
select this option before saving the Macro Template.

Save the Macro Template

Ve STre Cancel

The Macro Template is saved to the C:\CXproHD\Macros\ directory if it was created in a UCU or UC16 strategy, or
in the C:\CXproHD\UC32Macros\ directory if it was created in a CBM or CBT strategy. The group and subgroup
information is stored in the macro_database.db file in the same directory.

To save the Macro Template, click the Save button.
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If you decide not to save the Macro Template, click the Cancel button to close the Create Macro dialog box without
saving.

When you save the Macro Template, an entry is added to the Macro pane:
Macros

Macros
M- Legacy Macros
&[] Cylon Macras
E-F= Heating
E-F Boiler
L..[@ WeatherCom

=
&,
S
[F]
<
Q
[}
=
[0}
7]

The Macro symbol is the bitmap that represents the Macro on the drawing area. (See Working with Macros on page
166).

[ .' WeatherCom
) DaT Dmnd €3
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HOW TO CREATE A NEW MACRO GROUP AND SUB-GROUP

Macro Groups and Sub-Groups are defined in the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy

£ copy

lﬂ Create

E ol W BACnet Points E
'.l= BACnet Units Manager

Add o] Reorder _ Strategy | | View | _ r]%

Text Terminals Modules & Strategy Details Help Macros| [ Save Hew

Clipboard Strategy Macros

LS

Start

or by clicking the Macro Manager... button on the Create Macro dialog

—Macro Grouping

Mame I

Group IConn Macros vl
Sub Group IBACnet 'l

Macra ManaEer... |

This opens the Macro Manager window

Macro Manager

[ Ty R
B[] Legacy Macros
[ cylon Macros

To add a group, click the Add button

Groups

[(JLegaey Macros
[ cylon Macros

Macro Manager

Groups

[Legacy Macros
O cylon Macros

Macro Manager

o5 I
while the Macros root is selected in the BE e e
explorer pane (left hand side of the
window)
A new group appears in the Right-hand
side Group pane. B s

3 ¢ylon Macros
[ Heating

Type in a name for the new group.

Groups

[legacy Macros
[ Cylon Macros

Add
Delete
Rename
Adi
Delete
Rename
Export Exit
Add
Delete
Rename
Export Exit

158
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To make a sub-group in the new group, first, make groups visible by clicking on the + sign to the left of the Macros

root.

Click on the group under which you
want to make a sub group.

Click on the Add button.

A new sub group appears in the
right-hand " Sub groups " pane.

Type in a name for the sub group.

You can view the subgroups under
agroup by clickingonthe" + "sign
to the left of the group in the left-
hand explorer pane .

To close the Macro Manager , click Exit .

When a new Macro group is created, it will be listed under Macros in the View menu. When a new sub-group is

Macro Manager “
= Macros Sub Groups | Add
{7 Legacy Macras
B[] Cylon Macras Delete
[Ema] Heating|
Rename
Export Exit
Macro Manager u
By Macros Sub Groups [ Add
[ Legaey Macros T oiled |
[ cylon Macros Delete
[ Heating
Rename
Export Exit
Macro Manager “
1By Macros Sub Groups | Add
[ Legacy Macros ™ Boiler
[ cylon Macros Delete
%Erm
[ Boiler Rename
Export Exit

created, anicon is also created for that sub-group and displayed in the Macro sub-group bar.
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HOW TO RENAME POINTS IN A MACRO TEMPLATE

Points can be renamed from the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
£ copy E ol W BACnet Points E I [ Create .‘
Lﬁ Paste '.l= BACnet Units Manager
- View | Add o Reorder _ Strategy | | View | _ r% Start
[Tiselect Al | |Modules| Text Terminals Modules o Strategy Details Help Macros| [ Save Hew
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

Mame

Group | Cylon Macros =~
Sub Group |BACHet ~

Macra ManaEer...

Clicking on a Macro Template in the left-hand-side ‘Tree Blaciciian=oe]
. . . & Macros roper ame. e mpof
view’ pane of the Macro Manager displays properties of | | -é - e . ] | et |
B Cylon Macros Macro ID {DBFA0DE3-TAG4-4531-B... PEER
the Macro Template in the right-hand pane. O e e crstra [ e — e
EB‘M Point 14 Analog e —
Point 15 Analo
The Macro Name , Macro ID , User Created flag, and the Foint 15 oy

Point 17 Analog

list of point names are displayed.

If point names have already been defined, then an

Edit Point Names button will be displayed on the right- =

Exit

hand side of the dialog.

Macro Point Configuration

If there is no point names list, then a Create Point Names

Macro Details
Name [Weathercom
Group W

Subgroup W

button will be displayed instead.

Clicking either button will open the Macro Point Name

Prefix dialog, allowing point names to be edited for

) Num... | Name [ Type Value High U... | Low Un..
the current instance. B analog c
14 Analog *C
15 Analog °C
16 Analog °C
17 Analog *C
However, if this dialog is opened from the Macro
Manager as shown here instead of from the Create
Macro dialog, then when OK is clicked the Macro
Template is changed and any Macro instances created
afterward will use the updated point names list.
< >
Cancel
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HOW TO SET MACRO SETPOINT UNIT LABELS

In the Macro Point Configuration dialog, it is possible to set labels for specific setpoint values, so that a user can for

C

example select “Night” and “Day” for a digital setpoint, or “off”, “on”, “trip” and “switch” for an analog point, 0%

without the need to know which numerical value matches each function. 2

Q

(o]

. ) . . ) e o

To set an enumerated list for a setpoint, right-click on the setpoint Macro Point Configuration 2

in the Macro Point Configuration dialog and select Add/Edit Iy —

Enumerates . Group [Gylon Macres
Subgroup W

[ um... [ name [ Type [value © [HighU.. [ LowlA
. X i X X 4 ClgRange Analag Setpoint  40.00 3
Note: This option is only available for setpoints. 2 T T e
. ) ) ) ) 13 HtgWarmUpPos pa [rou 5
Note: This option will not be available when a Macro is 5| bt apox Boslogseipont [10000 1%
. 8 FreeFrostStatPos Analog Setpoint  0.00 %
being added to a strategy, or when a Macro 9 ClgFroststateos Analog Setpoint 0,00 %
. . . . . . . 14 FreewarmUpPos Analog Setpoint  0.00 %
instance is being edited within a strategy —in those o Ao semmem | 020 i
. 51 ClgWarmUpPos Analag Setpoint 0,00 %
cases when the Macro Point Configuration dialog 1 Anslog <
19 Analag (o
opens the user will be allowed only to select from 2 inaieg <
.. . 22 Anale C
an existing enumerated list, or to type a value. E :::::3 :

26 Ana\og C o

Cancel
This will open the Setpoint Enumerates dialog. Setpoint Enumerates

Value Description | Celete |

Enter a Value and Description pair, and click the Add button. The
Value/Description pair will be added to the list.

If an entry is made in error it can be removed from the list by
selecting it and clicking the Delete button.

Value | 0 Descrlptlml[]ff Add[ |
oK | Cancel |

When the list is complete, click OK to close the Setpoint Enumerates Setpoint Enumerates
dialog. Value Description | Delete |
o Off
1 On
2 Trip
3 | Switch |
Value| 3 Descriptioll Switch Add |

Cancel |
5
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Now, when editing the setpoint, the user can select the Macro Point Configuration
required value from a drop-down list. Macro Detais
Name [ HtgFreeClg
Group | cylon Macros
Subgroup | BACnet
[ num... | Hame [ Type [value © | HighU.. | Lowi~
4 ClgRange Analog Setpoint 40,00 %
33 HtgRange Analog Setpoint %
2 C——
HtgFroststatPos Analag Setpoint %
13 HtgWarmUpPas Analog Setpoint %
46 HtgFrost1_2Pos Analog Setpoint %
5 DamperMinPas Analog Setpoint %
8 FreeFroststatPos Analog Setpoint %
9 ClgFrostStatPos Analog Setpoint %
14 FreeWarmUpPos Analog Setpoint %
47 FreeFrast1_2Pos Analag Setpoint %
48 ClgFrost1_2Pos Analog Setpoint %
51 ClgWarmUpPos Analog Setpoint %
16 Analog C
17 Analog C
19 £nalog *C
20 Analog C
21 Analag C
22 Analog *C
23 Analog *C
25 Analog =
26 Analog C v
< >
cancel
The setpoint value is displayed in the list with the text Macro Point Configuration
descrlptlon. Macro Details
Name | HtgFreeClg
Group | Cylon Macros
Subgroup | BACnet
[ Type [value © [ HighU.. [Lowta
4 ClgRange Analog Setpoint  40.00 %
33 HtgRange Analog Setpoint 40,00 %
; Ca——
HtoFroststatPos Analog Setpoint %
13 HtgWarmUpPos Analog Setpoint %
46 HtgFrost1_2Pos Analog Setpaint %
5 DamperMinPas Analog Setpoint %
8 FreeFrostStatPos Analog Setpoint %
9 ClgFrostStatPos Analog Setpoint %
14 FreeWarmUpPos Analog Setpoint %
47 FreeFrost1_2Pos Analog Setpaint %
48 ClgFrost1_2Pas Analog Setpoint %
51 ClgWarmUpPos Analog Setpoint  0.00 E3
16 Analog =
17 Analog =
19 Analog =C
20 Analog =
21 Analog =C
22 Analog =
23 Analog =
25 Analog =C
26 Analos A
: s < v
< >

The enumerated list is saved with the Macro template and will be available in all instances of the Macro created
afterward.
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HOW TO TRANSFER MACROS FROM ONE COMPUTER TO ANOTHER

It is possible to use Macro Templates created on one PC on a different PC. They must be exported from the PC on
which they are created, and added to the 'host' PC system (i.e. the PC on which they will be used) as follows:

c
2.
S
o
<
Q
(o]
=
o
(7]

Export macros from the PC on which they were created

Exporting Macro Templates as follows puts each Macro Template in a separate file with a user-identifiable name so
that they can be easily identified and moved to the 'host' PC system.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
{f copy . E a1 g BACnet Points E [ Create .t
Lﬁ Paste '.l= BACnet Units Manager
f— View | Add 1o Reorder _ Strategy | | View | _ r% Start
[TiSelect All | |Modules Text Terminals Modules 1 Strategy Details Help Macros| [ Save Hew
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

MName

Group |Cylon Macros hil
Sub Group |BACnet 7

Macro ManaEer...

. Macro M
Select the Macro group that contains ——
. g Macros A acros ~ mpo
the Macro Templates you wish to |55l e D Fe s
B-F> Cylon Macras CIF Enthpitt Delete

export, E‘"B'p 5 CIF Frostis 2

ampin [1F HtgFCIgPID Q‘"am

. . L..[3 EnthDiff e

select all of the Macro Templates within F Rosti 3 DI marrecto

H [@ HtgFCIgPID E Meter
that group that you wish to export, [ prgreds IR oaTReset

L F Meter Dg Optimizer

. o[Z OATReset Reset

and click the Export button. [ optimizer TR Sortntes

LM Reset [IE seqctr

[ SenAlmLog I seqModule

[ seqctr I sPiant

LR Sanbadula A T &

Export Exit
Select Folder

A Select Folder dialog will open. Select
the location into which the selected

Macros will be saved. T — -
> @ Downl s

W Music

> =] Pictures
> | B Videos
45, 05(C)

Current Selection

Folder: | Documents

Make: New Folder Cancel
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Add exported Macros to the host PC system

Once all required Macros have been exported, copy them onto the PC on which they will be used.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
ﬁc-:upy AR f BACnet Points E
[ Paste 4} 5Acnet Units
View Add (e} Rearder _ Strategy
elect All | Modules Text Terminals Modules b Strategy Details Help
Clipboard Strategy

or by clicking the Macro Manager... button on the Create Macro dialog

Macro Grouping

Mame

Group | Cylon Macros =~
Sub Group |BACnet ~

Macra ManaEer...

Select the group and subgroup into which you wish
to import Macro Templates,

and click on the Import button.

In the standard Windows Open dialog. Multiple files

can be selected by holding the [CTRL] key while
clicking on each file.

Select the Macro Templates you wish to add and click
the Open button.

The selected Macro Templates will be imported into
the selected group.

If the Macro Template already exists on the host PC,
an alert box will be displayed identifying the group
and subgroup of any duplicates.

If you wish to import any of the listed Macro
Templates, tick the box beside its name before

clicking the OK button. This will create a new Macro

Template on the host PC, in addition to the existing
duplicate.

I E“, Create .‘
Manager
View Start
Macros| [ Save Rew
Macros
Macro Manager
=B Macras Macros [ I
[ Legacy Macras 1/ weathercom
E-= Cylon Macros Delete
] BaChet
-3 Heating m
ER=]
‘WeatherCom
Export Exit
i Open
© * 1 L <« temp » Macros v| ¢ | SearchMacros »
Organise New folder =~ [ @
sources *  Name Date me
temp
| AD3.m32
attachments
__| ADB.m32

Macros
ro

VirtualMachines

| WeatherCom.m32

v < >

File name: | "ADG.m32" "A03.m32" v| [*m32 v

Importing Macros

Some of these macros have matching IDs to existing macros. These may have
aready been imported previously. You can select which macros you would like to

import anyway.

Issue

File

€

[~ Select All

D Macro <A03> has same ID as <A03> in <UC32 Macros-=Air Syst... A03.m32
%Macro <AD6> has same ID as <AD6> in <UC32 Macros-»Air Syst... ADG.m32

Cancel
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Note: Each newly imported Macro Template will be named “X New Macro”, where Xis the index of the
Macro Template in the list.

To change this name, select it in the Macro Manager dialog, and click the Rename button.

c
@,
5
)
<
)
(o]
9
o
1%

Once all Macro Templates have been added, they are available for use in the 'host' PC.
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WORKING WITH MACROS

To access the Macro groups and sub groups that exist in a site, click on View Macros in the Strategy tab of the

Ribbon .

r Strategy

ﬁ Copy E 'r BACnet Points

£ T B L |

[¢] Paste 'll= BACnet Units
" View | Add o] Reorder _ Strategy
i Select Al | |Modules| Text Terminals Modules 1o Strategy Details Help
Clipboard Strategy

E‘, Create
Manager

Vi

Ma

335 l__'m Save Mew

Macros

The Macros pane will be displayed on the right-hand side of the CXpro"® window

Macros i x|

"[—ﬂ Macros

[ Legacy Macros
[ cylon Macros
[ Heating

Macros Prop... Page .. Mod..

How to insert a macro into a strategy

To insert a Macro in a strategy, select it in the Macros pane and click in the drawing area (note the cursor changes

to the “Module Cursor” during this process)

S BEES Q- CXproHD - 1.00.00-320 - olEl
File = Home  Controller | Strategy ®
# Comnect 1 | oo E 7. fasacnetponts E B crete | € starause €, | Byona O}
¥ Disconnect [ Paste & BACnet Units [y Manager | 9 < B
Download | o Add /O Reorder Strategy | | View |
[Jisclect All | |Modules Text Terminals Modules T Strateay Details ~ Help | |Macros) [ Save New | &, g
site Controller | Clipboard Strategy Madros Simulation Display
Site List =K 00101532 | 001.01.s32WeatherCom | 001 01.s32Wea..| b X | Magres a8
=-§) Sites ~ || macos

So BACnet P
B-Ta BACnet Serial
222 001 - Network
= 001 - 001 - UCU3213VAV
B-2g PLOffice
-2 001 - Network

&, 001- 001 - CBM24
Ba sample Apps BACnet

v

[ Legaey Macros
[ Cylon Macras
B[ Heating

- Boiler
[ WeatherCom

Strategy saved successfully.

> Macros Prop.. Page .. Mod..

Connected to: Sample Apps BACNzt (3], Y 1o
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le anogu: ==
) Macro Point Configuration
Nrie - Home  comroter | st ®
& Connedt gL (F] Copy D Eoiihand b Start/Pause € | B Grid O}
Foscomee| LI | pute Name [Weathercom Thi text il be prepended to L o B
Dounload each point name below.
Group [Heating -
o site Controller | Clipboard i Simulation Display
£ Subgroup | Boiler
Jsien T | .|
e Sites. Y Macros
2 2, BACet P Num.. | Name [Type [ Value [High u... [towun., D Lo
-2 BAChet Serial B e = L3 cyton Macros
nalog
552 001 - Network 25 Analog - B Heating
= 001-001-UCUI2IIVAY] | |25 Anslog < EBB@W‘: .
5-Za PLOffce 27 Analog d . eatnerCom
B2 001 - Network
=), 001 - 001 - CBM24
S0 Sample Apps BACnet
< >
v
oK > Macros Prop.. Page .. Mod..
Setup block updated. —

2 BEG Q- CXproHD - 1.00.00-320 = B
File ~ Home Controller Strategy @
Hcomnea | L | Chcopy E A BACnet Points [ creste | @ statrpause &, | Bhoria Oy
¥ Disconnect [F] Paste A Bacnet Units FRy Manager | Ty & B
Download View | Add O Reorder Strategy - o
Modules Text Terminals Modules b Strategy Details ~ peip Ry save New | 8, - 7
site. Controller | Clipboard Strategy Macros Simulation Display
site List L Kl 00101532 | 001 01s32:WeatherCom | 001 01s32Wea..|» X | [Macros < |
E-@) Sites. - - - - - ~ | [@ macros
Bo sacoat I3 Legoy s
=50 BACnet Serial & o Bmnd ) [0 cylon Macres
232 007 - Network = Heating
L. 001- 001 - UCU2IIVAY EBB@”“&: et
&-2a PL Office eathercom
2-52 001 - Network
1.1, 001- 001 - CBM24
25 Sample Apps BAChet
v
< > Macros Prop... Page ... Mad.
Setup block updated, Connected to: Sample Apps BACnet ), — | —.

The Macro instance can be renamed, and its details viewed, through the Properties pane.

Properties

ra

WeatherCom

4 001.01.532 | 001_01.53%WeatherCom | 001_01.s3.. b X

N SECSE

XS] B

~ £ > ? IWeatherCom

B General Information

Point De... | Analog

MName WeatherCojn
Point Configura...
B Inputs
B O0AT
Internal Mo... Rescaleto 0and 100
Internal Meo... Upper Limit B
Point De... | Analog
B Outputs
B Dmnd
Internal Mo... Rescale from 0 to 100
Internal Mo...  Input

=l

Name
The name of the macro.

> Macros  Properties  Page Ma...

Modules
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How to view the modules in a macro ("Expanding" a macro)

To expand a Macro, double-click on the Macro symbol on the drawing area.

4 001_01.532 001_01.s32:WeatherC
B U H WzatherCom
S8 oa

[ [x=8]

CXpro*"® will open a new strategy for the Macro’s constituent modules.

q 001_01.532 001_01.532"WeatherCom 001_01.532WeatherCom 001_01.532:WeatherCom I
P Wéai:hér‘c'r'""
i0 . 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 .., 80 °C
........ aosopl
R Real Constant o 100 ¥ Rescals from Do 100 32
A=20, B=80 Y a/,l
R Real Constant Output A 72| Lower Limit A Outh[O
Y - Output B @ —55|© Upper Lim B
[ B [Constant A+ 80.00; Gonsn: B: 2. @ o
owaBORY
[Constant A: 20.00; Constant B: 2... B 100 Resczletodand 100 32
- . . / ...........
Ao
B e T = N
L 7@ Ueeer ime Bl
Qutside Air Temperature (OAT) O et
Rescales input temperature
"""" so'that 0°. 20 °C Becomés 0...'100 o
......................... v
£ >

Note: The view settings for Lines and Point Numbers are saved with the Macro. They are not inherited from
the parent strategy. For example, if lines are not visible when a Macro is expanded, simply right-

click on the strategy drawing, select Display Options , and specify that lines are to be shown.

Note: To distinguish between the inputs and outputs of individual modules and the inputs and outputs
of the overall Macro module red highlighting is used to mark the connection points of the Macro
modaule. It also provides the full path of the strategy file that it just created when expanding the
Macro in the Window menu.

Note: Any changes made to a macro within a strategy will only affect the current strategy. The macro and
all of its module blocks are saved within the active strategy. To edit the macro strategy itself you must
open the *.etn file.
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How to Edit a Macro

It is possible to edit an existing Macro Template or to re-save a modified Macro as a new Macro Template. To do this,

expand the Macro by double-clicking on the Macro symbol in the drawing area. c
>

4 001_01.532 001_01.s32:WeatherC o%
(o]

Rl FTr 8

r. WeatherCom ]

B R

CXpro"® will open a new strategy for the Macro’s constituent modules.

4 001_01.532 001_01.532:WeatherCom 001_01.532:WeatherCom 001_01. m box
~
Weather C
.. 30 5C Gutside Ar is mapped fo a Flow Temperature Setpoint of 20 ... 80 °C
A=80, B=20
) ) ) ) ) R Real Corsmamt 3% . {00 ¥ Rescae fom 0 100 3%
A=20, B=80 N b7
R Rea Conemant 3 . [ ot AQmr— (@ Lower Lz A] Otz ()
A [ o506} & Upprimi g
) |Gonstane Ar 80.00; Gonseans B: 2. )
o
[Conart 7 20.00; Cansnt B 2 u}m Reckw@land il =

Outside Air Temperature (OAT)

Rescales nput temperature
so'that 0'... 20 °C becomes 0 ... 100

Make any required changes to the component modules of the Macro by clicking on the symbol and editing its
properties in the Properties pane.

To save the changes select Edit Template from the Macros section of the Strategy tab on the Ribbon .

Strategy

E Copy

F3 Create

E el g Bacnet Points E
& BACnet Units

T Paste P Manager

L= View Add (] Reorder Strategy View

TiSelect All | |Modules| Text Terminals Madules 1 Strategy Details Help Macros [ Ed\tTen&\ate
Clipboard Strategy Macras

This opens the Create Macro dialog, but in this case, Macro Inputs and Macro Outputs cannot be added or deleted.

The input and output point names can be changed, as can the Macro Name , Group, and Sub Group .

Edit Macro Template ®
————
"
Ot A Oy ™
Sapu L ol
by [P ———_
y
<
Mo ot Outputs [reep—
Inputs ouputs
‘ e
w w [
@ n @ G
o ln Group [tegan oo =]
w o or o
W o sun ioup [Fetsmmems ]
o m
%% o ao anager
Msco Pt Contiguratian swvetiew | [omwme | cance

When all required changes have been made, click the Overwrite button to save the edits to the original template.
Alternatively, if you want to retain the original template along with the edited one, edit the text in Name field to

the name of the new template and then click Save New .

Note: This can also be launched when Macro is selected in the Macro Manager.
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COMMUNICATING WITH CYLON CONTROLLERS

When you are using CXpro"®, you will need to communicate with the Cylon controllers on the site.

You may need to send information to a controller such as a control strategy, a command to erase its
memory, details of its setup, etc.

You may need to get information from a controller such as its version, current setup, and details of any
strategies it may contain.

You may wish to view events within a controller, such as changes in values when a strategy is being serviced.
This can be done in Scan mode or by using the LiveLog menu option.

SENDING INFORMATION TO A FIELD CONTROLLER

When the strategy is ready to be downloaded, simply click the download button on the toolbar or choose
Download from the Communications menu and CXpro"? will download the strategy and send the set-up

automatically.

Wiping a Field Controller's memory

Although it is no longer necessary to wipe the Field Controller's memory before downloading if automatic
download is enabled, it is still necessary to wipe the controller’s memory before using it for the first time. If you
are not using automatic download, you must manually wipe the controller’'s memory before downloading.

The effect of wiping a Field Controller’'s memory

Wiping Field Controller memory has the following effect:

All blocks are deleted (the strategy is deleted).

The functions of the site (valves, pumps, dampers, etc. controlled by this Field Controller, are no longer
available.)

The number of serviced blocks will be set to zero. Field Controller Set-up has to be sent again.

All virtual points are assigned the value zero.

All hardware points are assigned the value zero.

All outputs go to zero volts.

Inputs do not read any signals from connected devices. This is true for manually overridden points too.

The green LED on the Field Controller flashes rapidly. If the Field Controller is running without a network
(standalone), the flashes are regular. If the Field Controller is running on a network (connected to a BACnet
Router), the flashes are irregular.

If the alarm feature is active, an alarm appears on the monitor of the connected PC.

If a keypad program for that Field Controller exists, it will be deleted.

Sending the setup to a Field Controller

If you are using Automatic Download, it is not necessary to send the setup to the controller after downloading.
Otherwise, the setup must be sent manually as described in Starting a strategy (sending the Setup) on page 131.
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GETTING CONTROLLER INFORMATION

How to get the Controller version
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

File - Home Controller Strategy

’ Co§e¢ m Copy Properties I Modules |Ez| Strategy
L”Disc nnect LﬁPaste Navigatian Macros |:| Reopen
..... Sits

i Select Al Lis: E Page Mames @ Search

Site. Clipboard View

Site List o x (i Strategy1

B2 001 - Metwork ||
~B oor-om-ucusizv L

e Select Version from the Operations section of the Controller tab in the Ribbon .

ne Contraoller Strategy
%Communications Ii"l Download @Compare E:';Version "T'\Board Diagnostics
ot %Controller ’?}Wipe Controller ShowCompare %Time and Date I;'_.|Statistics
% BACnet ﬁ Auto Online Maximums rlﬂ Lock and Unlock
Configuration Operations

CXpro"'® will get the version from the controller and display it.

Version

Wersion UC32.8B 7.6.9 05/05/16 Boot Ver:06.00

Serial Number CU12205063F
" Ecp

Close |

Click OK to close the Version window.

MANO0133 rev 15 © Cylon Controls Ltd.
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How to get the controller setup
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the

==
File -~ Home Contraller Strategy
’ Coged: m Copy Modules E Strategy
_é‘Dlsc nnect LﬁPaste Namgatmn Macros |:| Reopen
71 Select All E Page Names @ Search
Site Clipboard View
Site List 8 x [ Strategy1
-y Sites

g..i_g BACnet IP
-5 001 - Network
= 001 - 001 - UCU3213V

Ribbon :

e Select Time and Date from the Operations section of the Controller tab in the Ribbon .

Contraoller Strategy
Ela Version

L3 Time and Date T} Statistics

1 Download FE. Compare
’tEWipe Contraoller E Show Compare
ﬁjAuto Cnline

Jﬁ Communications

"E Controller k
%, BACnet

Configuration

Maximums

Operations

CXpro"® will get the Setup of the controller and display it.

Controller Configuration

Mumber Of Strategy Blocks To Service I b

r'.\Board Diagnostics

:.' Lock and Unlock

Send |

Receive |

Time |11:57:35 Time |11:5?:35 j‘ Date 14_-"3-8_-"23-182‘

r Last Ci d Strategy Last Modified
=] 108/2018 ==
=l Date |14/08/2018 = ’7

User ID

User Name
Drawing Reference

Strategy ID

Min Service Time

1]

Time Synchronisation Wait After

r~ Current Status
Received setup from controller

Close I

Click OK to close the Time and Date window.
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How to get controller statistics
e Select the controller in the Site List

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :
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==
File -~ Home Contraller Strategy
’ CoEed: m Copy I odules |Ez| Strategy
ﬂ Discannect LﬁPaste Namgatmn ||E| Macros |:| Reopen
..... ite
i iSelect All List E Page Mames @ Search
Site Clipboard View
Site List 8 x [ Strategy1
By Sites

B-3g BACnet P
¢ B2 001 - Network
™1 001 - 001 - UCU3213V

e Select Statistics from the Operations section of the Controller tab in the Ribbon .

ne Controller Strategy

%Communications li"l Download |_'—’11=|Compare E:Ij\fersion "T'\Board Diagnostics
u % Controller ’QWipe Controller Show Compare % Time and Date '-_.'_| Statistics
% BACnet lﬂ Auto Onling Maximums "_'5 Lock and Uhlock
Configuration Operations

The Statistics dialog box, shown below, appears. The Statistics dialog box contains information that comes directly
from the controller — this information allows you to check the status of the controller.

Statistics

Engineering Statistics } System Statistics | Serial Port Statistics |

Number of Resets

Mumber of Crash Detects

Comm. Checksum Emors

i

MNumber of Bad Blocks

Status

[~ WatchDog On
[ Real Time Clock present

oK

The Statistics dialog box has three tabs — Engineering Statistics , System Statistics , and Serial Port Statistics .
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Engineering statistics tab

Statistics

Eﬂgmeegg Statistics | System Statitics | Seral Por Statitics |

Number of Resets 0 Clear

Number of Crash Detects 0
Comm. Checksum Emors 0
Number of Bad Blocks 0

Status

[~ WatchDog On
™ Real Time Clock presert

e 1
Number of resets indicates how many times the Field Controller has been powered up and down
Number of crash detects the number of crash events detected since the Strategy started
Comm. Checksum errors the number of data errors that have occurred in communications
Number of bad blocks the number of bad or corrupted blocks that have been detected in the strategy

Watchdog on This shows the current status of the “Watchdog” on the Field Controller — the box is checked if the
watchdog is switched on (a watchdog is a hardware component in the controller that checks if the controller is
serviceable. When the watchdog is off, the controller is not operating)

Real time clock present indicates if a real time clock is present in the Field Controller
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System statistics tab

This tab provides information on any problems the controller may have in servicing the strategy.

Statistics

Engineering Statistics  System Statistics |Sena\ Port Statistics I
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"Last Reset

I\n\rahd Ilrwalid

™ Setup Block

MNumber Of Blocks Servicing ID
Number of Bad Blocks ID

First Bad Block ID
Last Bad Block ID

0K |

Last reset Shows the date and time that the Field Controller was last reset

Set-up block indicates if the Setup block (the block in the controller that stores details of the number of blocks in
the strategy) is in place.

Number of blocks servicing shows how many blocks are servicing in the Field Controller
Number of bad blocks shows how many bad or corrupted blocks are detected in the Field Controller
First bad block The number of the first of the bad blocks (if any)

Last bad block The number of the last of the bad blocks (if any)
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Serial Port Statistics tab

CXpro"'® can display information about messages passing through the Field Controller's serial ports as follows:

Statistics

Engineering Statistics } System Statistics  Serial Port ft}aﬁstics ]

Serial Port Type
& Subnet Recsive
" Service
" Intemal Keypad %
" Edemal Keypad
Total Number Keypad Information
Bytes Received [0 OvemunEmom [0 Unexpected Responses [0
Bytes Sent "}7 Framing Emors "}7 Rx Timeouts ,ﬂi
Packsts Received ’0— Parity Emors ’0— Resends '0—
Packets Sent [0 o e Packet Sze NACKS [0
NACKS Received [0 o Undefined NACKS [0
NACKS Sent ’D— Ereak Conditions Broadcast Information
ACKS Received "}7 ’D— Faults ,ﬂi
ACKS Semt [0 CRCEmrs [0
Checksum Emors ’ﬂi Packets Received OK ,‘}7
Packets Received 'D—

The first section of this panel, Serial Port Type allows you to select which of the four possible serial ports the
displayed information refers to.

Pressing the Receive button causes CXpro"® to upload information about the selected port from the Field Controller.

Clicking on Clear causes the Field Controller to clear its memory of port statistics for the selected port.

The information displayed is the number of each of the following messages that passed through the selected serial
port since the controller's memory was last cleared:

e Number of Bytes received

e Number of Bytes Sent

e Number of Packets received
e Number of Packets Sent

e Number of NACKs received
e Number of NACKs sent

e Number of ACKs received

e Number of ACKs sent

e Number of Checksum errors
e Number of Overrun errors

e Number of Framing errors
e Number of Parity errors

e Number of break conditions

This information can be used to diagnose low-level problems with the Field Controller's serial-port communications,
and this is usually done in consultation with Cylon Technical Support.

178 © Cylon Controls Ltd. MANO0133 rev 15



How to get Field Controller Diagnostic information

CXpro'P has a facility to display information about the operation of the UC32 controller's hardware system. This
information referred to as 'board diagnostics' can be of use in troubleshooting unusual and low-level problems on
a Cylon site, and is intended for use primarily when communicating with Cylon technical support.

Board Diagnostic information may be viewed by selecting Diagnostics from the Controller tab on the Ribbon .

$J39]|0J3U0D YUM SuiedIuNILC

Contraller Strategy

%Communications th Download @Compare E,Version "T'\E»oard Diagnostics

'3 Controller ’i}Wipe Controller Show Compare % Time and Date '-.'_.| Statistics ﬁ

% BACnet rﬁ Auto Online Maximums "_'5 Lock and Unlock
Configuration Operations

This opens a display panel showing categories of information about the Field Controller's hardware.

Board Diagnostics
Battery Status Vector
Battery VECTOR COUNT VALUE

DAC Reading for...

Ov switch ta

Port Setup

Address
Baud Rate

Board ID Resistors
Main Board

Daughter Board

Ready

Clicking on the Receive button causes CXpro"® to upload the relevant information from the targeted Field
Controller.

How to get Field Controller Configuration information

Field Controller configuration information can be of use in troubleshooting unusual and low-level problems on a
Cylon site and is intended for use primarily when communicating with Cylon Technical Support.

To view this information, select Maximums from the Controller tab of the Ribbon

Controller Strategy

%Communications I'fl Download @Compare E'a\fersion "T{Board Diagnostics

'3 Controller ’DWipe Controller Show Compare % Time and Date '-_.'_.| Statistics

% BACnet ﬁ Auto Online Maximums :.' Lock and Unlock
Configuration Operations

This opens a display panel showing the configuration of the Field Controller's hardware.

Maximums

Maximum Subnet Address 63
Maximum Strategy Block 1024
Maximum Number of Datalogs | 32

Maximum Keypad Program Size | 20003

Close
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HOW TO SET THE CONTROLLER TIME AND DATE

e Select the controller in the Site List
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

==

File - Home Controller Strategy

’ Cof§e¢ @ Copy Properties Modules EE Strategy
nnect

L’” Disc? LﬁPaste i Na\rigation Macros |:| Reopen
;' Select All List Page Mames @ Search
Site Clipboard View

e Select Time and Date from the Operations section of the Controller tab in the Ribbon .

ne Contraller Strategy
%Communications l!'l Download @Compare E'a‘u‘ersion "T'\Board Diagnostics
a3 % Controller ﬁWipe Controller Show Compare % Time and Date I:.'_.| Statistics
% BACnet I‘E Auto Online Maximums r'g Lock and Unlock
Configuration Operations

This opens the Time and Date dialog.

Time and Date
Time and Date Send
) _—— 5
Time | bE:06:57 =i System Time/Date | Receive |
Date [14/08/2018 =
Time Based On
" None
" EU
" us
" Use Point 0
Current Status
Error receiving time and date from controller

In this dialog, you can check the time and date set in the targeted controller by clicking on the Receive button (time

and date are automatically received when you first open the dialog).

The Time and Date can be changed by typing a new date, by scrolling, or by pressing the System Time / Date

button, which sets the time and date to match the settings in the PC on which CXpro"® is running.

The daylight saving time scheme can be selected in the Time based on the box on the Time and Date dialog:

e [f the None option is selected for Daylight Savings, then the controller will not automatically adjust its

time to match conventional Summertime and Wintertime.

e [f the EU option is selected for Daylight Savings, then the controller will automatically adjust its time

according to the standard European rules for Summertime and Wintertime.

e [f the US option is selected for Daylight Savings, then the controller will automatically adjust its time

according to the standard rules used in the USA for Summertime and Wintertime.

e |f the Use Point option is selected for Daylight Savings, then you can specify a point whose value will

determine Summertime and Wintertime.

If the time and date settings have been changed in the dialog box, they must be sent to the controller before

they will take effect. This is done by clicking the Send button:

Clicking the Close button closes the dialog box without sending or receiving further information.
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CHANGING THE ADDRESS OF A CONTROLLER (CBM ONLY)

CBM controller addresses must be set from software because there are no Address DIP switches on this type of
controller. To set a controller's address from CXpro*P:

e Make sure that the PC, running CXpro"®, is directly connected to the Field Controller’s service port.
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e Make sure that there is a site set up in CXpro"® with the PC connected to COM port:

Site Properties X

Name: |Sena| Site

Directory: | SerialSite

Type of Connection for this Site:
(% Serial Connection

" BACnetIP
-
IP Address | 0 0 0 0 47808

Time toLive |60 seconds

I™ Enable BACnet NAT |
oK Cancel
e  Make sure that the directly connected controller is targeted in CXpro"®s Site List
|5i‘te List
E@ Sites
72 BACnet IP

o BACnet Serial
- EE Campus block R
. 2= 001 - Network
... = 001-001 - CBI
&2 Pl Nffice

e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon :

File - Home Controller Strategy

’ Copnect @ Copy Properties I Modules |Ez| Strategy
Q’Dls%nned LﬁPaste Site Mavigation Macros |:| Reopen
List

["iselect Al Page Mames @ Search
Site Clipboard View

e Select BACnet from the Configuration section of the Controller tab in the Ribbon

Contraller Strategy
%Communications Ii"l Download @Compare
% Controller ’?}Wipe Controller Show Compare
%, BACnet 2 Auto Online
Configur[ﬁon Op
In the BACnet Configuration dialog, you can set the address for the controller
BACnet Configuration
Cantroller Config New
Contraller ‘ 1 | 1 IZS‘
Device Instance I 4 [ 4 [
Device Name o1 -001-cemos  o01-001-cemos  [Po1 oot - cBMO
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DATALOGS

Datalogs (Trendlogs) are a feature of Field Controllers that allows point values to be recorded over a period of time.
The recorded data can be later retrieved, displayed, and analyzed with the Datalog Manager module.

Analysis of logged data is often useful in optimizing the effectiveness of a Cylon site’s controllers and strategies, and
Identifying opportunities for energy savings.

The datalog function module

The collection of point values in a datalog is implemented in a strategy by either the Datalog module or the BACnet
Trendlog module.

Datalog B
N Datalog_1

Analog input BACn=t Trendlog 4
@—'np AN T outside fir -
[ Digital input & Temperasture Trend
[ Enzhle [ Digital input
[ Leg trigger €3 Anakg input
Datalog number: 1; Update [ Enable
interval: 900; Link: 0; Datalog P E——
Trigger Options: Any Edoe: Dekta: [ Leg trigger
1,00; Bxtended length: 0 Datalog Trigger Options: Any Edge

The content of a Datalog can be viewed with the Cylon Datalog Manager, and the content of a BACnet Trendlog
can be examined by a BACnet supervisor. Their use in the Strategy is identical.

Restrictions on the use of datalogs

The number of Datalogs (Trendlogs) permitted in a strategy depends on the type of controller in which the strategy will
be used.

Some controllers, such as the CBM24 can have up to 32 datalogs, with a maximum of 1024 entries per datalog.
Other controllers, such as the CBT12, have up to 6 datalogs, with a maximum of 1024 entries in each. You can
determine the number of datalogs that a particular controller can hold using the Maximums dialog box, available

from the Operations section of the Controller tab on the Ribbon menu.

Standard Datalog sampling period

Each standard datalog module can be configured with an individual time constant for sampling data. To make the
evaluation of datalogs easier it is advisable to use the same time period for sampling data in all datalog modules. A
sampling period of 15 minutes is suggested.

The period of time over which the datalog samples are equal to the product of number of entries (104 or 192) and
the sampling frequency. For example, a datalog module on a UC16PG with a sampling frequency of 15 minutes
(900 seconds) will take samples for (192 X 15) minutes = 48 hours.

Time Stamped Datalogs

A time-stamped datalog records the time and date at which a value was recorded, along with the value. A logging
interval is not set - instead, the value of the specified point is recorded:
e when the digital trigger point changes state
e when a logged digital point changes state
e orwhen alogged analog point changes state by more than a predefined amount from the last value that
was logged for it.
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There are several situations when such a datalog would be particularly useful. For instance, if you log the value of
a point with a conventional datalog and set the logging interval to 10 minutes, the value of the point may change
significantly and return to its original value over a period of 3 minutes, and that change might occur during the 10
minutes when the datalog is not recording. If so, the event would not be logged at all. On the other hand, if the
logging interval was 30 seconds, the event would be recorded - but the datalog could fill up and the event could
be 'flushed' before it is viewed. If so, the event would also be lost. In both of these cases, a time-stamped datalog

could record data over the period of the event only, so that the necessary data is recorded without the datalog
filling up.
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The other primary use of a time-stamped datalog is to log conditions that surround an event. For instance, when a
window is opened, the temperature of the surrounding area could be logged to see how it reacts.

Datalog sampling of digital and analog point values

Both digital and analog point values can be sampled. The datalog module has a digital input and an analog input.

Analog Input o Datzkg 2
Al goom at S N Raom
om Temperature S TemperatureA
Point £ T i) € Analog input
5 Y |
Ovemide [ [ Digital input
[ Enable
[ Log wigger

Datalog mumber: 1; Update
interval: 300; Link: 0; Datalog
Trigger Options: Any Edge; Deha:
1.00; Bxtendad length: 0

o s .
Digital Input A N Valve 2094
D I Valve 209 o £ Analog input
Point [T 7 vl (] Diigital it
AT )
Cvemide [ [ Enable
S

Datalog umber; 2; Update
interval: 900; Link: 0; Datalog
Trigger Options: Any Edge: Delta:
1.080; Bxtended length: O

How to define a datalog
To define a datalog, proceed as follows:

Select the Datalog module in the Modules pane

Modules W x|
®

I i " la

Controls »

Functions »

Math »

Schedules, Timers, and Logic »

Setpoints, Inputs, and Outputs »

Statistics -

‘ Alarm

“ BAChet Alarm

"\‘ BACnet Trendlog

D Comment

|b Control Flags

123

nmn  Counter

V' Datalog %

Meter

® Real Time Clock v

Macros Properties Page Ma.. Modules
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and place it on the drawing area (note the cursor changes to the “Module Cursor” during this process)

i oooisz ) wioise x| [ieadied - i oo ) oo s | Moduies =@
Cantrols v Cantrols N
Funcions » Funcions ,
Math » Math ,
HE Schedules, Timers, and Logic v Schedules, Timers, and Logic »
Sefpoints, Inputs, and Oulputs Sefpoints, Inputs, and Outputs
Statitics - Statitics -
A aam A aam
Ay sacnet wam Ay sacnet am
% satnet Trendiog 1§ Batnet Trendiog
D comment D comment
% control Flags % control Fags
1 1
T Counter T Counter
Y patalog Y patalog
Meter Meter
| ® reaimme dock v o || @® real Time ciock v

<

>

Macros  Propeties PageNa.. Modules

Select the datalog, and configure its properties

4 001_01.532 001_01.532 - X | Properties O x |
B £ D> ? Datalog -
‘Anzlog Input T Datakog =]
Ro
Al soomtempensre | NV e Type Detalcg
Peint O frrr— T Ansig inpet Service Order 2
Ovemide) g Eg"::"'j“" Marne Room TemnperatureA
na
5 tog wiaer Use point name  True
Darab\-; b L Synchronised 5t.. Checking...
interval: 500; Link: =]
Triggar Options: Any
L.00; Evtended langth: | Analoginput  Analeg (1): 0.00 Ro..
Enable Digital
Log trigger Digital
Digital input | Digital
=]
N Detzlog 3 Datalog number 1
Digal Input Valve 2094 Datalog type Analog
DI Valve 209 (65 Anaiog inpt 9P E!
— - - = Update interval 900
Point [ T EJE Digital input -
Gl N GET Log trigger opti...  Any edge
: | es wesr Delta 1.00
Datalog number Precision 0
intarval; 500; L R o
Trigger Clptrg;lg Eo=i Log trigger Time interval
1.00; Exte ngth: O
—_ — Extended length 0
Analog input
The analog value to be legged.
. LW
< > Macros  Properties Page Ma.. Modules
Name

Macros  Propeties PageWa.. Madules

A datalog is automatically given the same name as the point to which it is joined but can be edited if the Use Point

name property is setto False.
Use Point name

If True, then the Name property matches the connected point and cannot be edited.

Analog input

This shows details of the point to be logged if an Analog point is connected

Enable

The Enabling Point is a digital point, connected to the “Enable” input of the datalog module, which restarts the
sampling process if its value changes from @ to 1. If this point is not connected, then the datalog samples
continuously. In typical applications, this input is not used.
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Log Trigger

In Time-stamped datalogs, it is possible to record data when this trigger point changes. If the trigger point is not
connected, logging occurs according to the "Minimum Change' parameter.

Digital input
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This shows details of the point to be logged if a Digital point is connected

Datalog Number
This shows the automatically-assigned number for the Datalog within the strategy.
Datalog Type

The type (analog or digital) of the point being sampled is shown in the Type of Point to Log.

Update Interval

This is the frequency of sampling (in seconds). By default, this is 900 (15 minutes) but can be edited in the Properties
pane.
Delta

If the datalog type is set to 'Time Stamped', and if the type of point being logged is analog, it is possible to trigger
a sample whenever the point value changes by more than a particular amount. This field specifies that amount of
change.

Starting a datalog

A datalog is part of a strategy and is saved with the strategy. The example below shows a datalog module linked to

a strategy:
Anakeg Setpoint o Comparator [ Digital Output 7
m Frost Protection © - |A-B o DD Baoiler Switch
Point () el Inpust A c'utp.nm.l'] — w3 Point Tvame= O
. . . . L . 13
5] ) Input B Complement [[
A .
Y e
N IR Qutside Air
Analog Input 1 N
AI Outside Air 1. . -TEI11DEI'atIJI'Eﬂ
Temperature €) Anzlog input
Point & I3} [T Digital input
Ovarridz 0 |8 Enztk
[0 Log trigger
Dataleg numbsar: 1; Update
intzrval: 900; Link: 0; Datalog
Trigger Options: Any Edgs; Delta:
1.00; Baended length: @

Datalogs are started along with the rest of the strategy in which they are contained, when the strategy has been
saved (see page 121), downloaded (see page 126), started (see page 131) and tested (see page 134).

Note: If the block on which a datalog module is placed is downloaded again to the Field Controller, the
sampled data is deleted.
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Viewing the contents of a datalog

This is done on a PC running Cylon software.

The Datalog Manager program is used to view or print out datalogs, on screen or printer, as text or graphics. To
open is, click on the Datalog Manager icon in the Home tab of the Ribbon .

Home Controller Strategy
innect Cf copy T [FH Properties |[[E] Modules |[?] strategy Help r‘] g r'l r‘l r‘] r‘l
sconnect L?jPaste £ Navigation Macros Reopen Strategies a = w sh < e
= Site Configuration Database Datalog Site Eackup ME-Pro
L_iSelect All List |[=]Page Names [&]search Interface Mand.zr Organiser
Site Clipboard View Utilities

The Datalog Manager allows data from Field Controller datalogs to be viewed in a variety of ways:

e The data can be listed as text.

e Adatalog can be viewed as a graph.

e Information from multiple datalogs can be superimposed on one graph.
e The status of data points can be viewed in real-time.

e ‘Snapshots’ can be made of data from any set of analog points in a controller strategy.
For further details on the display and printing of datalogs, see the Datalog Manager manual.

Archived datalogs can be statistically evaluated by using programs like Microsoft Excel. This provides valuable
information about the operation of the site.
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ALARMS

Alarms are used in a BMS system to alert site supervisors/engineers to any difficulties that may occur on a Site. The
Cylon BACnet range supports BACnet Alarm notifications which can be made available to BACnet supervisors such
as Cylon’s Aspect™ UL.

The BACnet Alarm module is joined to a digital point (Binary Value). When the digital point has the value 1, the BACnet
Alarm module is activated. The Binary Value may indicate an error condition, for example, a sensor going out of
normal range or a fire alarm being activated.
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Alarms can also be set up directly on BACnet points via standard BACnet protocol.

Starting alarms

Alarms are parts of strategies and are saved with the strategies. The examples below show how alarm modules can
be linked to a strategy.

Alarms are started after the related strategies have been saved, downloaded, started, and tested.

Examples of Strategies containing alarms

Alarms - Example 1: Pump Trip Switch

To illustrate the use of an alarm module in a strategy, this guide takes as an example a simple case where a digital
hardware input represents a trip-switch contact of a pump. Joining the digital input to an alarm module means
that an alarm will be generated if the pump goes off-line.

Digal Input T BACn=t Alzrm s
D I Pump Tripswitch 0 % Pump Tripswitch
Point [0 .1;] -.ZJEAlar'n trigger |
Override [ ' ™ [Blzrm on: 1; Motficton type: Al

Alarms - Example 2: Pump Trip Switch with delay

This case joins a digital virtual point (a delay of 60 seconds on the digital hardware input) to the alarm record
function module.

Digital Input 3] [+ Twmerwih Consant.. 7| BACnet Alarm 3
DI Pump TripswitchA 0 o % DigVirt_1
Point [ .3.3 -.3]ETrigger Outp..rt@l- - {5 Alarm trigger
L A D e
Cverride [ [ Raset Complement [0 Alzrm on: 1; Motficton typs: Al
" [Ondely: 10; OF delayr 2p MG ) T

Alarms - Example 3: Room Temperature Input

In this case, an analog input (room temperature) is joined to the alarm record function module and will cause an
alarm to be sent to the Alarm Handler program if the input value is not within the range specified in the real
constant module.

R Real Constant [ B - Window Comparator  § & BACnet Alarm ]
AW Y DigVirt_2
| Outp..n.ﬂ@zj Z@Lo‘iuerlin'rtﬁ. Q.rtwirdowﬁzj JE.‘\lar'ntrit;n;\erl

Qutput B 6 € Upper limit B In window [ [Alzrm on: 1; Notification typs: Al...

Constant A: 0.00; Constant B: 0,00 € Input C
Analog Input
AI Room Temperature
Point €3 frp
Ovarmids [[
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INTRODUCTION

A Simulation Mode is available within CXpro"®, which allows the operation of a strategy to be simulated without the
requiring a controller to be connected. This is done, in most cases, by using actual Firmware code to ensure the
simulation is as close as possible to real controllers.

Simulation Mode is accessed through the Simulation section of the Strategy tab onthe Ribbon

ler Strategy

L?jPaste
iew

Clipboard

o 8

Start/Pause

“

Stop

%

Reset

#L!E Logging

o Configuration

E R rBACnetPoints E [ create .n .ﬂ. % #N Logging
.l= BACnet Units Manager > . Configuration

Vi
i_iSelect Al | |Modules| Text Terminals Modules n(".f'strategy Details  Help Macros FIE] Save New 1 seconds

(o] Reorder Strategy View Start/Pause S5Stop  Reset

<1 H B

Strategy Macros Simulation

Clicking this button will start and pause the simulation for the current strategy. It is enabled
only if CXpro®® is not logged into the site. When the strategy is paused, the current
simulation state is still visible on the strategy.

Clicking this button will stop the simulation and clear the simulation information from the
screen. However, the simulation state will still be preserved, and pressing the Start/Pause
button will restart from where it stopped.

Clicking this button will stop the simulation, clear the simulation information from the
screen, and clear any other simulation information for the strategy.

Clicking this button will enable or disable logging of data. When released, no point logging
will happen. When pushed, any point that has logging information set will have its values
logged accordingly.

Clicking this button opens the Simulation Configuration dialog.
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CONFIGURING THE SIMULATION

t‘ Configuration

Several aspects of the Simulation can be configured by pressing the button the Simulation

section of the Strategy tab on the Ribbon . This opens the Simulation Configuration dialog.

Simulation Configuration
General configuration
Simulation Speed |Norma| j
Display Progress As |Runtime j

Current simulation configuration

Start time/date 174618 = 14082018 ~|

Cancel ‘

The Simulation Cycle

The basic unit for simulation is a Simulation Cycle. This corresponds to approximately 1 second of runtime on a
controller. Some modules (Hardware, Globals, time dependent modules) will be processed a fixed number of time
during a cycle. Most of the other modules will be processed a number of times that depends on the size of the
strategy. The bigger the strategy, the less the modules will be processed.

Simulation speed
The Simulation can be run manually (“Step by Step”) where each click on the start button runs one Simulation

Cycle, or automatically at one of 3 speeds: Slow (once cycle every 5 seconds), Normal (one cycle per second) or
Fast (5 cycles per second).

Display Progress As:
The progress of the current simulation is displayed in the right-most section of the Simulation Toolbar. This

progress can be displayed as Runtime (number of seconds since the simulation started) or Date/Time (current
simulation date and time)

Current simulation configuration

Start time/date:

When the Simulation Cycle is run, any time and date dependent modules — such as Time Schedules or
Datalogs/Trendlogs - will use a simulated time. The value used will be the time and date set in the Current
simulation configuration Start time/date field of the Simulation Configuration dialog, incremented by one second
on each Simulation Cycle.

This allows a Strategy to be tested for unusual behaviors at specific times such as daylight savings time, year-end,
leap years, etc.

The value of this time and date will be displayed in the right-most section of the Simulation Toolbar if the Display
Progress As field is set to Date/Time.
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RUNNING A SIMULATION

When a Simulation runs, the labels at the end of lines will be updated to show the point values.

log Setpaint N A-B Comparator 1
t Protection o .
Piint £ jr= Input A Output [0 .
: 1
Input B Complement [ L
T S -
— | v Outside Air
alog Inport Tem peraturaf
1tside Air N i
5 | " Analog input
& Inpu
¥P . .FI Diigital inpast
og/Digital Type: Analog e
tharad/MNitherad: Nithered £

A green background means that the value is calculated by the simulation.

A red background indicates that the value has been overridden by the user.

Note: It is possible to add, update, and delete modules and lines while the simulation is running. The
simulation will take it instantly into account in its calculations.

Livelog

During a simulation, the livelog will display values from a simulation run so that it is possible to viewpoint values
from different parts of the strategy simultaneously.
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POINT PROPERTIES

The Simulation mode has two sets of point properties:
e one forinput points that feed into the Strategy (hardware inputs and Globals’ destinations),

e one for all the other points whose values result from the Strategy’s internal calculation.
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Accessing the points properties

To open the Simulation Properties for a specific point right click and select Simulation properties . This can be done
on either Lines, Hardware /0 modules or connected nodes:

Lines
oM parator L
Digital Output 7
Oupt ey pp DO goiler sviiech
Complement (3 — i !
Convert Line to Connector
Datzlog Tes - =
utside Air Simulation H{gpemes
Tperatured T ——
i
t

Hardware 1/0 modules

‘Analog Input BN
Al Outcite hir
T

ure

Simulation properties

BEEEER

Connected nodes

| N Qutside Air
Temperaturef
Analoq input

Hide lines

Add Destination Cennector

Convert Lines to Connectors

[ == ol

Simulﬁfion Properties
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Point value override

In a point’s Simulation properties dialog you can specify whether the value for the point will be calculated by the
Simulation, or set to a fixed value:

Analog points:

Point calculated automatically:
Poirt Value I Poirt Logging |
All Paints
( ™ Ovemide 0.00

|— Input points
o 1

Point is overridden and set to 18.5:

Pairt Value I Poirt Logging |

All Points
’7 W Qveride 185D

Input paints

| - -l

Digital Points:

Point calculated automatically:
Point Value I Point Logging I
All Points
’7 [~ Ovenide |

Input paints
I i _ — I ‘

Point is overridden, and set to “0ff” (boolean @)

Pairt Value I Poirt Logging |

All Paints
’7 v Ovemide r

Input paoints
I Kl _ — I

Point is overridden, and set to “On” (boolean 1)

Point Value I Point Logging I

All Points
’7 v Qvemide v

Input points
’7 INnne LI
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Input point options
For an input point, a selection of options is available to simulate different types of inputs. For Digital points there
are two options, for Analog points there are 7:
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Digital Input point options

Input paints
I Mone ;l

Fieed
Periodic change

¢ Fixed value
The point will have a fixed value throughout the Simulation run.

Value is “Off” for the whole Simulation run:

— Input paints
[ B
Value: r

Value is “On” for the whole Simulation run:

 Input paints
[ Foced -]
Value: v

e Periodic change
This option will change the value of the digital point during the Simulation run.

If the Random period box is unchecked, the value will change after the Basic Period specified:

Input points
IF'eriodic change ;I
Random period r
Basic period |2 Secs. LI

If the Random period box is checked, the value will change after a random period which is less than the specified

Basic Period:
Input points
IF‘eriodic change ;I
Random period v
Basic period Ia Secs. LI
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Analog Input point options:

— Input points

Random Value

T

Maone
Fixed

UUp (down) onby

Up {down) anby with limit
Up and down

Values from File

V‘S—
7.00

1.00

e None

The point is not assigned a value. The value will either be the last value that the point had, or zero if no previous

value existed.

Input poirts

e

e Fixed

The point will have a fixed value throughout the Simulation run.

— Input poirts

Foeed

Value:

=l
|1ﬂ|

12

10

—Cariesl |

e Random value

During each simulation cycle, the point will be assigned a random value between a given minimum and maximum.

— Input points

Random Value

Min Value:

Ma Value:

=
—
T

mmmmmmmmmmmmmmmmmmmm
AN M T TWmEe~® B0 e N NMm T
IR R
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e Up (down) only

The value will change in only one direction (up or down). Use a negative step limit to go down.

— Input poirts .
IUp (down) onhy j 160 /
140 /
Start value |5 120
100 /
80 // ——Sseriesl
60 /
40 /
20
>
IFmedstep LI |1| B e
—Input points P
-
Up (dawn) onhy - 80
| <] - —
Start value |5 s
50 /
| 20 // —Seriest |-
30 /
20 /
10 Vol
[Random step up to -] I1 T RETIrEAERERERGGE
¢ Up (down) only with limit
The value will go from a Start value to a Stop value.
—Input points 120
IUp (down) onhy with limit j 100 /
Start value |5 8 /
&0 —Seriesl
Stop value I'ID'D /
40
./
o
IF\MBd Step LI IH 1 4 7101316192225283134374043464952555861646770
— Input paints 120
Chart Area i
IUp (down) only with limit j 100 /ﬁ
Start value |5 & /
50 i
Stop value I'H}I] / Tosenest
40
" //
Handcnm step up to vl IEI. o
14 7101316192225283134374043464952555861646770
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e Up and down

The value will go up and down continuously between two limits either by a specified step (fixed or random) with a
specified period (specify the time to go from one limit to the other).

—Input points
Up and down ;I 2

15

Stop value |25‘ T erest

10

30

For up to ID INnne vI s
[Feed step ~| o4
A M~ O N T OO0 A M 0o N T W
SNEZREIANAREENRE

— Input points 16

IUp and down vI 1

e e W awavavaw, |
Stop value |25 ; E’MA%; —seriest |

4
Far up ta ID INnne vI s
o
Handc-mstei:luptn vl IE'-5 S IRSCEZRYIEENARS DT
ENZEEESRERESRAE
— Input paints

IUp and down j 1: / \ / \ / \
Start value |15 0 // \\ // \\ // \\

Stop value |25— - : / \v/ \V/ \ —series1

Forup to |1| I Mins. LI ‘

e Values from file

The point value will be taken from a datalog file — at each simulation cycle, the next value will be read from the
file.

This allows using real data such as a datalog of outside air temperature in the simulation. It also makes it possible
to repeat a simulation exactly if the input points from the original simulation have been logged.

— Input poirts
Walues from File j

File |
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POINT LOGGING

Paint Yalue FPoirt Logging

Mone
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Time stamped logging

Foirt Walue Point Logging |

Time stamped logging -

File [ .
Sample interval IBDD

Datalog capacity 1024
(50-4036)

Any point in the strategy can be logged to a file. This can be used to review values after the strategy has run, and
analyze issues. It can also be used to feedback the value in another simulation (see “Input points options”).

Note: Logging will occur only if both
1. the settings in the point Simulation properties dialog are set and

£

2. the logging button stari/rause iS pressed in the Simulation section of the Strategy tab on the

Ribbon .

This means that logging can be switched on or off during a simulation by clicking the logging
button.
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OVERVIEW

A site is the name given to one or more controllers, optionally connected to a PC. The following are examples of

sites.

e A standalone Field Controller.

e  One BACnet Router with a Fieldbus of one or more Field Controllers

e A network of BACnet Routers, each with a Fieldbus of one or more Field Controllers, connected to each other
via TCP/IP.

Sites are configured in the Configuration program.
Some common procedures carried out on sites include:

e Installing a new site on the PC (see page 204)

e  Site backup (see page 205)

INSTALLING A NEW SITE ON THE PC

To install a new site on a PC, the Cylon Software Suite must be installed already.

A new site is one which has not been installed on this PC before, and for which a backup from another PC does not

exist.

WHAT HAPPENS WHEN A NEW SITE IS INSTALLED

Installing a new site involves the following events:

e  Site-specific directories are created on the hard disk.

e Site-specific information (information about network ID, telephone number, ID code, etc.) is entered in
the WN3000.ini file.

e The network size (the number of BACnet Routers) is specified.

e The BACnet Routers and Field Controllers are named.

The Configuration program performs all these steps. For further details, see MAN-0041 Configuration User
Manual.

Note: Do not manually make entries to the WN3000.ini when installing a site on the PC. All necessary
changes will be made to the WwN3000. ini file by the Configuration utility.
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HOW A NEW SITE IS INSTALLED ON THE PC

Installing a new site on the PCinvolves the following procedures:

e Naming the new site in the Configuration program.
e Entering the size of the site (number of BACnet Routers) in the Configuration program.

saMs

e Naming the BACnet Routers and Field Controllers in the Configuration program.

e If the site is not a remote site, it can be configured as the default site (see System Configuration on page
33).
e  Restarting Microsoft Windows and the CXpro"P for the changes to take effect.

SITE BACKUP

Making a site backup means making a copy of all site-relevant data on the PC onto removable media such as
network, USB flash drive, external Hard Disk, or tape. A site can then be recreated on another PC running CXpro*®

from this site backup.

Making a site backup

To backup a site, right-click on the site in the Site Tree , and select Backup Site from the context menu:

Lo i e e

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

You will be prompted for a location to save the backup file:

"

©

410 THPC - Lol D) CXprD

= ==

Select any suitable device or folder and click Save .
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Restoring a Site from a backup file

To restore a site from a backup, right-click on the Sites node in the
context menu:

Site List R |
EO EF Discover Site

'"JE.E Import V7 Sites

- :I-E Restore Site

---JE_E Campus block R

A-5n PL Office

Choose the required backup file and click Open :

AL ThSPC > Local DIk (C) 3 CHproHD MIRET HI »

i Name - Date moddied Type

10020801
APPLBACN

Archive
g BACNEI
BACMSER
Bitmaps.
CaMPBLOR
2 Eugenepesio lp

B This PC PLOFFICE
sToRss
Symbolsh
System
Temp

o oicp
& Onebiive

3 30 Objeas
B Deshaop

& Documents
 Downlonds
b Music

Templste
UCTMecros
= Pictures Utities
B videe:
u Local Disk €)
CXproD
Fie name: | ~| | CXprotD Backup (.CHB)

Open Cancel

Site Tree , and select Restore Site from the

If no site with the same name exists, then the restored site is added to the system as a new site.

If a site by the same name exists, the user will be asked to choose either to overwrite the existing site or to create

a new site.

e If you choose to overwrite the site that has the same name, the existing site will be completely
overwritten. You will be asked to confirm that you want to proceed.

e If you choose to create a new site, you will be asked to enter a new name, and a new site will be added

to the site tree. The chosen name must be unique.

You can cancel the restore process at any time.
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SITE DISCOVERY

Strategy block data can now be uploaded from Cylon controllers and re-assembled into an easy-to-view layout. This
is useful when you have a Site where you do not have existing Strategy drawings or other information.

The purpose of the discovery process is to determine all of the Subnets (i.e. a Fieldbus connected to a BACnet Router)
on a Site.

saMs

Note: All Subnets are searched so that the integrity of the data passed between Subnets (e.g. wide globals)
remains intact. This happens even if you are looking for information on a single Subnet.

This process can be lengthy, so please ensure that sufficient time is allocated for it.

However, you do not have to upload all Subnets at one time. If you specify a Subnet Range for a
specific upload, you can retrieve the other Subnets at a later point in time.

The upload process is started from the Site Tree , either from the Sites Icon (if the Site is not already in the tree) or from the

relevant Site node.

If the Site is not yet configured in the Site Tree

Click on the Sites icon in the Site Tree , and select Discover Site

Site List r B

Ex i
E-ic
E Import V7 Sites
L. =T 0BT - 001 - UCU3213v
: L. 001 - 002 - CBM24
E-To BACnet Serial
"'JE-E Sample Apps BACnet

Discover Site

This opens the Discovery Site Details dialog with all fields editable.

Discovery Site Details

Enter the details of the site you would like to discover below. For BACnet Sites with a
large number of devices, please ensure the Timeout value is large enough.

Site Details Network Type

Site Name " BACnet Serial

Site Directory * BACnet IP
Site Number |4 (Next free: 4)
Device ID Range |1 to [4134302
Wait Timeout (s) |25
MSTP Network
Cancel

Enter the Site Name and Site Directory directory.
If you do not want to retrieve all Fieldbusses on the Site, specify a Subnet Range .

Sites can be uploaded either through TCP/IP or through a serial connection. For TCP/IP connections, include the IP

Address and verify the port. Port 4950 is the default.

When configured, click Discover .
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If the Site is already configured in the Site Tree

If the Site is represented in the Site Tree —i.e. if it has been configured locally configured using the Configuration
Utility (CCConfig), click on its node in the Site Tree and select Upload Site :

Site List A x|
Sites

2o BACnetIP

o BACnet Serial

= JE.E Camr--—l..l....l,ﬂ :
EE ol Discover Site %

...... =
Export Aspect Data
o PLOf
EI_E_ ol Create BACnet EDE Data

@,, 001 - 001 - CEM24
JE_E Sample Apps BACnet

= B 01 - Wet Sucteme

Discovery Site Details

Please ensure the information is correct for the site you would like to discover, For
BACnet sites, ensure the Timeout value is large enough.

— Site Details — Network Type
Site Name |Campus block R ' BAChet Serial
Site Directory |CAI\-1PBLOR & BACnet 1P

Site Number | 5
Device ID Range “ to [4194302

Wait Timeout (s} |25

MSTP Metwork

Discover I Cancel |

The Discovery Site Details dialog will be displayed as before, but in this case, the Site details are not editable.
When configured, click Discover .

After the discovery process is started, the Site Discovery Progress dialog appears showing its progress:

Site Discovery Progress

Below is the progress of the discovery process. Please wait until this is finished before
attempting to communicate with another site or press cancel to finish the process early.

r~ Site Details Summary
Name ’m “I-Am" Received Count ’O_
Mumber ’57 Properties Read Count ’0_
Network ’W

r Controller Discovery

Calling Whols on Network...

Reading Device properties...

Attempting to connect to site <Campus block R>... Cancel |

If you click Cancel to stop the process, any uploaded information is discarded and not applied to the Sitein CXpro*®.
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When the discovery has concluded, the discovered Fieldbusses /BACnet Routers are displayed in the Discovery Results

dialog:

7 Discovery Results - X
-~ Site Details Summary

= Tester Comms Contrller Count 1

Number |8 Field Controller Count 2

Network TCR/P

[ Name | Num | Default Type ['uc32 | No. Types | Version [ IP Address | I

3 o01-ucaanet 1 UC32.netk/WEB.. Y 2 netWH 2.03.03  192.168.5.46
= o01-uc3224 1 uc3z Y 3 Uc3z246.2.1
= 002-UC3216 2 uc32ie Y 2 UC32.166.2.1
Expart to CSV Rescan " Eentinie Cancel

saMs

The Export to CSV feature provides a convenient way to get subnet information and firmware versions of

controllers in the networks in CSV format that can be easily imported into Microsoft Excel.

If all known BACnet Routers are displayed and online in the Discovery Results dialog, click Continue to upload Strategy

information.

MANO133 rev 15

© Cylon Controls Ltd.

209



an04dxD

ASPECT® / INTEGRA™ EXPORT

This feature saves data for a Controller, Fieldbus (Subnet), or Site into a JSON-formatted text file for import into
ASPECT® or INTEGRA™, allowing applications to be automatically configured in ASPECT®-Studio or INTEGRA™ IT-
8000.

Starting the Export

To export a Field Controller, BACnet Router, or Site, right-click on its node in the Site Tree and choose Export
ASPECT/INTEGRA Data .

&

BACnet IP
BACnet Serial

[{m

Discover Site

BB &3]
E'“E'"E”E'DE"

b port Aspect/integra Data
Create BACnet EDE Data
Upgrade BACnet Units

If a Field Controller is selected, that controller’s information is exported to the ASPECT® / INTEGRA™ . json file, along
with the parent network and parent site information as required to correctly import into ASPECT® or INTEGRA™.

If a Fieldbus is selected, information for all controllers in that Fieldbus is exported along with the parent site
information as required to correctly import into Aspect.

If a Site is selected, information for all Controllers on all Fieldbusses within that site will be exported.

The points that will be exported will be those that are specified in the Export column of the BACnet Points dialog.
The BACnet Points dialog is opened by clicking on BACnet Points in the Strategy tab of the ribbon — see How to
expose Points on a BACnet system on page 139.

x|

- Select BACnet

BACnet | Bxport | Point Name [_pointadar [ PointType I
2 [m] oom Setting 5 Analog Setpoint
[m} axHWater 28 Analog Virtual
[m} e odl 28 An;
‘el o 30 An;
=] e e 2 An;
| [remperature | _5___[naloginput __]
arm Enable 2 Digital Setpoint
[m] Digvirt 3 H Digital Virtual
o Scnedule No. 1 (On) 4 Digital Virtual
(m] Hysteresis Block 15 Active High 9 Digital Qutput
BACnet Point Usage [~ Binary Unit String Usage ——————————
Maximum BACnet [22e Maximum Binary Unit — [52
Used BACnet ,T Used Binary Unit |3_
Available BAChet B Auailable Binary Unit [
Export Total =
Setpoint Li
Max Unexposed Setpoint and BACnet [ 324 Unexposed ]
Available Setpoints / BACnet Points 31e

Resolve Duplicate Paint Names
oK Cancel

210 © Cylon Controls Ltd. MANO0133 rev 15



After exporting, set a name for the export file that you want. By default, it is set to the name of the Site. The
filename extension must remain as . json for easy import into ASPECT® or INTEGRA™.

= Save As
T . « CproHD » CAMPBLOR v ¢ Search CAMPBLOR »p
Organise * MNew folder 3= v [7]
| AITEMP A Name : ~
.. CXproHD
.. ARCHIVE
. APPLEBACN
. dbase
. Archive
./ DRAWINGS
.. BACNMETIP
.. KEYPAD
.. BACMSERI
. MACROS
. Bitmaps
. strat3
.. CAMPELOR
.. STRATEGY v
. ARCHIVE wila >
A RN Campus block R.json| v
Save as type: v

“ Hide Folders

Save Cancel

After setting the filename, click Save .

The process will begin to export information. The Creating Aspect Data... dialog will be displayed to show the
progress of the export:

Creating Aspect Data...

0071 - UC32netk. - 007 - UC3224
Processing: E of 12

o1
ool
o001
ool
ool
o1
ool
o1
ool
nm

- UC3Znetk
- UC32netK -
- UC32netk -
- UC32netK -
- UC32netK -
- UC32netkK -
- UC32netK -
- UC3Z2netk -
- UC32netK -
- HE 2 natk -

- 012
012 -
012 -
012 -
012 -
012 -
012 -

o011
o1
1

- UC3224:
uc3z224:
uc3224:
uc3z224:
uc3z224:
uc3zz4:
uc3z224:
- UC3224:
- UC3224:
- HC 224

Datalog block 14 has a connected point that iz not named. A
Datalog block 131 has a connected point that iz not named.

Datalog block 250 has a connected point that is not named.

Datalog block 251 has a connected point that is not named.

Datalog block 252 has a connected point that iz not named.

Datalog block 253 has a connected point that is not named.

In path “/C/Aspect_v_Unitron/001_UC32netk/012_UC3224", "reset” iz a reserved word
D atalog block 14 has a connected point that iz not named.

Datalog block 131 has a connected point that iz not named.

Natalon black 260 has a connected noint that ie ol named

>

Close |

For any errors or warnings encountered, you will see the network (Fieldbus) name, the name of the controller, and
the action that should be taken. Correct these errors in the appropriate Strategy or configuration and then start
the Export process again.

You may stop the export process at any time and review the errors and warnings.

You may copy the errors and warnings from the dialog into a document or email.

When finished, click Close to complete the process.

Import into ASPECT®-Studio and INTEGRA™-ProPack

Refer to MANO129 ASPECT®-Studio for details about importing the . json data into ASPECT®.

Refer to MANO140 INTEGRA™ ProPack for details about importing the . json data into INTEGRA™.

MANO133 rev 15
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Launching CXpro"° from INTEGRA™-ProPack

When an export file from CXpro"® is imported into an IT-8000, it is then possible to launch CXpro"® from the
INTEGRA™ Ul — targeting a specific controller for engineering or debugging.

In order to do this, ensure you have CXpro"® installed on your computer, and INTEGRA™ version 4.7 or greater is

installed on the IT-8000 or supervisor. Also, ensure that the CylonService is installed.

You must also have a copy of the CXpro"® project and strategies in CXpro*P.

Note: The CylonService uses the site name and device instance numbers to locate the strategy in CXpro*®,

so you must ensure that the site name in the INTEGRA™ station matches the site name in CXpro*P.
To verify or edit the site name in the INTEGRA™ station, open the property sheet for

CylonBacnetNetwork :

! Config @ Drivers

: CylonBacnetNetwork

P

roperty Sheet

@ cylonBacnetNetwork (Cylon Bacnet Network)

To launch CXpro®®, right-click on the Cylon controller and choose Launch CXproHD :

[ status

[ Enabled

@ Fault cause
3 Health

© Alarm Source Info
L Monitor

B Baenet comm
Bl Local Device

X Tuning Policies
[ site Name

@ uploadonstart
I INTEGRA

6 Drivers

6 NiagaraMetwork
e CylonBacnetMe
‘ Local Device
E Bacnet Com

Q Monitor
I chiller

A FirstFlonr

X TuningPolici

-
s CEX_ 8RS

{ok}

@ true

Ok [06-May-19 10:34 AM EDT]
Alarm Source Info

Ping Monitor
Bacnet Stack
Local Bacnet Device [device:10000]
Bacnet Tuning Policy Map

ProPac

@ e

9

o

BacnetDeviceFolder:INTEGRA

Launch CXproHD

Views

Actions

Edit Ta

gs

[LELERE

Cut

8RE Cylon Bacnet Device

Cylon Bacnet Device

204 3T Cylon Bacnet Device

2iVAY Cylon Bacnet Device

er Cylon Bacnet Device Folder

Cylon Bacnet Device Folder

1 Cylon Bacnet Device Folder

Cylon Bacnet Device Folder

00c¢c

00c¢

00c¢
00c¢

CXpro"® will open at the project and the last-saved strategy for the selected controller, allowing you to debug, make
code changes, and download it to the controller.

@ services

 orives

rs

 NiagaraNetwork
 cylonBacnethetwork

© apps
& Files

alette
X 3 &«

3 cylonservice

Bl Local Device
E Bacnetcomm
3 Monitor
X TuningPolicies
I chiller

o CBi_RS
I Firstrloor

lonService

 CylonBacnethetwork

4 CylonBacnetDeviceFolder

L_idelectAll | Modules Text Terminals Modules o Uratégy Uetalls
site. Controller Clipboard Strategy
FEnB -
site List o x [ 002_01.532
E-@g) Sites
BT 10020600
2o 10020801 .
=) Analog Input 1
B in 10020801 Al SWT-M"D
@-2g 10020801 T .
2o BACnet P S O g *
B~ g BACnet Serial . . .
B-2g CBXERS
= cylonimport_1000 Al Analog Tnpi
B g NewSite RWTemp . Co
B-£g ProPack Faint Ol f————8
o5 cexi Overide
&), CBTI2ivAY N
""" =) cev () SWTSEPE ) ) )
25 INTEGRA ] o Sl ————8
& ceiere : . .
mple Apps BACnet
Digital Input. e
DI bpisim
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ADDING UNITS OF MEASUREMENT

Additional units of measurement may be added to the existing list of units in a site to allow for a greater range of
applications. Units must be added to the site.ini file in the C:\CXproHDCXpro®P?\ (SITENAME)\SYSTEM
directory

Note: Before changingthe site.ini file, make a backup copy (for example, site.ini.bak).

The site.ini file can be edited in a word-processing program such as Microsoft Windows Notepad, or Microsoft
Word. If you use Word to edit the file, make sure to save the file as a "Text Only" document.

How to add units of measurement to the system

e  Make a backup copy of site.ini.
e Opensite.ini, usingaword processing program.
e Searchforthe [AnalogUnits] section if adding analog units, and the [DigitalUnits] section if adding
digital units.
e  Either
o edit one of the entries marked “spare”
(e.g. change UNITS61="Sparel" to something like UNITS61="m/s")
or
o append the new units to the list of units
(for example, add something like UNITS74="m/s" to the end of the list of analog units).
If you add to the list in this manner, be sure also to increment the NumberUnits parameter so
that it matches the final number of units. Ensure the number at the end of the units variable
(e.g. UNITS74) has a number at the end that matches its place in the list of units.
e Save theamended site.ini file.

e Close and restart CXpro"®, to allow the changes to take effect. The new units can then be selected from
list boxes for point configurations.

214
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EXAMPLE OF ADDING UNITS TO ANALOG UNITS LIST

40 syun Suippy :: xipuaddy

0ld analog units k=t: Hew list after changing:
[inaloglinits] [inaloolinits]
MmberThics=13 MmberThits=z1
Ticle="ITI" Title="Tnic"
TNITS1=" " THNITS1=" "
TNITZE=" %" TNITSZ=" %"
TNIT33=" %rH" TNITS3=" %rH"
THITS4=" °C" TNITS4=" °C"
TMIT=E=" Bits" UNIT2E=" Bit=s"
TNITS6=" oikg" UNITSs=" g/kg"
TNITS7=" Hz" THNITS7=" Hz"
UNITZE=" ki kg" UNITSS=" ki kg
TNITE2=" EWh" TNITSS=" k"
TNITS10=" Lfs" TMITS10=" Ls="
TNITE11=" Min" THITS11=" Min"
TMIT=E1lz=" mW" TUMITE1E=" my™
TNIT313=" Pa" THNITS13=" Pa"
TNITS1l4=" Zek" THNITS14=" Zek"
TNITS1E=" ZBtd" THNITS1E=" Std"
TNITEle=" Wolt" THNITSle=" VWolt"
TNITE17=" bar" THNITE17=" bar"
TNITElg=" E" THNITS18=" E"
TMIT=E19=" Uhr" TUMNIT212=" Uhr"
THNITSZ0=" m/=s"
THNITSZ1=" ko/m3"

Note: Units are also listed in the C:\CXproHDCXpro#P\SYTEM\WN3000.1ini. However, this file is for
legacy applications only and applies throughout the Cylon Software system, and so must not be
edited.

Note: Take care when editing site.ini not to change the section headings [AnalogUnits],
[DigitalUnits], etc.in any way, because this can cause errors in the Cylon Software system.
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FILE MANAGEMENT IN CXPRO™P

On a large site with multiple BACnet Routers where more than one engineer will be commissioning software at
any one-time file management becomes very important.

You must ensure that no one modifies the same strategies / global files that an engineer is currently
commissioning. To guard against this, we would recommend that all files are stored on a central computer and
only the files required for commissioning are copied onto the engineer’s laptop. We would also recommend that
each engineer is allocated a single BACnet Router to work on at any one time. At the end of each
day/commissioning period, the data files for the BACnet Router are copied back onto the central computer.

The data files required to commission a single LAN are as follows:
C:\CXproHDCXpro®P\ [SiteName]\dbase \* Where * is the address of the

BACnet Router to be
commissioned.

All files under Where *** is the address of

C:\CXproHDCXproHP\ [SiteName]\strat5\*** the BACnet Router to be
commissioned.

The same files should be copied back to the central computer at the end of each day/commissioning period.
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CXpro"'® includes two utilities that facilitate the commissioning of BACnet Sites: the integrated Discovery Tool,
accessible from the Site Tree , and the separate application NB-Pro.

NB-PRO
NB-Pro is a generic commissioning environment for BACnet controllers. Using NB-Pro, users can setup and
configure devices to create control programs and strategies for building automation systems, including Cylon
BACnet. For details see MANO122 NB-Link & NB-Pro.
Note: For NB-Pro to work with CXpro"®, you must open the Settings menu NB-Pro and select Network
Configuration . In the Network Configuration dialog, select the Remote IP radio button in the
Communicate Via: section so that NB-Pro does not attach to the BACnet UDP port of the PC as this
would block CXpro*®. Also, register NB-Pro as a foreign device on a CBR on the network by entering
the CBR’s IP address in the Network Configuration dialog’s BBMD Device field.
DISCOVERY TOOL
The purpose of the Discovery Tool is to allow users to see all live BACnet devices, objects, and properties on the
network via CXpro"®. It also allows some or all of the discovered objects to be added to an existing Engineering
Centre Site or allow a new Site to be created with the discovered objects.
For existing sites, this tool is used to compare the site configuration with the devices that are live on the network.
It is possible to change the present value property of some objects.
BACnet Explorer
The Explorer is an extension of the Discovery Tool. It is available in CXpro®® by right-clicking on a BACnet Site in the
Site Tree and selecting Discover Site .
Site Navigation x
E@ Sitex
Show Globals lssues Report
This opens the Site Discovery dialog, which is prefilled with the selected Site’s information:
Site Discovery
Please ensure the information is comect for the site you would like to discover.
For BACnet sites, ensure the Timeout value is large enough
—Site Details
Network Type
Site Name IEast Hall " Serial Connection
B SoTH  Unitran
Site: Directory IE.~.STH L P
Site Number Il = Remote Connection
' Unitron
Address Range |1 to [r192302 - ;‘AénetTFE':PJIF
Wait Timeout () [25
MSTP Metwork Nc.l
Discover I Cancel
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If the Discover Site option is selected from the context menu of the Site Tree’s root node,

x

Discover Site

A B | acal Mebwnardk

then the Site Discovery dialog will be blank and can be used to create a new Site.

Site Discovery
Enter the details of the site you would like to discover below. For BAChet Sites
with a large number of devices, please ensure the Timeout value is large
enough.
— Site Details
Metworls Type
Site: Name || ™ Serial Connection
o  Uritron
Site Directory
l " BAChet
Site Number I ¥ Remote Connection
Address Range |1 to [+134302 " Uniron TCP/IP
" BACnet IP
Wait Timeout {s) |25
MSTP Network No.l
Digzover | Cancel |

The Site Discovery dialog has the following fields:

Network Type
(If an existing Site is selected, this selection cannot be changed).

If a site is not selected, select a Network Type that will apply if you choose to create a site from the Explorer during
the current exploration:

e Network 1 for Serial and Modem Sites

e Network 2 for TCP/IP or BACnet Sites

Site Name
(If an existing Site is selected, this field will not be editable).

If a site is not selected, enter a new Site Name here. If you choose to create a site from the Explorer during the
current exploration, this is the name that will be used for it.

Site Directory
The Site Directory is automatically generated from the Site Name , but it can also be user-defined. Do not use special

characters in the Site Directory Name.

Site Number

(If an existing Site is selected, this field will not be editable).

If a site is not selected, specify a Site Number . If you choose to create a site from the Explorer during the current
exploration, this is the Site Number that will be used for it.
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Address Range

Wait Timeout (s)

Larger Sites require higher Wait Timeout(s) to explore the entire site (default 10 seconds)

Network

This sets the length of time that the process will listen for I-Am responses during discovery.

This can be used to limit the Discovery process. Only BACnet addresses within this range will be tested.

The user can choose a specific network to discover in this dialog box. If the user enters a network number, only

devices on that network will be displayed. Leave this blank if you want to show devices on all networks.

The Discover button will launch the progress dialog.

— ]
Site Discovery Progress

before attempting to communicate with another site or press cancel to finish
the process early.

Below is the progress of the discovery process, Please wait untl this is finished

[ Site Details Summary
[eom I BACnetExplorer Online Devices 0
Number I 5 Current Device 0

Network I BACnet

i~ Controller Discovery

Calling Whols on Metwork...

] =/l 9

Reading Device properties, .,

| )| I

i Cancel

Calling Whols on Metwork...

A Whols call is made, and then the system waits for the specified timeout (default is 10 seconds) after which it
reads the BACnet information for each Device that responded with an I-Am message. When this is complete, the

results dialog opens:
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>
©
e
g
Mot DL e
Cylon BACnet Explorer E\L %
- Site Details I B
Name BACetExplorer This is the BACnet Explorer dialog. g
(@]
Number 5 =
o
Num, Devices |8 G
m
x
BACnetExplorer Name | MAC | Def.Type | Types | Model [ D [ vendor | Network | P Add | =k
=] Cylon BACnet Router - Chris (50 | Cvlon BACnetRo... 1 CBR. 3 Cylon BACnetR... 6000 171 a 132.168.6.38 2
i & ObjectList Unitron Slave UC... 1 UC32.24B... 1 UnitronVirtual ... 1220 171 61000 o
O JRet-Lis Controller type ... 14  UC32.34B... 2 uc32. 24 1054 171 £0000 7]
Unitron Slave UC1 (2) (1220 | Cylon BACnetRo... 2 CER. 3 CylbnBAChetR.. 49 171 0 192.168.6.40
Controller type UC32.24 (1¢ | Controller type U... 1 UC32.24B... 2 uc3z.24 6767 171 51
| Controller type ... 2 UCU12BAC... 2 ucu1z 3752 171 51
B~ [¥]== Cylon BACnet Router 43 (48) | cyion BAChetRo.., 3 CBR 3 CylonBAChetR... 141077 171 0 192,168.6.35
16 objectiist 001-UC3224BA.. 1 UC32.24B.. 2 ucsz.24 14078 171 51
2 UCU12BAC.. 2 ucu12 14079 171 51

Controller type UC32.24 (57 | 002 -CET12
Controller type UCU12 (375
- [/]5. Cylon BAChet Router 43 (14107
[ object-List

001 - UC3224 BACnet (1410
[¥]'= 002 - CBT12 (141079)

< mn 2

I Select all devices to add to Site Rescan Network | Add Selected Devices to Site Close |

Number of devices found: 9

The results dialog contains two panels:
e The left panel contains a tree view list of the BACnet devices and objects discovered.
e The right contains information regarding the selected device or object.

It is possible that not all devices would be discovered during the specified Wait Timeout(s) ., so if necessary you can
re-scan the network for further devices by clicking the Rescan Network button. The Site Details dialog will open
again so that the settings for Address Range , Wait Timeout(s) and Network number can be adjusted. Devices that
have already been discovered will be skipped, so that further devices may be discovered even if none of the
settings are changed.

The tree view is similar to the existing site list in other applications. The site is the root node of the tree, followed
by the routers and then devices under those. Under the device nodes, there are other nodes in the Object List.
Expanding this will show each object read in from the parent device.

As an extension of the Site Discovery Tool, the Explorer allows devices to be added to the Site specified in the top
left corner of the Cylon BACnet Explorer dialog (which may be an existing site or a new site that will be created when
devices are added).

To add devices to the selected site, check the box beside each required device in the Site Tree and click on the
Add Selected Devices to Site button. To quickly select all of the discovered devices check the Select all devices to add
to Site box beneath the Site Tree. Non-Cylon devices will be added as virtual controllers and have a Cylon address

of 131 or above.

When the root of the tree view is selected, the right panel contains a list of the BACnet devices found, along with:
device name , MAC address , vendor ID , model name , IP or MSTP Address , Network, and estimated Controller Type .
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rSite Details
1
= BACnet Explorer This is the BACnet Explorer dialog. Below is the list of devices that were discovered. To edit any of the details double dick on an
item in the list. To begin reading in the object list of a device expand its node in the Tree View.
Number g Any newly discovered devices will be in white, Devices that have already been configured will be highlighted in Green or Red.
Green means that the device discovered matches the addressing of the site configuration. Red means there has been a dash
MNum. Devices |8 between the device information discovered and the device information in the site configuration.
|
Mame | MAC I Type I No. Types I Model | Instance I Wendor | Netw... | IP Addr
B Cylon BACnet Router 49 (3000) | Cylon BACnetRo.., 1 CER [ Cylon BAChetR. .. 3000 171 515 192,163.6,4
s ObjectList Controller type U... 4 CET13VAV 1 ucui13 2221 171 515
Cylon BACnetRo... 2 CBR [ Cylon BACnetR. .. 43 171 77 192.168.6.3
[#]'=) Controller type UCU13 (222 | Controller type ... 1 CBM24 1 uca.24 141078 171 7
B- Cylon BAChet Router 49 (43) UCU12 CT12229... 2 CET12 1 ucu12 141079 171 77
0 Object-List
Controller type UC32.24 (14
+ UCU12 CT122290324 (1410
4 1 [ (1] | +
[V Select all devices to add to Site Rescan Metwork Add Selected Devices to Site Close |
[~ Sort Objects By Instance Number

Number of Devices found: 8 /4

There is also a column ( No. Types ) which shows the number of possible Cylon controller types this device could
be.

Cylon devices are initially set as a CBM24 controller type, but this can be changed in the Controller Properties dialog.
The ‘Type’ of a non-Cylon device cannot be changed in the Controller Properties dialog, but if they are added to the
Site, they will appear as CBM24 in CXpro"®, and this can be changed in the Configuration utility (CCConfig).

To open the Controller Properties dialog, double-click on the device in the right-hand panel.

e

Controller Properties

r Controller Details

Name I Controller type UC3224
Model I UCc3z2. 24
Address I 1

—Controller Details

MName I BASRT-E
Model I BASRT-E
Address I 4

Possible Types | 3rd Party ;I Possible Types ICBM?A |
Device Instance 1920 Device Instance I 141078
Number Number

oK I Cancel | OK I

You can then change the Name , Type, Address, and Device Instance Number before adding them to the site.

Note: This will only change the name of the device in the database on the PC, it will not change the name
on the device itself.

When the device node of the tree is expanded or double-clicked, the object list of that device will be read in. As
each object is received from the device it will be added as a child to that device node. At this stage, the right-hand

panel will display the object list with a column for object ID, object type , object name , and present value and this
list will be populated as objects are read in.
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" Cylon BAChet Explore

- Site Detail

Name BACnetExplorer
Number 5
Num, Devices [ 10

This is the BACnet Explorer dialog.

[ 8 objectist

- [] @ 1.17 analog (17)
[J @ 1.18analog (18)
[ ] & 1.19 analog (19)
[J @ 1.20analog (20)
~[]@ 1.212nalog (21)
[J@ 1.22analog (22)
-~ ] @@ 1.128 digital (129)
[J@ 1.130 digital (130)
& 113t diital (131)
-] @ 1.132 digital (132)
I 1.133 digital (133)

& [V]E) Controller type UC32.24
~[] @ Contraller type UC3
‘ ] 6 sACnet RTC Trendic
16 sAcnetRTC Trendlc
%] Cylon BACnet Router 43 (49)

<

I™ Select all devices to add to Sit=

[¥] 5k, BAChetExplorer -

Cylon BACnet Router - Chris ’7

m

-] @ 1134 digital (134)

[ 6 objectdist -

Rescan Netwark

Object Name | ObjectID | Object Type [ value
Unitron Slave UC1 (2) 1220 (8) Device 0.00
1.17anzleg 17 (2) Analog Value 0,00
118 analog 18 (2) Andlog Value  0.00
119 anzleg 1 (2) Analog Value 0,00
1.20 analog 2 (2) Andlog Value  0.00
1.21analog 21 (2) Andlog Value  0.00
1.22 analog 2 (2) Andlog Value  0.00
1.129 digital 129 (5) Binary Output  0.00
1.130 digital 130 (5)Binary Cutput 0,00
1.131 diital 131 (5) Binary Output  0.00
1.132 digital 132 (5)Binary Cutput 0,00
1.133 diital 133 (5) Binary Output  0.00
1.134 digital 134 (5)Binary Cutput 0,00

Add Selected Devices to Site

Close.

Successfully read Object list from Device

When an object is selected in the tree view, the properties of that object will be read from the device and the

right-hand panel will contain the properties and values of that object.

From the results dialog, the user will be able to change the present value property for some of the objects.

Note: To refresh a specific object, right-click on that object.
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Check Against Existing Devices

When using the BACnet Explorer on an existing site, any discovered devices must be checked against those that
have already been configured. This is done by comparing the Device Instance Number of each discovered device
against the Device Instance Number of any devices on the site configuration already.

For any discovered devices that have the same Device Instance Number as a device on the PC, there will be a
comparison made between the MAC address discovered and the Cylon address.

e |f these match, the device will be highlighted in the list in green to signify that the devices match. A
matching device cannot be edited.

e [f they do not match, then the device in the list control will be highlighted in red to alert the user to this
mismatch. The user will be given a choice to resolve the mismatch

e [f the Device Instance Number does not match any other ID on the PC, then this discovered device will
not be highlighted and will be left white. Non-matching devices can be edited.

Changing the Present_Value Property

The present value can only be written to commandable BACnet objects. Commandable objects always have the
‘present value’ property and two additional properties —Priority Array and Relinquish Default.

e Analog Output, Binary Output, and Multi-State Output objects are always commandable.

e Analog Value, Binary Value, and MultiState Value objects can be commandable, but this is decided by the
vendor.

To change the present value of a commandable object, double-click on the present value property in the right panel.
If the object has the required properties, this will open the Change Present Value Dialog :

= r
Change Present Valus m M

Below is the Priority Array of the -

gelected object. To change a | Priofity | Value |
value, select the checkbox and
enter the new value, Leave the
value blank or set to "NULL" if
you would like to relinguish this
value.

MULL
MNULL
MULL
MNULL
MNULL
MULL
MNULL
mm
MNULL
MULL
MNULL
MNULL
MULL
NULL
12,567
2.58

Object Details

Device ID ,W
Object Name | Analog

Object Instance 10

Object Type ,m
Present Value 12.57

Th ke B v Ao e

—
n

REEOOO0OOO0ROOOOOO0O

[
@

Change Selected Values

Close |

The table on the right-hand side of this dialog shows the current priority array of the object. To change or relinquish
the value, you must select the checkbox beside the relevant priority index. By selecting the checkbox, you can edit
the value at that array. To relinquish that value, clear the contents in the box or set it to “NULL".

When the Change Selected Values button is clicked, the value for any priorities whose checkbox is ticked will be sent

to the BACnet object. This will update the priority array on the device and to show this, the list items,
present value andpriority array, in the Explorer dialog will be updated too.
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HOW TO CONFIGURE A CONTROLLER’S BACNET SETTINGS

When a Field Controller is first commissioned, its address must be set by connecting CXpro*® directly to the controller
by RS232 link (Service Port). If points on the controller are to be exposed on a BACnet network, or if CXpro*® is to
communicate with the Field Controller by BACnet Tunneling, then the Field Controller's BACnet address (Device Instance
Number) must also be set.

These device settings, and others, can be set from CXpro*"® as follows:

Note: Some parameters can be set over Ethernet connection, but Controller Address and Baud Rate can
only be set when the Engineering PC is connected to the controller by RS232 link.

In CXprofP, select BACnet Configuration from the Controller tab of the Ribbon

me Controller Strategy
%Communications lﬂ Download |_'_’E|Co
ect % Contraller )?:'EWipe Contraller Shs
#, BACnet & Auto Online

Configllx?tion
a

This opens the BACnet Configuration dialog, which defines how the Controller will communicate on the BACnet
network, and how it will communicate with CXpro"® for configuration over BACnet.

In this dialog, each current value and the proposed new values can both be displayed at once. Defaults can also be
automatically generated.

BACnet Configuration ﬂ
Controller Config Mew
Controller 1 ﬁ
Device Instance 666111 —
Device Name coi.oot.cem24 [[
site 4 —
Comms Ctrl 1 ,7
MS/T® Max Masters —
APDU Timeout —
MS/TP Baud Rate >
Use Config Values

_Receve | |_sena |

Reading from controller...
Close

Note: Only Device Name , Router Address, and MSTP Max Masters will be editable when the Engineering PC

is connected over Ethernet. In order to edit the other parameters, it must be connected by RS232
serial link.

The parameters that define how the Controller communicates on the BACnet system are:

228
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e Device Instance

Enter the required BACnet address (0 —4194303).

Note: The number set here in the Field Controller (when connected serially) must match the Device Instance
Number set in CXpro"®.

3
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e Device Name
Any descriptive text.

¢ Tunneling Properties: Site and Comms Ctrl

Note: All of the Cylon controllers throughout the BACnet system must have the same CXpro"P “Site
Number”.

In the Device Properties dialog set the Site and Comms Ctrl matching the position of this Controller in the Site
defined in the Cylon Configuration utility (CCConfig).

e MSTP Max Masters

This must be equal to or greater than the highest address used on the BACnet MS/TP fieldbus, because this
controller will not pass data to devices with addresses higher than this. The optimum situation is that this value is
set in all devices to exactly the value of the highest address on the fieldbus. (1 - 127)

Note: It is recommended that you address your controllers consecutively starting at 1, with the MAX
Master value matching the Maximum Controller address value. For optimum efficiency, there should
be no gaps in the device addresses.

e APDU Timeout

(@ ... 60 seconds) this value should be left at its default unless there is a problem.
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COMMISSIONING A RANGE OF CONTROLLERS QUICKLY (MASS COMMISSIONING)

CXpro"® includes a utility to quickly commission the MAC, Max Masters, Device IDs and Names of Cylon controllers.
The utility can be launched by right-clicking on a Site or a Router in the Site List :

LN < R 001_02.532

Export ASPECT/INTEGRA Data
Update BACnet EDE Data

Comi I. sion BACnet Devices

Site List L < ] 001_02.532 Site List
=] @ Sites El--e lgites
B-Fg 10020801 E-2g 10020801
E3-$o BACnet P So BACnetIP
o .
- JE_E BACnet Serial Zo BACnet Serial
o
[]--EE Campus block R Io Campus block R
o
E-3g Io PL Office
== Discover Site -2
Backup Site E,c
. Export ASPECT/INTEGRA Data (]
- JE.E Sarr Create BACnet EDE Data io Sample/
[]"EE Star Stores

| C%missron BACnet Devices
[

L

. 1Al

Note: The devices must be configured within CXpro"® before they can be accessed by this utility.

If launched from a router, only the devices on that subnet will be pinged. If launched from the site, all devices on

the site will be pinged.

Commission BACnet Devices

All Devices Serial Number | Network | MAC Device ins... | Name | Max Masters | Strategy Type
- CBV LIS - Integral Actuator CX16744168C 515 1 4000 CEX Chris Desk 50 CBV US - Integral Actuator
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: 0
— Offine f Misconfigured Devices
Serial Number | MNetwork | MAC Instance (PC) | Instance (Ctrl) | MName | Type (PC) | Type (Cir) | Strategy Type | Issues
515 3 3443 001-003-CB... (CBMO03 Strategy ID: 0 Offline
515 2 001-002 -CBX... CBX-3R8 Strategy ID: 0 Offline
< >
Recondle Issues |

Rescan | Timeout (s) |5

Close |

230

© Cylon Controls Ltd.

MANO133 rev 15



When pinging is complete, the Commission BACnet Devices dialog is displayed:

Commission BACnet Devices

All Devices Serial Number | Network | MAC Device ins... | Name | Max Masters | Strategy Type
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: 0
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~Offine / Misconfigured Devices

Serial Number | Network | MAC Instance (PC) | Instance (Ctrl) | MName | Type (PC) | Type (Ctrl) | Strategy Type | Issues
515 3 3443 001-003-CB... (CBMOB Strategy ID: 0 Offline
515 2 4000 001 -002 -CBX... CBX-8R3 Strategy ID: 0 Offline

Device instance does not m

< >

Recondle Issues |

Rescan I Timeout (s) |5 Close |

The upper-right pane of the Commission BACnet Devices dialog lists all of the devices configured in the CXpro"® Site
that has been successfully discovered on the BACnet network.

The lower pane of the Commission BACnet Devices dialog lists devices that are configured in the CXpro"P Site but

have not been successfully identified on the BACnet network. Devices that partially match the CXpro"® Site
configuration are highlighted in red —for example, a device has been found that matches the MS/TP Network Number
and MAC Address of a configured device, but the Device Instance Number does not match.

If you want any of the devices highlighted in red to be included in the Commissioning process, tick the checkbox
to the right of red highlight. When all such devices have been selected, click the Reconcile Issues button.

The configuration of the device in the CXpro*P Site will be updated to match the corresponding discovered device,
and the device listing will move to the top-right pane:

Commission BACnet Devices

All Devices Serial Number | Netwark | MAC Device ins... | Name | Max Masters | Strategy Type
- CBV S - Integral Actuator CH16744165C 515 1 4000 CEX Chris Desk 50 CBV US - Integral Actuator
CU12142008F 515 30 3001 CEM desk test 127 Strategy ID: 0

- Offline f Misconfigured Devices
Serial Number | MNetwork | MAC Instance (PC) | Instance (Ctrl) | Name | Type {PC) | Type (Ctrl) | Strategy Type | Issues
515 3 3443 001-003-CB... (CBMO3 Strategy ID: 0 Offiine
515 2 £ 001-002-CBX... CBX-8R8 Strategy ID: 0 Offline
< >
Recondle Issues |

Rescan | Timeout (s) |5 Close |

Note: If reconciling might create duplicate IDs, the conflicting offline devices are renumbered to a value
above 4000000 to ensure that they will be unique.
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If no match is found for the MS/TP Network Number and MAC Address of a configured device, that device is listed in
the lower pane as 0ffline, marked with a grey background and cannot be included in the Reconcile Issues process.

To retry pinging offline devices, click the Rescan button on the bottom left of the dialog.

The upper-left pane of the Commission BACnet Devices dialog shows categorized devices found organized by strategy
ID.

St NN AP AEEL PR

Sert

123
123
122
13
133
122

This groups devices by the type of strategy they contain (e.g. single or dual duct VAV, or RTUs, Fancoils, etc), so that
common properties can be edited together.

Clicking on All devices will show only the properties that are common to all devices of MAC, Max masters, Device
ID, Name, Serial Number, and Strategy Type.

Clicking on a strategy type in the left-hand pane means that additional parameters common to that strategy type will
become available in the right-hand pane:

= Al Devices Seral Number  MAC MaxMasters  DevicelD  Name Type lnput Confiy  Output Config
;
o Ot VAY 1224567 1 127 12341 VAVST386 137 3 18
Fan Cod 124562 2 127 12342 VAVST388 137 a8 12
RTU 12345673 3 127 12343 VAVST390 137 48 18
12345674 4 127 1244 VAVST392 137 48 18
1245675 5 127 12145 VAVST394 137 43 18
124567% 6 7 12346 VAVST356 137 48 18

Each of the fields can be edited individually.

However, it is also possible to copy a single value to multiple controllers at once, so that device types that are
installed identically - for example, VAVs — can be configured in bulk very quickly (similar to copy & paste in a
spreadsheet program).

When appropriate, editing a single field will be assisted by a properties window that indicates what the setting
value will mean:

CEes

Serial Mumber MAC Max Masters Device 1D Mame Type Input Con Output Config
! 12345671 1 127 12341 VAVST386 137 43 18
12345672 2 127 12342 VAVST™ - i
12345673 3 127 12343 VAyS] VAVST ig Properties
12345674 4 127 12344 VAWST Auxilary heat True
12345675 5 127 12345 WAVST Cortrol Method ~ Standard
12345676 6 7 12346 WVAWST
Control Method
This is the control sequence applied to this
VAV

Apply Cancel
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When all of the fields have been configured, click the Apply button, and the full set of edited parameters will be
sent to all controllers. A progress dialog will be displayed, indicating progress and highlighting any failures:
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Progress
Seral M... MAC Max Masters Device |0 MName Progress
12345671 1 127 12341 WAVST386 Complete
12345672 2 127 12342 WAVST388 Controller write failure. g
12345673 3 127 12343 WAVST3S0 Complete
12345674 4 127 12344 WAVST392 In Progress
12345675 5 127 12345 WAVST394
12345676 6 7 12346 WAVST3S6

MANO133 rev 15 © Cylon Controls Ltd. 233



Cylon’)

UNITED STATES

ONE TECHNOLOGY LANE
EXPORT, PA 15632
PHONE: (724) 733-2000
FAX: (724) 327-6124

1 SUNDIAL AVE - SUITE 219 N
MANCHESTER, NH 03103

75 WADE GREEN BUSINESS PARK
1301 SHILOH ROAD NW, SUITE 1411
KENNESAW, GA 30144

IRELAND

CYLON CONTROLS LTD
CLONSHAUGH BUSINESS &
TECHNOLOGY PARK
CLONSHAUGH

DUBLIN 17

IRELAND

T+3531 2450500

F+353 12450501
EINFO@CYLON.COM

UK

CYLON CONTROLS UK LTD
ENDEAVOUR HOUSE
COOPERS END ROAD

ST ANSTED

ESSEX CM24 1S)

UNITED KINGDOM

T+44 870178 1800

F +44 870 403 6570
EINFO@CYLON.COM

WWW.CYLON.COM
WWW.CYLON-AUTOMATRIX.COM



	SECTION 1 :  Cylon Building Management System
	Hardware Components
	Routers
	I/O Field Controllers
	PC
	Connections between hardware components

	Software Components
	CXproᴴᴰ modules

	CXproᴴᴰ – Overview

	SECTION 2 :  Basic tasks
	Starting CXproᴴᴰ
	The CXproᴴᴰ Interface
	The Ribbon
	The Quick Access toolbar

	Connecting to a Field Controller
	Opening Strategy files
	Navigating a multi-page strategy
	Labeling the pages within a strategy drawing

	Finding an element in a strategy
	Zooming and Navigating the drawing area
	Changing the display
	Modifying the Drawing Area (Grid settings)
	Modifying display colour settings
	Saving Files
	Saving a new file
	Saving changes to an existing file
	Saving more than one file

	Printing
	Including a footer in a printed strategy
	How to edit the footer that will appear with the strategy when it is printed:

	Altering the print set-up
	Printing a file
	Changing the size of a Printout
	Fitting a Strategy to a page size when printing.

	Closing files

	SECTION 3 :  System Configuration
	System Configuration definitions
	What is meant by “System” during configuration?
	What is a “Site”?
	What is meant by “Network”?

	Configuring Sites
	Defining the contents of a site
	Site Properties / Add Site Dialogs : Site Information section
	 Name
	 Directory

	Site Properties / Add Site Dialogs: Selecting the Network for connection to a site (Type of Connection)
	 Serial Connection (RS232)
	 BACnet IP

	Editing the number and names of controllers on a site
	 Adding Networks to a Site
	 Adding Field Controllers to a Site
	 Editing Controller information
	 FLX I/O modules
	 Modbus devices
	Configuring the CBX or CBXi’s Modbus RTU port
	Adding and Removing Modbus Devices
	Accessing Modbus points in the Strategy

	 Removing a Controller from a Site
	 Adding Multiple Controllers
	 Sorting the Controller List
	 Saving the changes made in the Edit Controllers dialog



	Configuring Serial Port Connection
	Configuring Strategy Defaults
	Configuring BACnet Communications
	Configuring BBMD
	What is BBMD?
	How a BBMD operates
	Setting a BBMD in CXproᴴᴰ
	BBMD Parameters
	 System-level BBMD parameters
	 Site-level BBMD parameters
	 Network-level BBMD parameters



	Configuring Site CommunicatIons (Commands)
	Command Settings
	Profiles:
	 TCP/IP Profile:
	 Default Profile:



	SECTION 4 :  Using Modules
	Modules - Overview
	Accessing Modules
	Placing a module on the drawing area
	Selecting modules on the drawing area
	To select more than one module on the drawing area:

	Move, Delete, Cut or Copy a module or modules on the Strategy drawing area
	Moving modules
	Deleting modules
	Copying modules on the drawing area

	Tool Tip Data on Modules

	Joining modules in a strategy
	Notes on joining modules
	Module connection points
	How to join modules
	How connections are represented
	Connectors
	Add a Source Connector
	Adding a Destination Connector
	Deleting Connectors
	Quick Searching for Connectors
	 Jumping from a Destination Connector
	 Jumping from a Source Connector

	Convert Lines to Connectors

	Viewing Point properties
	Viewing BACnet properties
	Viewing Module BACnet Properties
	Viewing Device BACnet Properties


	How to add text to a strategy
	How to change text that has been added to the strategy drawing

	Virtual modules
	Placing Virtual modules on the drawing area
	Rules for connecting to virtual modules
	Numbering virtual modules
	Virtual modules in macros


	SECTION 5 :  Points and Point Values
	What are points?
	What are blocks?
	Block Numbers
	Point Numbers
	Defining hardware points
	How to define hardware points
	Defining Hardware points – Target the controller
	Defining Hardware points - Place the module on the drawing area
	 Expandable I/O – Hardware Points on CBX + FLX devices

	Defining Hardware points - Save the hardware point definition
	Connect to the controller
	Download the hardware point definition.

	Summary of procedure for defining hardware points
	Point numbers for inputs and outputs
	A short cut to defining hardware points

	What are UniPuts™?
	Configuring the Field Controller’s Inputs and Outputs
	How to open the "I/O Terminals" Strategy Details tab.
	How to configure a UniPut™
	Changing the configuration of a UniPut™
	Example: Configuring Analog Input module properties
	 General Information
	 Constants
	 Outputs


	Viewing used blocks
	Viewing the list of blocks
	Viewing the blocks associated with each point


	Keeping CXproᴴᴰ and Controller strategies in Sync
	Strategy Compare
	Compare Process

	Strategy Synchronization
	When a module properties are edited:
	When a strategy is closed following a partial download:
	When Scan Mode is enabled


	Reading Live point values (LiveLog)
	Configuring Live Log
	Running LiveLog
	LiveLog - Scanning Definition
	Strategy name tab
	Strategy Target
	LiveLog mode
	 Points mode
	 LiveLog: Time Schedule mode
	  LiveLog: Network mode

	Scanning definition
	Override Status


	Manually Overriding Point Values - the Override Point dialog
	Overriding points
	Using the Override Point dialog:

	How to Enable a hardware point value (remove manual override status)
	How to change the value of a Setpoint

	SECTION 6 :  Creating Strategies
	What is a strategy?
	An example of a strategy
	The Problem
	The Solution
	The Strategy

	How to Create a Strategy
	Place all the required modules on the drawing area and join them
	Automatic point selection
	Selecting a connection line
	Naming a point
	Assigning a unit to a point

	Creating Strategies - Set the values of the module's Constants
	Creating Strategies - Add explanatory text if necessary

	How to reorder blocks in a Strategy
	How to Upload Setpoint Values
	Naming strategy Files
	How to open an existing strategy:
	Strategy Associations
	What is an "Associated" Strategy?
	Creating Associations
	New strategies
	Existing strategies - manual

	Breaking Associations
	Copying associated strategies
	Importing a Strategy

	Opening multiple strategies
	Downloading a strategy
	Open the strategy and connect to the controller
	Download the strategy
	Wipe the controller's memory
	 How to check the controller type to which you are downloading

	Edit the strategy
	Download the strategy

	Starting a strategy (sending the Setup)
	The effects of sending the setup

	Testing a strategy with Scan Mode
	Preparing to test a strategy
	How to test a strategy
	How to Display the strategy's point and constant values
	Setting the Scan mode
	Activate scan mode

	Suggestions for testing strategies

	Securing CBM data
	How to password-protect a range of blocks in a CBM strategy
	How to access locked strategy blocks

	How to expose Points on a BACnet system
	How to View BACnet points from A Controller

	SECTION 7 :  Naming Objects
	Why objects are named
	Rules for naming objects
	Procedures for naming objects
	Naming Points
	Types of point
	How to name points

	Naming Field Controller time schedules
	How to name a Field Controller time schedule

	Naming datalogs
	How to name a datalog


	SECTION 8 :  Using Macros
	Macros - Overview
	Macros and Macro Templates

	Macro structure
	Macro Description (Help) Files
	How to Create a Macro Template
	Create the strategy
	Select the modules for the macro
	Add the selected modules to the Macro Template
	Define the Macro Inputs, Outputs, Group and Name (the Create Macro dialog box)
	Define the inputs and outputs for the macro
	Change input or output label if necessary
	Name and group the Macro
	 Macro Name
	 Macro Group and Sub-Group

	Set names for all points in the Macro

	Choose whether to insert the macro into the active strategy
	Save the Macro Template

	How to create a new macro group and sub-group
	How to rename points in a Macro Template
	How to Set Macro Setpoint Unit LaBels
	How to transfer macros from one computer to another
	Export macros from the PC on which they were created
	Add exported Macros to the host PC system

	Working with Macros
	How to insert a macro into a strategy
	How to view the modules in a macro ("Expanding" a macro)
	How to Edit a Macro


	SECTION 9 :  Communicating with Controllers
	Communicating with Cylon Controllers
	Sending information to a Field Controller
	Wiping a Field Controller's memory
	The effect of wiping a Field Controller’s memory

	Sending the setup to a Field Controller

	Getting Controller Information
	How to get the Controller version
	How to get the controller setup
	How to get controller statistics
	Engineering statistics tab
	System statistics tab
	Serial Port Statistics tab

	How to get Field Controller Diagnostic information
	How to get Field Controller Configuration information

	How to set the Controller Time and Date
	Changing the address of a controller (CBM only)

	SECTION 10 :  Datalogs and Alarms
	Datalogs
	The datalog function module
	Restrictions on the use of datalogs
	Standard Datalog sampling period
	Time Stamped Datalogs
	Datalog sampling of digital and analog point values
	How to define a datalog
	Name
	Analog input
	Enable
	Log Trigger
	Digital input
	Datalog Number
	Update Interval
	Delta

	Starting a datalog
	Viewing the contents of a datalog

	Alarms
	Starting alarms
	Examples of Strategies containing alarms
	Alarms - Example 1: Pump Trip Switch
	Alarms - Example 2: Pump Trip Switch with delay
	Alarms - Example 3: Room Temperature Input



	SECTION 11 :  Simulation Mode
	Introduction
	Configuring the Simulation
	The Simulation Cycle
	Simulation speed
	Display Progress As:
	Current simulation configuration
	Start time/date:

	Running a Simulation
	Livelog

	Point properties
	Accessing the points properties
	Lines
	Hardware I/O modules
	Connected nodes

	Point value override
	Analog points:
	Digital Points:

	Input point options
	Digital Input point options
	 Fixed value
	 Periodic change

	Analog Input point options:
	 None
	 Fixed
	 Random value
	 Up (down) only
	 Up (down) only with limit
	 Up and down
	 Values from file



	Point logging

	SECTION 12 :  Sites
	Overview
	Installing a new site on the PC
	What happens when a new site is installed
	How a new site is installed on the PC
	Site backup
	Making a site backup
	Restoring a Site from a backup file

	Site Discovery
	If the Site is not yet configured in the Site Tree
	If the Site is already configured in the Site Tree

	ASPECT® / INTEGRA™ Export
	Starting the Export
	Import into ASPECT®-Studio and INTEGRA™-ProPack
	Launching CXproHD from INTEGRA™-ProPack



	SECTION 13 :  Appendix :: Adding units of measurement to the system
	Adding units of measurement
	How to add units of measurement to the system

	Example of adding units to analog units list

	SECTION 14 :  Appendix :: File Management
	File Management in CXproᴴᴰ

	SECTION 15 :  Appendix :: BACnet Explorers
	NB-Pro
	Discovery Tool
	BACnet Explorer
	Network Type
	Site Name
	Site Directory
	Site Number
	Address Range
	Wait Timeout (s)
	Network

	Check Against Existing Devices
	Changing the Present_Value Property


	SECTION 16 :  Commissioning Controllers with CXproᴴᴰ
	How to Configure a Controller’s BACnet settings
	 Device Instance
	 Device Name
	 Tunneling Properties: Site and Comms Ctrl
	 MSTP Max Masters
	 APDU Timeout

	Commissioning a range of controllers quickly (Mass Commissioning)


